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RCM++ Training Guide

1.1 About this Training Guide

This training guide is intended to provide you with many examples to demonstrate the use of RCM++. It
begins with step-by-step examples and then proceeds into more advanced examples. At any time during the
training, please feel free to ask the instructor(s) any questions you might have.

Some of the examples in this training guide require you to access files that have been shipped with the
RCM++ application. These files are located in the Training and Examples folders in your application
directory (e.g. C:\Program Files\ReliaSof\RCM4\Training or C:\Program Files\ReliaSoft\RCM4
\Examples). The Examples folder is also accessible by clicking the Open Examples Folder... link in the
What do you want to do? window or by selecting Open Examples Folder... from the Help menu.

1.2 RCM++ Documentation

Like all of ReliaSoft's standard software products, RCM++ is shipped with detailed
printed documentation on the product (RCM++ User's Guide). This training guide is
intended to be a supplement to that reference.

1.3 Contacting ReliaSoft User's Guide

ReliaSoft can be reached at:
ReliaSoft Corporation
Worldwide Headquarters
1450 South Eastside Loop
Tucson, AZ 85710-6703 USA
Phone: +1.520.886.0366
Fax: +1.520.886.0399
E-mail: Support@ReliaSoft.com

For up-to-date product information, visit our Web site at:
http://RCM.ReliaSoft.com
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Features Summary

The examples in this training guide have been designed to introduce you to the features available in
RCM-++. This section presents a brief summary of these features. If you are already familiar with RCM++’s
capabilities, you can proceed to Chapter 3, First Steps.

ReliaSoft's RCM++ facilitates analysis, data management and reporting for Reliability Centered
Maintenance (RCM) analysis and also provides integrated support for failure modes and effects analysis
(FMEA) and failure modes, effects and criticality analysis (FMECA).

2.1 Support for Major Industry Guidelines plus Extensive Customization
Options

RCM++ supports all of the major industry guidelines for RCM and FMEA/FMECA. This includes SAE
JA1011, SAE JA1012, ATA MSG-3, NAVAIR 00-25-403 and other references for RCM as well as SAE
J1739, SAE ARP5580, AIAG FMEA-3 and MIL-STD-1629A for Design FMEA (DFMEA), Process FMEA
(PFMEA), Machinery FMEA (MFMEA) and Criticality Analysis (FMECA).

In addition to providing pre-defined profiles for the major industry standard reporting formats, the software
provides extensive capabilities to customize the interface and the reports. This includes the ability to rename
fields, hide/display fields, customize the RCM decision logic and/or RPN rating criteria and other options to
allow you to determine the configuration for analysis and reporting.

2.2 Intuitive Interface, Easy Data Entry, Time-Saving Shortcuts

RCM++ provides two complementary views to facilitate data entry. The worksheet view displays the
analysis in a tabular format. The intuitive hierarchical view displays the system configurations at-a-glance
along with the related functions, failures, effects, causes, controls, actions and tasks defined in your analysis.

For consistency and to save effort, the software allows you to re-use descriptions from any existing analysis
or to select phrases from pre-defined phrase libraries. The software also provides:

e Integration with ReliaSoft’s Xfmea, Weibull++, ALTA and BlockSim, as well as the capability to import
data from ReliaSoft’s MPC 3 and Microsoft Excel.
e Ability to link or attach other files to the analysis, such as process flow charts, design drawings, etc.

e Ability to copy/paste and import/export sections among different analyses.

2.3 RCM Decision Support

In order to focus resources where they can provide the greatest benefit, RCM++ supports two methods for
selecting the equipment that will be analyzed with RCM techniques: Selection Questions (yes/no) and
Criticality Factors (rating scales). The software comes with pre-defined selection questions based on the
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2 Features Summary

major industry guidelines and also allows you to customize the questions and criticality factors to meet your
organization’s particular analysis requirements.

In order to prioritize issues and select applicable and effective maintenance tasks, RCM++ supports the
Failure Effect Categorization (FEC) and Maintenance Task Selection logic diagrams in the major industry
RCM standards. These logic diagrams can also be customized to meet specific application needs.

2.4 Optimum Maintenance Interval, Cost Comparisons and Task Packaging

For analysts who rely on cost comparison in addition to, or instead of, decision logic diagrams, RCM++
goes beyond calculations based on MTBFs and the often-inappropriate assumption of an exponential failure
distribution. Now, you can use the Weibull, exponential, normal, lognormal or mixed Weibull distributions
to describe the equipment's failure behavior and then use the same powerful calculation and simulation
engines that are available in ReliaSoft's BlockSim software to estimate the optimum maintenance interval
and to compare the operational costs of various maintenance strategies.

In addition, RCM++ makes it easy to group individual tasks into packages based on interval, labor crew, etc.
Both manual and automated packaging options are available.

2.5 Risk Assessment

RCM++ supports the Risk Priority Number (RPN) ranking method as well as Criticality Analysis. This
includes automatic RPN calculation for both initial and revised RPNs, as well as optional “roll-up”
capability to calculate RPNs for other analysis levels (such as Item or Failure) based on the RPNs for the
potential causes of failure.

The software is shipped with an extensive array of pre-defined rating scales for Severity, Occurrence and
Detection and also allows you to create and manage your own rating scales. In addition, RCM++ supports
both quantitative and qualitative criticality analysis methods. The software automatically calculates Mode
and Item Criticalities and generates charts and reports of the criticality analysis.

2.6 Actions Management

RCM++ allows you to fully define and manage the recommended actions identified by the analysis in order
to close the loop on corrective actions. Action management options include automated notifications via e-
mail as well as useful reports and charts for progress tracking. Detailed reports on current controls are also
available.

2.7 Simultaneous Access by Multiple Users

The software has been designed to allow multiple users to work cooperatively on the analysis and provides
flexible techniques to share portions of an analysis with other users as well as revision tracking mechanisms,
the ability to limit access to authorized users, and more.

If you are working with a secure database, more than one user can have read/write permission to access the
database at the same time. This means that multiple users can simultaneously edit different portions of the
analysis in the database. If other users are editing a section in a database when you log in to it, then those
sections of the database that are currently being edited by the other users will be marked as “read-only” for
you and the section that you are currently editing will be marked as “read-only” for the other users.

2.8 Revision Tracking

In addition to the option to restrict database access to authorized users via password protection, RCM++
provides several levels of revision tracking functionality to protect the integrity of your analysis. The last
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2.9 Check Analysis Utility

update user and date/time stamp is clearly displayed for each record. The software also maintains a database
login history, with the user and date/time for every login to the database. You can also create baseline
versions of the database with the ability to “roll back” to previous versions if necessary. In addition, the
software provides a Change Log feature, which allows authorized users to control the revision of a particular
analysis and provides a record of all modifications since the log was activated.

2.9 Check Analysis Utility

RCM++ allows you to check a particular analysis and identify any possible discrepancies and/or omissions
via the Check Analysis utility. The utility will list the potential issues and you can make the decision of
whether to address them. You will not be prevented from generating plots or reports even if issues are
identified via the data check.

2.10 Query Utility

The Query Utility allows you to query the current RCM++ project for the records that meet your specific
query criteria. The results of the query are returned in spreadsheets that can then be exported to Microsoft
Excel. You can also use the Query Utility to perform queries at the database level.

2.11 Automated Reporting and Charts

RCM++ provides a comprehensive set of print-ready reports for your analysis. This includes equipment
selection, functional failure analysis, failure effect categorization, maintenance task selection and other
reports for RCM analyses as well as FMEA and FMECA spreadsheets in the standard industry formats. You
can choose to generate each report in Microsoft Word or Excel, which provides maximum flexibility for
customization and generation of HTML and PDF versions of the reports, as desired.

You can also generate a variety of graphical charts for the analysis.

2.12 Control Plans, DVP&Rs, DRBFMs and Flow Diagrams

RCM++ provides several ways to integrate your FMEA with the requirements of the Advanced Product
Quality Planning (APQP) guidelines. This includes the ability to generate a new Process FMEA (PFMEA)
based on an existing Design FMEA (DFMEA) and also to create integrated Design Verification Plan and
Report (DVP&R), Control Plan, Design Review Based on Failure Mode (DRBFM), Process Flow Diagram
and/or Functional Block Diagram analyses.

2.13 Administrative Options and Database Tools

RCM++ provides utilities that allow you to manage and maintain the databases that you create. The
administrative options and database tools include:

e The Administrative Options window, which allows the database administrator to perform administrative
options, such as change the administrator information and manage the database users.

e The Database Tools window, which gives you access to database maintenance options, such as
compacting and repairing the current database, creating a backup of the database and restoring the
backup of the database.
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First Steps

In addition to providing information on starting RCM++ and a brief overview of the software's main
interface, this section allows you to experiment with the data management, analysis and reporting features of
the software using a pre-defined analysis based on sample data. Working through this example will help you
to become familiar with the software quickly and easily.

3.1 Starting RCM++

RCM++ is a 32-bit application that has been designed to work with Windows NT, 2000 and XP. The
RCM-++ internal screens and commands are identical regardless of which operating system you are using,
and this training guide is equally applicable. To start RCM++, from Start select Programs, ReliaSoft
Office and then RCM++ 4.

3.2 Multiple Document Interface

RCM++’s Multiple Document Interface (MDI) is the workspace within which you can create, edit and
manage your RCM and FMEA/FMECA analyses. You can open one database at a time in the MDI and as
many projects from that database as necessary. The MDI remains open until you close the program and
closing the MDI terminates the program.

The next figure displays the RCM++ MDI and its components. The appearance of the MDI will vary
depending on the window(s) currently open.

E RCM++ - No Current Database [_ O] =]
Menu Bar——=Fie Tools Windaw Help
Toolbar ; -f#l Mew Database. ., ..,% Open Database. .. d Close Database | _‘? ‘Wiews Project Explorer... | G 9,
Internal Area
Status Bar— RCM4+ - Mo Current Database [ [ EEE

The internal area of the MDI contains the active RCM++ windows, which can include the Project Explorer
and the open Project window(s). The status bar that appears at the bottom of the MDI displays the path and
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3 First Steps

filename of the database, whether Login Security is enabled for the database, whether the user has read and/
or write access to the database and the current date.

3.3 Getting Help in the RCM++ Environment

ReliaSoft's RCM++ includes complete on-line help documentation. This help can be obtained at any time by
pressing F1 or by selecting Contents from the Help menu.

3.4 First Steps Example 1

This example allows you to experiment with the data management, analysis and reporting features of the
software. For this example, you will work with a sample database that has been prepared by ReliaSoft,
which contains sample data related to imaginary equipment. Sample data sets are not intended to be
realistic.

At this time, we assume that you have started the application and, if this is the first time you have run
RCM++, that you are looking at the Setup Wizard.

3.4.1 Complete the Setup Wizard

The Setup Wizard will be displayed the first time that you run the software. The purpose of the wizard is to
introduce you to the RCM++ working environment while guiding you through the process to configure the
software to fit the specific way that you work.

ESetup Wizard

Setup Wizard Step 1 of 6

RCM + + facilitates all types of FYIEA/F¥IECA and RCM analysis with support for major
industry standards and extensive customization capabilities.

RCM++ is highly flexible and customizable, This wizard
provides a brief introduction to RCM's work environment and
guides you through the process to set the major
configuration options.

You can click Finish' at any time to apply the current
configuration settings and begin working with the
application. Click the Mext:='and '<Back' buttons to
navigate through the pages of the wWizard,

This Wizard only appears automaticaly the first time you
run the softwara, After that, you can access it from the
Uszer Setup window, The configuration options can also
be modified at any time with the User Setup and
Profies/Libraries Management windows,

Click Finish at any time to begin working with the
application...

RCM++

=Back | Mewxk> | Finish |

e If you have not already completed the Setup Wizard, then you can do so now before proceeding with the
examples. If you would prefer to begin the examples immediately, simply click Finish to accept
RCM++’s default configuration settings and close the window. If you would like to run the wizard again
at a later time, click Run User Setup Wizard in the User Setup window, which is available from the File
menu.

3.4.2 Open an Existing Database

RCM++ databases can be created with or without Login Security. If Login Security is enabled for a
database, then each user must log in with an authorized username and password in order to gain access to the
information in the database. If Login Security is not enabled for a database, then any user who has read/write
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3.4 First Steps Example 1

permission to access the location where the database file is stored can view and edit the information
contained in the database. By default, Login Security is not enabled for new databases. However, you can
enable Login Security via the Settings (1) page of the User Setup. The database that you will access in this
example is non-secure.

When you launch RCM++ (or after you have completed the Setup Wizard if this is the first time that you
have started the software), the What do you want to do? window will be displayed. This window provides a
quick way to create a new database or open an existing database.

’E‘what do you want to do? [ x|

m;j Mew Database...

w1
Open Database...

Recent Databases:

C:\Program Files\ReliaSoft\RCMAAExamples\RCM Dem
C:\Program Files\ReliaSoftiRCMEExamplesiDemonstr,

Open Examples Folder. ..
I~ Do not show this again 4| | j

RCM++

e For this example, click Open Database to open an existing database file.

e In the Open Database window, select the file called RCMQStartl.rx4 from the Training folder in your
application directory (e.g. C:\Program Files\ReliaSoft\RCM4\Training), as shown next.

1
Look in: IL’f}Training j - cF B~

File hame: IHCMQStam.M j Open I
Files of type: | RCM+ 42xfmea 4 ["rs) =l Cancel |

Z

e Click Open to continue.

3.4.3 Open a Project

Projects give you additional flexibility for managing your analyses to fit the particular needs of your
organization. You can have one or many projects in the same database. Every analysis within a given project
will have the same characteristics, including the fields that are enabled/disabled in the interface and reports,
the RCM decision logic, rating scales and the menu options that are available for codified information, such
as Action Categories, Task Statuses, etc. These properties can be set automatically based on pre-defined
profiles and libraries and are fully customizable.

e After you have opened the existing database, the Project Explorer will appear, which allows you to
create, edit, delete, import or export projects within the current database. You can also duplicate and
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3 First Steps

transfer projects. The Project Explorer is shown next with the RCM Quick Start 1 project, which we will
be working with in this example.

@Pmiecl Explorer |_ (O] x|
= Project Explorer

= =
ﬁ:\.[?|:_1}£1|d_‘1 :ﬂ
A MName Based on Profile Description -

E[RCM Quick Start 1 Standard B This sample praject has been created to demonstrate some
of the sofbware fratures,

(7]

¥
l e

|Exph:|rir|g projects in current database A

As can be seen in the Project Explorer, the RCM Quick Start 1 project is based on the Standard RCM profile.
A profile is a pre-defined set of project properties, which includes selections for interface styles, rating
scales, menu sets and RCM analysis logic. The Standard RCM profile enables/displays a basic set of
properties that are applicable to a typical RCM analysis.

e From the Project Explorer, open the RCM Quick Start 1 project by double-clicking it, by selecting Open
Project from the Project Explorer menu or by clicking the Open Selected Project icon.

L]

The Project window will appear. The Project window is the main window that you will use to perform your
analyses. It presents all of the items, functions, failures, effects, causes, controls, actions, tasks and related
properties that you have defined within a particular project and provides all the tools required to add and edit
these records. Notice that the project name, RCM Quick Start 1, appears in the caption bar at the top of the
window. The Project window with Subsystem A selected is shown next.

[M/RCM Quick Start 1 =1 E3
 Project Edit Wiew SwstemHierarchy  Function Falue  Effect Cause
£ X | IS fe | 1 B | zoom~ | A 4] M| Ve N[ B | @
System Hierarchy FMEA Hierarchy - Subsystem A
] Name gElenl=] 2 Description 0 [T lrec|T]=
= Mstem r O To pump water from tank % to tank ¥ at not less than

» & S evehem & m: r B00 licers per minute,
...... I__J Component 1 EH§| Unable ko transfer any water at all.
Companent 2 [=1-[H] System Fails. EQ
-[Z] Matar burns aut,
=] tmpeller comes adrift, z
[Z] Coupling hub shears due to Fatigue. 1
=] Impeller jammed by Faresign object.
EH[® Transfers less than 500 likers per minute,
E-[M] System does not perform to capacity,
[F] Impeller worn. 1
4[Z] Partially blocked suction line. 1

¥ ¥
A4 F 1 F

= Aszembly ||Subsystem A S

The Project window is divided into two panels. The panel on the left displays the System Hierarchy, which
includes all items that have been defined in the project and also provides access to linked/attached
documents and other related information. The panel on the right displays the functions, failures, effects,
causes, controls, actions and tasks associated with the item that is currently selected in the System Hierarchy

panel. The columns that are displayed in both panels can be configured via the Hierarchies page of the User
Setup.

------ || Component 3
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3.4 First Steps Example 1

e You can now take a moment to get familiar with the Project window by going through the menus and
their commands. You can also view the properties windows for the records by double-clicking the record
name. For example, to view the Item Properties window for Subsystem A, double-click the name that
appears in the Name column in the System Hierarchy panel. To view the Function Properties window for
the first function, double-click the name that appears in the Description column in the FMEA Hierarchy

panel, and so on.!

3.4.3.1 Copy and Paste Items

You can copy items, functions, failures, effects or causes within a project and paste the record(s) to the same
project or to another project within the same database. (Please note that if you want to share items between
different databases, you must use the import/export functionality.)

e Copy Subsystem A by selecting it in the System Hierarchy panel and selecting Copy from the Edit menu
or pressing Ctrl+C. When an item is copied, all next level items, functions, failures, effects, causes,
controls, actions and tasks will also be copied, along with any attachments.

e Next, paste Subsystem A by selecting the System item and then selecting Paste as Next Level Item
from the Edit menu or pressing Ctrl+V. Subsystem A will be pasted into the specified position in the

hierarchy, along with its related sub-items, as shown next.?

[M/RCM Quick Start 1 =1 E3
: Project Edit View SystemHierarchy  Function Faillue  Effect Cause
P BB X | ]IS | zeom- | H 4 W3 N6 | @
Syskem Hierarchy FMEA Hierarchy - Subsystem &
[m] arne g lFml=] O Description O |¥ | FEC | T |~
=] @_“E}fstem =D To purp water _from tank ¥ ko kank ¥ ak nok less than
» 5 g Subsystem & 800 licers per minute.
______ | Component 1 [—}@ Unable ko bransfer any waker at all,
______ #| Companent 2 EH-m System Fails, EQ
...... || Component 3 = Totoﬂ burns out Id ' >
= rpeller cames adrift,
B SubsystemA M Coupling hub shears due to Fatigue. 1
""" l-':-] Component 1 -[=] Impeller jammed by Foreign object.
Component 2 [=+-[@] Transfers less than &00 likers per minuke,
""" || Component 3 -8 System does nok perform to caparity,
=] Impeller warn, 1
[Z] Partially blocked suction line. 1

¥ ¥
A k 4 k

=1 Item ||Subsystem & A

e When you copy and paste items, they retain their original names and numbers. If you have not changed
the default settings on RCM++, the item numbers will not be visible, but they are used by the software to
sort the items. Renumber the items by selecting Renumber items from the Project menu so that the
copied subsystem and the original subsystem no longer share an item number.

e Rename the second subsystem in the hierarchy by double-clicking its name in the System Hierarchy
panel. The Item Properties window will appear.

L Please note that this example is meant to give you a quick overview of the software. Subsequent examples in this
training guide will take you through the steps of adding records to a project using the properties windows and will
provide more explanation of the fields that appear in these windows.

2- When an item is copied, you can also use the Paste as System command in the Edit menu or press Ctrl+Shift+V to
paste (add) the copied item to the System Hierarchy panel as a top level item (system).
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3 First Steps

e Edit the Item Name by typing Subsystem B in the corresponding field, as shown next.

[MIEdit 1tem [x]
[ Parent System | 1 - System
‘ Mext Higher Assembly |N,|’A
General |Other I User Defined |
# Itern Mame
I 2 ISubsystem B Lﬁj
Part Mumber Alkernate Part Number
Item Description
_ ;II
Remarks
_ ;II
Gty per System Qb per NHLA Ibem RFH
I I | Initial I Revised |
|R Reliability. .. ” Bnalysis... ” Analysis Plan,.. ” &€ Eaupment Selection... |
+
- e
E Fe] i @ || % (7] of | Cancel
o
= |Last Update Date: 4/11/2005

e Click OK. Notice that the name has changed in the System Hierarchy panel.

3.4.3.2 Promote and Demote Items

You can promote and demote the items within the System Hierarchy using the Promote and Demote
commands available from the System Hierarchy menu or the Project toolbar. For example, if you have a
system, subsystem and subsubsystem and you promote the subsubsystem up one position in the hierarchy, it
will be on the same level as the subsystem. When an item is promoted or demoted, all associated next level
items, functions, failures, effects, causes, controls, actions, tasks and attachments will also be moved. An
item can only be demoted if there is another item on the same level and above the selected item that it can be
demoted under.

e Promote the Component 3 item that appears under Subsystem B to the next higher level in the System
Hierarchy panel by selecting it and then selecting Promote Item from the System Hierarchy menu or
by clicking the Promote Item icon on the Project toolbar.

|
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3.4 First Steps Example 1

e Notice that the Component 3 item now appears on the same level as Subsystem A and Subsystem B, as
shown next.

I[=] E3

[MIRCM Quick Start 1

: Project Edit Wiew System Hierarchy Function  Failre  Effect Cause

4 x |1 g | | 2o~ | H 4] M| 2 Yo DY || 48 | | @
System Hierarchy FMEA Hierarchy - Component 3
[m] Marme g [T Tem]<] [O] Descripkion [a [FlrEc]t]-
= OB System
E- 2 Subsystem A [F M|
:| Component 1
:| Component 2
------ % Component 3
E- 2 Subsystem B [F M|
:| Component 1
% Component 2
AT %) Compaonent 3
« i) £ of

|z Item

||C0mp0nent 3 i

e Promote Component 3 again up to the system level, as shown next.

[MIRCM Quick Start 1

: Project Edit Wiew System Hierarchy Function  Failre  Effect Cause

x |1 g | |zoom-| o 4] W |2 Yo DN || | | @
System Hierarchy FMEA Hierarchy - Component 3
Marme g [T Tem]<] [O] Descripkion [a [FlrEc]t]-

[FIm]

I[=] E3

"E:_" ...

a

= OB System
E- 2 Subsystem A
:| Component 1

:| Component 2
:| Component 3
E- 2 Subsystem B

------ % Component 1
------ % Component 2
» [l Component 3

- -
4 E A E

A System ||C0mp0nent 3 A

e Now return Component 3 back to its original position as an item below Subsystem B by selecting it and
then selecting Demote Item from the System Hierarchy menu or by clicking the icon.

o

You will need to select the Demote Item command two times to return the item to its original position.

e Next, delete Subsystem B from the hierarchy by selecting it and then selecting Delete from the Edit
menu or pressing Delete. A window will appear to confirm that you want to delete the selected item.
Click Yes.

Subsystem B will be deleted, along with its associated next level items. The Project window will now appear
as it did when you first opened it.
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3.4.4 Perform Equipment Selection

In order to focus resources where they can provide the greatest benefit, RCM++ supports two configurable
methods for selecting the equipment that will be analyzed with Reliability Centered Maintenance (RCM)
techniques: Selection Questions and Criticality Factors. To view the Selection Questions analysis that has
been performed for this example, double-click the M icon to the right of the Subsystem A item. The

Equipment Selection window for this item will be displayed, as shown next.

’El - Subsystem A: Equipment Selection

e ™ -
Parenk System | 1 - Syskem

M= E

| Next Higher Assembly | T

Current Tkem | 1 - Subsystem A

Selection Questions |Critica|ity Fackors I

Safety

Could Failure affect safety or have ather hazardous consequences?

Mo

Detectability

Could Failure be undetectable or not lkely to be detected during
normal operation?

Mo

Operational

Could Failure have significant operational impact?

es

Economic

Could Failure have significant econamic impact?

Mo

Remarks

Remarks related ko the equipment selection decision.

™ Analyze For RCM (Manual Overrids)

|l

| Cancel |

| Last Update Date: 4/8/2005

&

e Click the cell in the bottom right corner of the table to change the answer to the last question to Yes. You
will notice that the “Economic” label changes from green to red, indicating that the failure of the item
could have significant economic impact (and the item should be considered for RCM analysis).

'_ﬁ‘l - Subsystem A: Equipment Selection

e °. ©¢©\t s 8 99 -
Farent System | 1 - System

[0 ]

| Next Higher Assembly | Mja

Current Ikem | 1 - Subsystem A

Selection Questions |Cr|t|ca||ty Fackors |

safety

Could Failure affect safety or have ather hazardous consequences?

)

Detectability

Could Failure be undetectable or not likely ta be detected during
normal operation?

Mo

Operational

Could Faillure have significant operational impact?

Economic

Could Failure have significant econamic impact?

Remarks

Remarks related to the equipment selection decision.

™ Analyze For RCM (Manual Override)

=[El

| Cancel |

| Last Update Date: 4/6/2005

N

e Click OK to save the change and close the window.

14
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3.4 First Steps Example 1

3.4.5 View the Analysis in the Worksheet View

RCM++ provides two complementary views to facilitate data entry for the functional failure analysis (often
called FMEA). The worksheet view displays the analysis in a horizontal, tabular format while the
hierarchical view displays the information at-a-glance in a hierarchical tree structure.

You have been looking at the hierarchical view, but you can easily switch to view the analysis in the
worksheet view.

e To do this, make sure that the Subsystem A item is selected in the System Hierarchy and select
Worksheet View from the View menu, press Ctrl+W or click the Toggle worksheet/tree view icon.

=]

You can see that the panel on the right side of the Project window now displays the information in a tabular
format, as shown next.

[MIRCH Quick Start 1 I [T 3
: Project Edit Wiew SystemHierarchy  Function Failwe Effect Cause
£ x | I8 | Zeom-| 4 4] W[ - DN 1| 4@ o | | @
Syskem Hierarchy FMEA WarkSheet - Subsystem &
o oS AR B Function Failure ‘ =
=] @0 System
> -2 Subsystem A FIm) To purnp wiater from tark X to = Unable ko transfer any watsr at
F T P |tark ¥ at nat less than 800 liters Swstem fails,
...... L_J Companent 1 per minute. Lla".

Component 2

|| Component 3 ||

Transfers less than 300 liters per  System does
minuke. capacity,

- -
4 » 4| | »

|| Function |To pump water from tank # to tank ¥ at not less than 800 liters per minute, v

e When you display the worksheet, you may be in Edit mode (i.e. a cursor blinks in the currently selected
cell). To exit Edit mode, press Esc.

e To display more of the worksheet within the window, click the Hide System Hierarchy icon.

4l

The cells in the Worksheet view are color-coded according to their purpose/functionality. Cells that are
white (or blue when selected) contain record properties (e.g. function description), green cells contain values
that are automatically calculated by the application (e.g. RPNi, if applicable) and grey cells are
nonfunctional due to the layout of the analysis in this view.

e You can add and edit records by typing directly within the cells of the worksheet and/or by using the
menus and shortcut menus to open the appropriate properties windows. For example, to open the
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Function Properties window, right-click the cell that contains the function description, as shown next,
and select Edit Function from the shortcut menu or press Shift+F6.3

[MIRCM Quick Start 1 [_[0]
Project Edit Wiew System Hierarchy Function Failure Effect  Cause  Controls  Actions
¥ Ga X | IS I o~ | (] (NN 2| @ ©
FMEA Warksheet - Subsystem &
Function Failure Effect Eailt=linde =
{Cause)
To pump water from tank ¥ to tank
» [ at not less than 800 liters per Unable to transfer any water at Syskem Fails, Motor burns out,
| |minte, "E &dd Function... Fo
. Impeller comes adrift,
— I £ Function. .. Ctrl+F
@ ANsert Function 4 Coupling hub shears due to
- ¥&| Edit Function...  Shift+Fg Fatigue.
- - Impeller jammed by Foreign object.
'EI Add Function Group... System does not perform ko Irnpeller warn
— ﬁﬂ Insert Function Group. .. capacicy.
- Partially blocked suction line.
*s AddFailure... F7
Bulk Add »
Select Existing... Chr+E
4 Cut Chrl+%
=3 Copy ChrlbC .
4] | Paste Chel+y _>|_I
[»| Function | To pump water Fram| 2% Delete Delete rs per minute. 4

e Now return to the hierarchical view by selecting Worksheet View from the View menu.

3.4.6 View the Records by Type

When working in the Project window, you can filter the information displayed in the panel on the right to
show all functions, all failures, all effects, all causes, all controls, all actions or all tasks and specific related

properties in a tabular view.

e To filter the information associated with the selected item, select View Records by Type from the View
menu or click the Filter icon. A submenu will appear, as shown next.

m

View Functions
Yiew Failures

Wi Effects

i) | & [+

View Causes

Wieww Controls

3

View Ackions

[

Wigmw Tasks

Remove Filker

3. Please note that the FMEA Worksheet view is not intended to have the same functionality as a Spreadsheet application
such as Microsoft Excel. The data entry and editing capabilities in the Worksheet view are limited and you may want to
use the Properties window for the corresponding record when performing extensive data entry and/or editing.
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e Select View Tasks. The panel will change to display only the maintenance task records and specific
related properties, as shown next. (Please note that you may have to scroll and/or resize the window to
view all the tasks and their properties.)

[MIRCM Quick Start 1 [_ O[]
Project  Edit  Wiew  Swstem Hierarchy
4 Ga x| EEH Zoom- | H A (W2 Yo | 2 || 48 ]
| Tasks - Subsystem A
- Labor {Crew | Duration per | Total Cost Cost per Average Availab... ;I
Y
# Task Name a Status Type Assigned Int... Name) Incident A e Uptime (o)
On condition task
ap [ oo SR Assigned oc 3Month  |The labor requi... | 0,25 Hour $12,50 1,655 | Haur 99.52
fiow weat and
initiste preventivet
On condition task
2 z |toinspect suction assigned oc 3Month  |Thelsbor requi... | 0.5 Hour $25.00 0,343} Hour 99.65
line For obstruction
and initiate +
On condition task
b inspect impeller "
3 4 eor conditions that Rejected ac 1 Manth The labar requi... 0,25 Hour $25.00
indicate it will come-
Re-design the
equipment ko
4 5 redured the Assigned o7 $10,000,00
likelibood that the+
& scheduled
5 & |replacement For Assigned RR. 748,698 Hour | The labor requi... 2 Hour $210.00
the coupling hub, LI
L] Bl
iz Task HOn condition task b inspect impeller for wear and initiate preventive maintenance iF necessary, 4

e You can sort the records that appear in this filtered view. Sort the task records by their Total Cost per
Incident by clicking the corresponding column header. Notice that the records are now sorted by their
Total Cost per Incident from lowest to highest. Click the column header again to sort the data from
highest to lowest Total Cost per Incident.

e Now return to the hierarchical view by selecting Remove Filter from the View Records by Type sub-
menu or icon. Restore the two-panel display by clicking the Restore/Split Screen icon twice.

|

The first time you select this command, it restores the display to its previous state. The second time, the
two panels will be evenly split within the Project window.

e With Subsystem A selected, the window will look like the figure shown next.

[MIRCM Quick Start 1 M=l

 Project Edit Wiew Swstem Higrarchy  Function  Falue  Effect Cause

x| 1 bl | 1= B2 | zoom | ot {1 L M| (e | | @ | | @
System Hierarchy FMEA Hierarchy - Subsystem &
Mame i lEInl=] O Description AR
= @_ System | | » B Tao pump waker Frolm tank ¥ to tank ' at
-2 Subsystem A F]| 7ot less than 00 liters per minute,
J Component 1 EHEI Unable ko transfer any water at all.
- Systern Fails. EQ
- Motor burns out.
Impeller comes adrift, z
Coupling hub shears due to
fakigue,
) Impeller jammed by foreign
= ghject.
Transfers less than 800 liters per
H@ rhinute, i
System does not perform ko
- c:pacity. i
=] Impeller worn. 1
[Z] Partially blacked suction line. 1

”E:" it

a

b4

:| Component 2
------ % Component 3

- -
A L A L
|| Function ||T0 pump water from tank & to tank ¥ &t not less than S00 liters per minute. i
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3.4.7 Perform Failure Effect Categorization

As you can see, the functions, functional failures, effects and causes (failure modes) for Subsystem A have
already been defined for this data set. In addition, the effect of the first failure (unable to transfer any water
at all) has already been analyzed and categorized as EO - Evident Operational.

e To analyze the effect of the second failure, double-click inside the FEC column to the right of the effect
with the description “System does not perform to capacity.” The Failure Effect Categorization window
for this effect will be displayed, as shown next.

[ (O] x]

'EFailule Effect Categorization

Current Item | 1 - subsystem A
| Function | 1 - Ta purmp water From tank ¥ takank ¥ at not less than 800 liters per minute.
| Failure | 2 - Transfers less than 800 liters per minute,
| Effect | 1 - System does not perform ko capacity,
—Question 1 Answer 1
Is the occurrence of a functional Failure evident ko the operator during the performance of ;I »f
normal duties? ;I
L 1
L8l Lol
[ = ‘ ° Answer 2
—Guestion 2 Question 3 ][
Does the functional Failure or secondary: Does the hidden Functional Failure or |
damage resulking from the Functional secondary damage resulting from the PrEREs B
Failure have a direct adverse effect on Functional Failure have a direct adverse = [
operating safety or other hazardous effect on operating safety or other —I ==
resulbs? hazardous results? ;II
-
= es LT = ee LT Ansier 4
[ =
Guestion 4 SR EE— Guestion 5 S jl;‘\J
= |
AnsWer 5
Does the Functional Failure have a Dioes the hidden Functional Failure =
direct adverse effect on operating have a direct adverse effect on =
capability? operating capability?. - ;II
Remarks
£ Yes L T yes L jll_ﬁj
| | | \ - |
Category
Es Evi:lznt EvE:Iint s Hi:?en Hi:gen | =l
Evident safety - - Hidden Safety N N
Operational Econormic Operational Econormic
s
4 (0] 4 | Caniel |
| Last Update Date: 4/g/2005 v

e Answer Yes to Question 1, No to Question 2 and No to Question 4 to categorize the effect as EE -
Evident Economic.
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'E.‘Failule Effect Categornization

[_[Of ]

Current Item | 1 - Subsystem A

Function | 1 - To pump water From tank X to tank ¥ at not less than 00 liters per minuke,

| Failure | 2 - Transfers less than 800 liters per minute.

EFfect | 1 - System does not perform ko capacity.

—Question 1

& Yes

Is the accurrence of a Functional Failure evident to the operator during the perfarmance of
niormal duties?

Mo

—Question 2

Does the functional Failure or secandary
damage resulking from the Functional
failure have a direct adverse effect on
operating safety ar other hazardous
resulks?

" yes & HNo

Question 3

Dioes the hidden Functional Failure or
secondary damage resulting from the
functional Failure have a direct adverse
effect on operating safety ar ather
hazardous results?

[ E—

Question 4

Does the Functional Failure have a
direct adverse effect on operating

Dioes the hidden Functional Failure
have a direct adverse effect on

capability? operating capability?.
€ Yes & N  Ves LT
| | | |
Es EOQ EE Hs HO HE
Evident Safety Ewde:nt Ewdenl_: Hidden Safety Hlddz_en Hldden_
Operational Economic Ciperatianal Econormic

Answer 1

Explanation of answer 1.

i
5]

i

Answer 2
Explanantion of answer 2, ;ll_ﬁj
=
¥ 1
Answer 3
==
=l
¥ 1
Answer 4

Explanation of answer 4,

L]
o

had

Answer 5

ol
&

-

Remarks
Remarks relating to FEC analysis,

juls
&

= |

Category
IEE - Evident Economic j

[F7]el __ = |

| Last Update Date: 4/572005

e Click OK to save the changes and close the window.

3.4.8 Perform Maintenance Task Selection

RCM++ provides full support for the Task Selection logic in the major industry guidelines for RCM along

with the ability to compare the operational costs of potential maintenance strategies.

If desired, you can also provide an explanation for your answer to each question and/or general remarks
associated with the FEC analysis for this effect in the text boxes on the right side of the window.

RCM++ 4 Training Guide
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e To perform the task selection for the first potential cause of failure, double-click inside the T column to
the right of the cause with the description “Motor burns out.” The Maintenance Task Manager window
for this cause will be displayed, as shown next.

E‘Mainlenance Task Manager |_ (O] x|
| Current [kem | 1 - Subsystem A
| Function | 1 - To pump water from kank ¥ to tank ¥ at not less than 800 liters per minute.
[ Failure | 1 - Unable to transfer ary water at all
| Effect | 1 - Syskem fails.
| Cause | 1 - Makar burns out,
FECZ: ECQ - Evident Operational [+ Display Task Selection Logic
Question % vesiNo ® Explaniation -
11 Is a scheduled service task (such as lubrication) applicable and
4 effective? s 'ﬁ
z: Is a scheduled on-condition inspection task applicable and " 'ﬁ
" o
effective?
3t Is a scheduled repair/replacement task applicable and o Iﬁ
effective?
4: Is an up-front one-time task {such as re-design) applicable and " 'ﬁ
" o
effective?
¥
i E
Run to Failure:  Cost per Uptime | 0.818 / Hour Average Availability (%) 99.116
. Labor {Crew Total Duration Total Cost Cosk per Bveri ~
7Y
| # Task Mame Status | Type Assigned Inter... | Hame) e et i e Upkime
-
«| | 3
Skabus Type
[ = = @ Add Task.. | @8 AddlnkedTask. g EdiTask. |[gz  DelsbsTask|
| Maintenance Packaging... | Refresh | [o]'4 | Cancel |
V.

The applicable task selection questions (based on the logic that has been defined for the project and the FEC
for the associated effect) are displayed in the middle of the window. The Cost per Uptime and Average
Availability percentage that has been calculated for a run-to-failure maintenance strategy (i.e. no preventive
maintenance tasks) is displayed below that. The tasks that have been considered to address this issue are
displayed at the bottom of the window.
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e Click the Yes/No column to the right of the third question to change the answer to Yes, indicating that a
scheduled repair/replacement task is applicable and effective to address this issue. If desired, you can
type some additional comments in the text box to the right.

’&_‘L‘Mainlenance Task Manager |_ (O] x|
| Current [kem | 1 - Subsystem A
| Function | 1 - To pump water from kank ¥ to tank ¥ at not less than 800 liters per minute.
[ Failure | 1 - Unable to transfer ary water at all
| Effect | 1 - Syskem fails.
| Cause | 1 - Makar burns out,
FECZ: ECQ - Evident Operational [+ Display Task Selection Logic
Question % vesiNo ® Explaniation -
11 Is a scheduled service task (such as lubrication) applicable and " 'ﬁ
. o
effective?
z: Is a scheduled on-condition inspection task applicable and " 'ﬁ
" o
effective?
» 3t Is a scheduled repair/replacement task applicable and Yes Comments regarding efficacy of repaii/ieplacement task | = Iﬁ
effective? -
4: Is an up-front one-time task {such as re-design) applicable and " 'g
" o
effective?
¥
i E
Run to Failure:  Cost per Uptime | 0.818 / Hour Average Availability (%) 99.116
. Labor {Crew Total Duration Total Cost Cosk per Bveri ~
7Y
| # Task Mame Status | Type Assigned Inter... | Hame) e et i e Upkime
-
«| | 3

Skabus Type

I'q" j I'q" j E Add Task... ” @ Add Linked Task. ., | B Edit Task. .. | B Delete Task ‘
| Maintenance Packaging... | Refresh | [o]'4 | Cancel |
V.

e Click the Add Task button to open the Task Properties window. Enter the following information on the
Task page:

o Task #: Accept the default number.

o Task Name: Type “A scheduled repair for the motor.”
o Type: Select “Repair/Replace (RR)” from the menu.
o Status: Select “Assigned” from the menu.

e Click the PM Resources tab to describe the resources required to perform the scheduled repair. Enter the
following information:

o Labor Rate: Enter 150 per Hour.
o Task Duration: Enter 4 Hours.

o Restoration Factor: Enter 1 to indicate that the motor will be restored 100% by the repair (i.e. as
good as new).
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o Materials Cost: Enter $500

# Task Mame
I 7 I & scheduled repair For the matar, :ll l,ﬁ
[ 1

Task  PMResources | User Defined |

‘ Item Operating Time | 10 Year Ikem Downtime Rate ‘ Edit...

Materials (Spare Name/Part Mumber)

I ﬁlﬁl Restoration Factor lli
[ i 1
Labor {Crew Mame) —iCost per Incident
l =] Misc. Cost —
! = ! Downtime Cost
Lt iz I 150.00 = IHUL" j Labor Cost Per Incident l—
Task (D Time Based Labor Cost 600,00
Dielay - Wait For Labar I
Dielay - Wait For Materials I— Total Labar Caost ’T
Task Duration [ # Materials Cost [ 500.00
Total Duration per Incident 4 Hour Total Cost per Incident 1,100.00

Cost per Uptime Total Operating Cost Average Availability (%)
+
" = o AEC
% Ij‘ | Associated FMEA, ., ” =]  Show Cause... ” ‘Q” ) ” i || 22| %5 ” “j| oK | Cancel |
[ | Adding new Task

e Return to the Task page to define the maintenance interval. Click Calculate Optimum to allow the
software to determine this interval based on the cost of corrective repair, the cost of preventive repair and

the probability of failure. Accept the calculated value, 2650.805 Hou rs* and Set as Assigned Interval.

Calculated Optimum Interval: 2650.8605 Hour
% Set as Assigned Inkerval
™ Set as Proposed Interval

" Do Mat Use

Ok I Cancel L

RCM++

Note that the Optimum Interval utility assumes a Restoration Factor of 1 for both Corrective
Maintenance and Preventive Maintenance.

e Click the Calculate icon to simulate the operation of the equipment and estimate the Cost per Uptime,
Total Operating Cost and Average Availability for this maintenance strategy.

=

4 To change the number of decimal places displayed in your results, select User Setup from the File menu, and click
the Other tab. Change the Displayed Math Precision field to the desired number of decimal places, then click OK.
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A Dblue progress bar will appear at the bottom of the Task Properties window as RCM++ runs the
simulations. If you have not changed the default user settings, when the progress is 100% complete, the
simulation results will be displayed, as shown next.

Simulation Results - Calculation Inputs

o ofChs = 20524
\11) #of PMs = 16614
Uptime = 87032932 Haur

Click OK. The Task Properties window will look like the figure shown next.

[M/Add Task ]
# Task Mame
I 7 I & scheduled repair For the matar. j @
[ hd ]
Task |PM Resources | User Defined |
Type Task Description
IRepair,l’RepIace (RR) j ﬂl_lﬁj
Status
IAssigned j =
¥ |
Maintenance Package Reference Document
= |
[ k |
Proposed Interval Urits assigned Inkerval Units
I j I 2650.805 Hour j Calculate Optimun. ..
Basedon =  Item Age  System Age
Condition
= |
I [l 'ﬁ
L - 1
Remarks
= |
[ S|
[ LS |
Zone I @J Access @J
Cost per Uptime Total Operating Cost Average Availability (%)
| 0,754 ] Hour | 65,628.20 | 99.35
i
" = 0 o
% | Associated FMEA, ., ” =]  Show Cause... ” ’QH E ” || 22|| = ” '_;/| oK | Cancel |
= | Adding new Task

Click OK to save the changes and close the Task Properties window then click OK again to close the
Maintenance Task Manager.

3.4.9 Package the Maintenance Tasks

RCM++’s Maintenance Task Packaging utility allows you to group individual tasks together based on
interval, labor requirements, etc. to achieve the most efficient maintenance plan that is possible.

RCM++ 4 Training Guide
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e Select Maintenance Packaging from the Project menu to open the Maintenance Task Packaging

window for this project, as shown next.

E‘ Maintenance Taszk Packaging |_ (O] x|

This window displays all non-linked tasks in the current project. Drag and drop a task ko add o remove it from a maintenance package. Double-click a task

or package to viewledit its properties. Use the menus ta filker the display.

| Maintenance Packages and Packaged Tasks

Labor (Crew Total Duration Tokal Cost Caosk per By -
| & Vsl e Siiie | Trpe Risiazd oo, Mame) | per Incident per Incident Uptime
¥
< | »
I[‘Q Expand Tree || I;‘ Collapse Tree | ™ shaw Packages Only Add Package... ” Edit Package. .. H Dielete Package |
| Individual Tasks
: Labor (Crew Total Duration Total Cost Cosk per Averag ~
. C
& Task Hame e Type Assigned Inter... MName) per Incident per Incident Lptime
On condition The labar
» 1 Fask bo inspeck Assigned ocC 3 Month e 0,25 Hour 12,50 0,655 [ Hour
2 |On condtion Assigned oc 3 Manth The labor 0.5 Hour 25,00 0,343 { Hour
task ko inspech requirements for
4 |On condition Rejected oc 1 Month The labor 0.25 Hour 25,00
task bo inspech- requirements fok
Re-design the
5 cquipmert ko + Assigned oT 10,000.00
g |Aschedued Assigned RR | 748695 Hour | Nelabor 2 Hour 210.00
replacement. + requirements for ¥
4| | v
Status Type Assigned Inkerval Labor {Crew Mame)

[

= Je

=

Jan

‘ Auta-Package Tasks

Un-Package Tasks

=

[

|Ma|ntenance Task Packaging

e Maintenance packages and packaged tasks are displayed at the top of the window and individual
unpackaged tasks are displayed at the bottom of the window. Click Add Package and type Every 3

Months for the Name, as shown next.

@Add Maintenance Package [ %]

# Mame

[ 1

IEver_l,l 3 Months
[

[rescription

Auto-Package Criteria

™ Assigned Interval
™ Labor {Crew Name)

™ Type

Urits

L]

Lancel

|Adding new Maintenance Package

e Click OK to create the package.
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e Now select the first individual unpackaged task with the description that begins “On condition task to
inspect impeller for wear...” and drag/drop the task under the package that you just created. The window
will now look like the figure shown next.

'E‘ Maintenance Taszk Packaging |_ (O] x|
This windaw displays all non-linked tasks in the current project. Drag and drop a task ta add or remove it from a maintenance package. Double-click a task ar
package ko viewfedit its properties. Use the menus to filter the display.

‘ Maintenance Packages and Packaged Tasks

Assigned Labar (Crew Tokal Duration Total Cost Cost per Overa ~
& | Vet i Sl | TR Inkerval | Marne) per Incident per Incident | Operating Time
Every 3
g i Months
on condition . The labor
» 1 Eask b inspec Assigned o 3 Month requirements For 0.25 Hour 12,50
=
| | 3
|[‘Q Expand Tree ||[p Colapse Tree | ™ show Packages Cnly Add Package... ” Edit Package... ” Delete Package |
‘ Individual Tasks
Assigned Labar {Crew Toatal Duration Total Cost Cost per Average Avail ~
A
# T Wi SEE Type Interval ame) per Incident per Incident | Operating Time o,
0On condition The labar
» 2 Fask bo insneck Assigned ocC 3 Month T 0.5 Hour 25.00
4 |9n condition Rejected oc 1 Month The lsbor 0,25 Hour 25.00
task bo inspeck- requirements fok
Re-design the
5 cquipmert to + Assigned oT 10,000.00
g |Ascheduled Assigned RR | 748695 Hour | TMelabor 2 Hour 200.00
replacement. + requirements for
7 |Aschedded Assigned RR 2650,505 Hour 4 Hour 1,100.00 0,934 { Hour 99,267
repair For the +
¥
| | »
Status Type Assigned Inkerval Labar {Crew Marne)
Jen | ETIES [ ] = e =l
| Auto-Package Tasks H Un-Package Tasks | Clase |
‘Ma\ntenance Task Packaging 4

Other methods to assign a maintenance task to a package (i.e. assigning the package from the Task
Properties window or using the Auto-Package Tasks feature) are described in the RCM++ User’s Guide.

e Click Close to exit the utility.

3.4.10 Generate a Report of the Analysis

RCM++ provides a complete set of reports for your analysis. Reports can be generated in Microsoft Word
and/or Excel, which provides maximum flexibility for customization and the ability to create HTML and
PDF versions of the reports, as desired.

e To open the Report Generation window, select Generate Reports from the Project menu. The Report
Generation window will appear, which allows you to specify the items and forms you want to include in
the report and whether you want to create the report in Microsoft Word or Microsoft Excel.

e Select the Subsystem A item in the area at the top of the window. Do not select components.

e Onthe FMEA Reports page, click Deselect all FMEA reports to clear all selections and then select only
the Report Summary form.

e Go to the RCM Reports page and click Deselect all RCM reports. Select the following report forms:
o Equipment Selection
o Functional Failure Analysis
o Failure Effect Categorization
o Maintenance Task Selection

o Maintenance Task Summary
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e You will notice that some of the report forms allow you to select which field (column) to sort by. Accept
the default selections for this example.

e In the Select Output Type area of the window, select Word Document. The window will now look like
the one shown next.

'E.‘Repnrt Generation

Select Items to include in the report:
Name [~
B[ system
» =]V Subsystem A
Component 1
= = Select all
- | Component 2 =
-.] Component 3 R | = Deselect all
FMES Reports  RCM Reports
[~ Equipment Selection Lagic ¥ Maintenance Task Summary I~ with Costs
¥ Equipment Selection SaitlEy ITask# j
Sort By IHiararchicaI j [ Maintenance Task Summary (Detailed)
Sork By [Task # -
[ Equipment Reliability and Maintainahility I a3 J
Sork By IHierarchicaI j [~ Maintenance Package Summary
Sort B
[~ Equipment Reliabilty and Maintainability (Detailed) or. By ITGSK# j
Sort By IHierarchicaI j [~ Maintenance Package Details
[~ Integrated Documents) SEiElEy ITESK# j
¥ Functindl Failure Analysis [ Maintenance Task Details Range
“With FEC Shiith Emd Effect anl With Tasks
r L A % Compact " Extended
[ Failure Effect Categorization
¥ Maintenance Task Selection
| i— Select all RCM reports ” — Deselect all RO reports |

Select Oukput Type
’75' word Document € Excel Spreadshest ‘ ES) | Generate Repott. ..
Close |
.

e Click Generate Report. The Save Report As window will appear, which allows you to specify the name
and location for the report. Specify to save the report as RCM Quick Start 1.When you click Save, a
blue progress bar will appear at the bottom of the MDI. When the progress is 100% complete, the report
will automatically open in Microsoft Word.

e Once you have finished viewing the report, leave it open. Return to RCM++ and close the Report
Generation window by clicking the Close button.

3.4.11 Generate Charts Based on the Analysis

RCM++ also provides a complete array of plots and charts for graphical presentation of your analysis.

e To create plots and charts, select Plot Viewer from the Project menu.
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In the Select Items window that appears, select to include data associated with Subsystem A, as shown

[}
next. Do not select any of the components.
@Select Items |_ (O] x| |
Mame -
=[] System
» [=F-Iv|_Subsystemn A&
-] Component 1
-] Component 2
-] Component 3
< o[
|E Select Al ”E Deselect Al |
|
4
e Click OK.
e The Plot Viewer utility will appear. Select Task Type Pie from the Plot Type drop-down menu in the

Control Panel on the right side of the window. Make the following selections:
o Auto Refresh = Selected

o Show Legend on Plot = Selected
o Show Details in Pie = Not Selected

o Show User Information = Not Selected
The plot, which displays the percentage of tasks in the data set that have been assigned to each of the
available task types, will look like the one shown next.

Tasks by Type

Plot Type

- ITask Type Pie j
Record Type
ITask j

Record Quantity [3

¥ Auto Refresh

¥ show Legend
[ show Details in Fies

Totdl Quirtity of Tasks = &
[ 5how User Information
Database: C;\Program Files\Reliasoft\RCME, Training|RCMOStart 1t -
Project: RCM Quick Start 1

[selected Items:
1.1 - Subsystem A
Close
= y

Tasks by Type
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e Next, select Task Cost Pareto from the Plot Type menu. Since Auto Refresh is selected on the Control
Panel, the Plot Viewer will be updated automatically to display the plot type you have selected. Make the
following selections:

o Display Range: 1to 5

o Cost Type = Total Cost per Incident

o Auto Refresh = Selected

o Show Legend on Plot = Selected

o Show Details in Pie = N/A

o Show User Information = Not Selected

The plot, which displays the top five maintenance tasks ranked by Total Cost per Incident (highest to
lowest), will look like the one shown next.

Tasks Ranked by Total Cost per Incident (1 - 5)
B Total Cost per Incidernt Flot Type
ITask Cost Pareto j
Record Type
ITask j

Record Quantity [3
(Display Fange

From; |1 To: |5

Cost Type
ITUtaI Cost per Incident j

¥ Auto Refresh

¥ show Legend

Task ' [ show Details in Fies
[ 5how User Information

Database: C;\Program Files\Reliasoft\RCME, Training|RCMOStart 1t -

Project: RCM Quick Start 1
[selected Items:

1.1 - Subsystem A

Close
Tasks Ranked by Total Cost per Incident {1 - 5} j v

3.4.11.1 Copy Plot Graphic and Legend
RCM++ allows you to add the plot graphic and legend to other documents, such as the print-ready report of
your analysis.

e To do this, right-click inside the plot area and select Copy Plot Graphic from the shortcut menu that
appears.

e Next, go to the report that you created in Microsoft Word for this example and paste the graphic into the
document.

e Now return to the Plot Viewer and right-click inside the plot area again or inside the legend panel. This
time, select Copy Text Legend from the shortcut menu and return to the report.

e Place the cursor below the plot graphic and paste the contents of the Clipboard into the report.
e You can save the changes you have made to the report, if desired, and then close Microsoft Word.

e Close the Plot Viewer by clicking Close.
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3.4.12 User-Defined Queries

The Query Utility allows you to query the current project for the records that meet your specific query
criteria. The results of the query are returned in tabular grids that can then be exported to Microsoft Excel, if

desired.®

e To access the Query Utility, select Query Utility from the Project menu. The utility will appear, as
shown next.

[MlPraject Query utility
Limit: Query by Last Update Date Uit Query by Spachiad Teems
From
Mame [=]
E = B[ System
B[ subsystem &
[¥ Component 1
[V Component 2
[V Component 3
__:g Selsct Al
~l|:=  Desslsctal
Query Ttems |Query Functions | Query Failures | Query Effects | Guery Causes | Query Actions | query Controls | Query Tasks | query all|
Enter search criteria for any of the properties. The checkboxes determine which columns will be displayed in the results, Other columns displayed:
Trem # Tkem Mame ¥ | Initial RPN ¥ Revised REN ¥ Project Name
| ! ::]‘ to to
[ Part Mumber [ alternate Part Mumber ¥ Item Description
I 2 ] L = I = ]
[ Remarks [ Supplier ¥ Similar To
I 2 1 I 2 1 [ = 1
[¥ | Desian Engineer ¥ | Brawing humber, ¥ caGE code
[ 2 1 [ 2 1 = 1
¥ Lcn [ | Reference Designatar: ¥ Enwiranmental Conditions
[ 2 1 [ 2 1 [ = 1
|l I¥ | Uiser Defined|1 J¥# | User Defined 2
I 2 ] I 2 1 = 1
I¥ | User Defined I¥ | User Defined 4 J# | User Defined 5
[ 2 1 [ 2 1 = 1
‘ Resst Criteria || Save Query... H Selact Query... || Run Query ‘ o Close
|Project Guery Uity 7

e Select Subsystem A, as before, in the area at the top of the window to specify that query results will only
include data associated with this item.

e Click the Query Tasks tab to specify the criteria to find specific maintenance tasks in the current project.

e For Type, select On Condition (OC) from the drop-down menu. For Status, select Assigned from the
drop-down menu.

5 You can also use the Query Utility for database level queries by selecting Query Database from the Tools menu in
the MDI.
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e You can specify which columns you want to appear in the query results by setting the checkboxes at the
left of each property. For this example, accept the default selections. The window will look like the one

shown next.
[MIProject Query Utility

Limit Query by Last Update Date
( o

Lint Query by Specified Ttems

Mame

i e
|

E ] system

» -]V Subsystem &
™ Component 1

[ Component 2

[ Component 3

= Select Al
wllfs= Deselect Al

Query Items | Query Functions | Query Failures | Query Effects | Query Causes | Query Actions | Query Controls  Query Tasks |Query al|

Enter search criteria For any of the propetties, The checkboxes determine which columns wilbe displayed in the resuts.

Other columns displayed:

Task Number Task Name [# Task Description
[ = 1 [ 2 1
¥ Type ¥ status [¥ Maintenance Package
Jon Candiion (ocy | [assigned =
[ 2 1
IV Condition I Remarks IV Reference Document

=

=

¥ Proposed Intarwval
to Al

IV Detection Threshold
0 |t |1 =

¥ PF Interval

¥ Assigned Interval
- to Al

IV zane

[V Restoration Factar
= o «|ta 1 ~+

v Access

=

¥ Labor (Crew Mame)

[¥ Materials (Spare Mame/Part Mumber)

[ I

Resources Units

¥ Labor Cost per Uit Tims

[¥ Total Duration per Incident

[an

IV Tatal Cost Per Incident

=] ] o |

[V Cost per Operating Time

I o |

[¥ Total Operating Cost

[¥ Project Name

IV Ttem #

IV Item Mame

Iv Function

IV Failure

IV Effect

v Cause #

[~ On Condition PM Resources

I~ Full Task Resourcas

[ to [ o | [ o |
I¥ | Uiser Defined)1 J¥# | User Defined 2 I¥ | User Defined
I = [ :l| ! ::’\
I 2 ] < 2
[¥ | Lser Defined 4 [ | User, Defined 5 [¥ Failure Mode (Cause)
! ::’\ ! ::’\ I ::’\
¥ FEC
Jal |

| Reset Criteria H Save QuEry... || Select Query... H Fun Query

Project Query Utiliy
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e Click Run Query. The query results will appear in the Query Results window, as shown next.

B‘Query Results |_ (O] x|

Query Tasks :

Selected ltems:
1.1 - Subsystern A

Type: On Condition [OC)
Status: Assigned

Task. # 4 Task Mame Type Skatus Task Description Maintenance Package =
On condition kask to
1 1 |nsp§c_t_|mpe|ler fFor wear on Condition (9C) fssigned Short description of the Every 3 Months

and initiate preventive task,
maintenance it
On condition task to
inspect suction line for - . Short description of the

2 12 obstruction and initiate On Condtian (OC) Assigned kask,
preventive maintenance-

-
| | »

Refresh ¥ auko Refresh Send to Excel | Close |/

The criteria you specified for the query will appear at the top of the window. The results of the query will
appear at the bottom of the window. These results will vary depending on the type of record and on the
criteria you selected to include in the query, including the columns you selected to be displayed. You can
click the column header to sort the results by any of the columns.

e Click Send to Excel to send the query results to a spreadsheet in Microsoft Excel.

e A window will appear that allows you to specify the name and location to save the results to. Enter RCM
First Steps Query.When you click Save, a blue progress bar will appear at the bottom of the Query

Results window. When the progress is 100% complete, the query results will automatically open in
Microsoft Excel.

e Close Excel then close the Query Results window.

e From the Query Utility, you can save the query criteria as a custom query by clicking the Save Query
button. The Save Query window will appear, as shown next.

[Mlsave Query E
Mame

+
E O I Cancel |

e |Saving Query

e Type RCM First Steps Query for the query name and save it as a custom query by clicking OK.
e Close the Query Utility.

3.4.13 Close the Database
e To close the database, select Close Database from the File menu or click the Close Database icon.

L& lose Database
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e Notice that “No Current Database” appears in the caption bar and status bar at the top and bottom of the
MDI, indicating that a database is not currently open.®

M ReliaSoft RCM++ - No Current Database [_ O] =]

gﬁle Tools  MWindow  Help

& Meve Database... Open Database... f;? Close Database | j Yiew Project Explarer... | @ 9,

ReliaSaft RCM++ - No Current Database | 4f11f2005

6| you do not close the database, it will be closed automatically when you create a new database for the next example
or open an existing database.
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4.1 List of Examples

This chapter provides the following step-by-step examples, designed to introduce you to the features of the
RCM++ software:

e Example 1 - Simple MSG-3 Analysis for Aircraft Subsystem - page 33
e Example 2 - Add Authorized Users to Secure Database - page 47

e Example 3 - Maintenance Task Intervals, Costs and Packaging - page 50
e Example 4 - Excel Import/Export for Items and/or FMEAs - page 59

e Example 5 - Using the Plot Viewer Utility - page 62

e Example 6 - RCM Analysis for Conveyor Belt - page 70

e Example 7 - RCM Analysis for Dust Filter - page 74

e Example 8 - Cost and Availability Comparisons - page 78

e Example 9 - Integration with BlockSim via XML - page 85

e Example 10 - Using the Check Analysis Utility - page 89

e Example 11 - Using Profiles/Libraries for Customization - page 94

e Example 12 - Advanced Techniques for Profiles/Libraries - page 101

e Example 13 - Using Revision Tracking Features - page 107

e Example 14 - Using Change Logs - page 112

e Example 15 - Perform Your Own RCM Analysis - page 119

4.2 Example 1 - Simple MSG-3 Analysis for Aircraft Subsystem

This example guides you through the process of performing an RCM analysis for an aircraft subsystem
following the MSG-3 guidelines.

For this example, you will work with sample data provided for demonstration purposes. This information is
not intended to be realistic.

4.2.1 Enable Login Security

The first step for this example is to configure the software so that the new databases that you create will
require a username and password to access the database.

e To do this, select User Setup from the File menu and click the Settings (1) tab.
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e Select the Enable Login Security features for new databases option, as shown next.

'&_'L‘ User Setup

User  Settings(1) ISettings(Z) | Hierarchies | Descriptions | E-mail | Prioriy | wiarnings | Reports | other |

x|

Login Security
¥ Enable Login Security features for new databases
V¥ Always ask For password for databases with Login Security

Rall Up RPMs from Cause ko:

I Effect [ Failure I Function

™ ttem

—I Creats Default Function For ll new [tems

Description | XEM performs as intended

r—Control Plans and DYP&Rs
[V Inteqrate Mew Control Plans with FMEA

i+ Items " Functions

7 Integrate Mew DYP&Rs with FMEA

—Simulation Settings For Cost Calculations

Mumber of Simulations 1000

¥ Use Seed for Randam Mumber Generator Il

’*Set the Assigned Interval 'Age' option for new Tasks ka:

{* Item Age ™ System Age

RCM++

| ’E Run User Setup Wizard, ..

e Click OK to close the User Setup.

4.2.2 Create a New Database

e Create a new database by selecting New Database from the File menu or by clicking the New Database

icon.

f# Mew Database. ..

e Inthe Create New Database window, type the name AircraftExample and click Save to continue.

The Database Creation Wizard will be displayed, which guides you through three simple steps required to

create a secure database in RCM++.

e In Step 1 of the Database Creation Wizard, type username in the Username input box and type
password in the Password input box. This will be the username and password that you will use to log in
to the database. Type the password again in the Confirm input box to confirm it. Type the rest of the
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required information in the Creator/Administrator Information area (indicated with red text), as shown
next with sample information.

'E‘Datahase Creation Wizard [ x|

C: am

Wizard Step 1 of 3

— Creator/Admini Logn
Fleaze enter your ugername and password for this new databaze.

Future acocess to this database will be based on this usemame and
pazzword,

| Usemame Iusemame

| Password I xxxxxxxx
| Corfim I xxxxxxxx
—Creator/Admini
Cantact First Mame IF\rst
infarmation for
the database Last Name [Last
creator
[admiristrator]

E-mail Ifilsl.last@company.com

Title: ICreator Title

Cormpany ICompany Mame
Phone IPhone Mumber

i |_we |

I

e Click Next to continue.

Step 2 of the Database Creation Wizard allows you to add authorized users to the database.

[MIpatabase Creat

rd E

Wizard Step 2 of 3

3

Would you like to add other authorized users ka this
+ i database?

i Yes, Twould like to add other users now,

% No, I may do so at alater time,

o |[ow ]

e For this example, we will not add authorized users so select No, | may do so at a later time. Click Next.

I
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Step 3 of the Database Creation Wizard allows you to create a project for the database.

'E‘Datahase Creation Wizard [ x|
ram_Fil Chi 4’ aftExample. red

Wizard Step 3 of 3

Done, Would you like ko create a new
‘ project For this database?

% Yes, T would like to create a project now.

Mo, T will create the project later,

I

Select Yes, | would like to create a project now and click Finish.

4.2.3 Create a New Project

After you have created the new database, the next step is to create a project within the new database. The
New Project window allows you to set the properties that apply to all of the analyses within the given
project. This includes:

Interface Style: which determines which data fields will be enabled/displayed for the analysis (and
what they will be called). This includes user-defined fields.

Severity, Occurrence and Detection Rating Scales: which allow you to rate the relative severity of
the failure effects and the relative likelihood of occurrence and detection for the failure causes, if you
are using the Risk Priority Number (RPN) risk assessment methodology that is commonly employed
in FMEA analyses.

Menus: which set the available options for menus throughout the analysis, such as Action
Categories, Task Statuses, etc.

ES Questions: which determines the questions and categories that will be used for the Selection
Questions method of RCM equipment selection.

ES Criticality: which determines the categories, factors and ratings for the Criticality Factors
method of RCM equipment selection.

FEC Logic: which determines the questions and categories that will be used for the RCM failure
effect categorization.

Tasks: which determines the questions and task types that will be used for the RCM task selection.

36
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4.2 Example 1 - Simple MSG-3 Analysis for Aircraft Subsystem

e In the New Project window, type Engine Fire Detection MSG-3 for the project name. At the bottom of
the window, click the Use Profile to set properties button and select the MSG-3 profile from the drop-
down menu, as shown next.

[MINew Project [ x|

General |Interface I Severity I QCCurrence | Detection I Severity Class I Failure Probability I Menus I ES Questu;l_’l

Eased on Profile Standard RCM

MName
IEngine Fire Detection M3G-5

Drescription
I | <]
[l

Remarks

| 2

Proprietary Label
| (]

Select Profile from Library

| Use Profile ta set properties Standard RCM j |§“§|
ALAG DFMERA
ALAG PFMEA

Comprehensive Cancel |
11739 DFMEA
Adding new project 11739 MFMEA

1739 PFMEA
MIL-STD-16294

RCM++

RAC RCM

SAE RCM (4 Cateqories)

SAE RCM {6 Categories)
Standard FMEA

Standard RCM

YDA-Yold Process System FMEA
¥DA-Yol4 Product System FMEA

e You can then click each of the tabs in the Project Properties window to view the properties that have been
set automatically by selecting the MSG-3 profile. Note that these properties cannot be edited until you
have saved the project for the first time. The FEC Logic page for the MSG-3 profile is shown next.

@New Project E
Detection I Severity Class I Failure: Probability I Merius I ES Questions | ES Criticality ~FEC Logic |Tasks I 4 I 3

| 5 Categaries {Split in Yes Branch)

Questions Cakegories
Is the occurrence of a functional Failure evident ko - Evident Safety
the operating crew during the performance of their ~ Evidert: Operational

riormal duties? " -
— - - Evident Economic
Dioes the Functional Falure or secondary damage -
- Hidden Safety

- Hidden Economic

r

resulking from the Functional Failure have a direct
adverse effect on operating safety?

Dioes the combination of & Hidden Functional Faiure
and one additional Faiure of & system related or
backup function have an adverse effect on
operating safety?

Cioes the Functional Failure have a direct adverse
effect on operating capability?

o oo fra e
FEEIEE

[

s

Edit...
Apply Existing

RCM++

| Adding new project

e Click OK. The Project window will appear. The Project window is the main window that you will use to
perform your analyses. It presents all of the items, functions, failures, effects, causes, controls, actions,
tasks and related properties that you have defined within a particular project and provides all the tools
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required to add and edit these records. Notice that the project name, Engine Fire Detection MSG-3,
appears in the caption bar at the top of the window.

[MlEngine Fire Detection MSG-3 M= E3
Project  Edit Wiew System Hierarchy Funchion  Failure  Effect Cause |
| | |zoom-|H 4] (M E G- N | @]
System Hierarchy FMEA Hierarchy

[ull| Hame [ [EIm]=] 2] Description [EFalclrcl1]=

- -
A 2 A 2

[l System H 4

The Project window is divided into two panels. The panel on the left displays the System Hierarchy, which
includes all items that have been defined in the project. The panel on the right displays the functions,
failures, effects, causes, controls, actions and tasks associated with the item that is currently selected in the
System Hierarchy panel. For this example, we will use the hierarchical view of this information.
4.2.4 Define the System Configuration
The analysis will be performed on the Engine Fire Detection subsubsystem, which has two components:
Zone 1 Sensor and Zone 2 Sensor, as shown next.

Engine Fire Detection

e Zone 1 Sensor
e Zone 2 Sensor

e To define this configuration and the specific properties of the item that is currently undergoing analysis,
select Add System from the System Hierarchy menu to open the Add System window.

e Inthe Add System window, accept the default item number, 1, that appears in the # input box.*

L The item # will automatically be set for you if the Autonumber new Items option is selected on the Settings (2) page
of the User Setup. If it is not automatically set, type 1 in the # input box.
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e Type Engine Fire Detection in the Item Name input box. The Add System window will look like the
one shown next.

[Mladd system [ x|
‘ Parent System | 1Y
‘ Mext Higher Assembly |N,|’A
General |Other I User Defined |
# Itern Mame
I 1 IEngine Fire Detection Lﬁj
Part Mumber Alkernate Part Number
Item Description
_ ;II
Remarks
_ ;II
Gty per System Qb per NHLA Ibem RFH
I I | Initial I Revised |
|R Reliability. .. ” Bnalysis... ” Analysis Plan,.. ” &€ Eaupment Selection... |
+
- e
E Fe] i @ || % (7] of | Cancel
o
= |Adding new System

e Click OK to add the top level item to the system hierarchy.

e Next, add the Zone 1 Sensor component to the system configuration by selecting the system, Engine
Fire Detection, and then selecting Add Next Level Item from the System Hierarchy menu.

e Inthe Add Item window that appears, accept the default item number, 2, and type Zone 1 Sensor in the
Item Name input box. In addition, enter the following item properties on the General and Other pages of
the window:

o Part Number: AC2611G201
o Qty per System: 16
o Qty per NHLA: 4
o Supplier: VORTOS Inc.
o Similar To: Various
e Click OK to add the item to the configuration.

e With the Zone 1 Sensor item selected, select Add Same Level Item from the System Hierarchy menu
and enter the following item properties:

o #3

o Name: Zone 2 Sensor

o Part Number: AC2611G202
o Qty per System: 8

o Qty per NHLA: 2

o Supplier: VORTOS Inc.

o Similar To: Various

e Click OK to save the changes and close the window.
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Once all three items have been added to the system hierarchy, your Project window will look like the one

shown next.

[MlEngine Fire Detection MSG-3

Project  Edit Wiew System Hierarchy Funchion  Failure  Effect Cause

| Zone 1 Sensor
|| Zone 2 Sensor

-
4| | » 4

s x| & = | | zoom~ [ H 41 LW |2 A~ Y| & | | |@ |

System Hierarchy FME&A Hierarchy - Engine Fire Detection
=] Name o i I i =1 Description HEREE
| A= @ Enaing Fire Deteckion

Ea System HEngine Fire Detection

4.2.5 Define the Functions

The following functions have been identified for the system in this example:

To provide Fire Zone 1 & 2 fire detection/overheat signal to the airframe.

To provide fire loop failure signal.

e To define a function, select the item it pertains to in the system hierarchy (in this case, Engine Fire
Detection) and select Function then Add Function from the System Hierarchy menu or press F6. You
can also right-click the item and select Function then Add Function from the shortcut menu. The Add

Function window will appear.

e Type the description for the first function, To provide Fire Zone 1 & 2 fire detection/overheat signal

to the airframe, in the Function input box, as shown next.

[MJadd Function

I | Current Tkem | 1 - Enging Fire Detection

Function | User Defined I

# Function

1 To provide Fire Zone 1 & 2 fire detection/overheat signal to the airframe,

2 ]

hd

Function RPR
’7| Initial I |

Revised |

EEEEE

of | Cancel |

e
= L
o
4

| Adding new Function

fre}

e Click OK. The function will appear in the panel on the right side of the Project window.
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e Add the second function to the system in the same way. When you have added both functions, the Project
window will look like the one shown next.

[MlEngine Fire Detection MSG-3

Project  Edit Wiew System Hierarchy Function Failure  Effect Cause

5 ECIEGE RN EER e

Zone 1 Sensar

Zone 2 Sensor

A

ol

airframe,

[#] detectionjoverheat signal to the

System Hierarchy FME&A Hierarchy - Engine Fire Detection
[m] Hame glrieim|«y 0o Description grlalclrc] «
P | = [, Enaine Fire Detection L Ta provide Fire Zone 1 & 2 Fire

» [ ¥ To provide fire loop Failure signal,

Ea System HEngine Fire Detection

4.2.6 Define the Potential Failures

Two potential failures have been identified for the first function in this example.

Fails to provide Fire Zone 1 & 2 fire detection/overheat signal to the airframe.

Provides erroneous fire warning.

e To define a failure, select the function and select Add Failure from the Function menu or press F7. You
can also right-click the function and select Add Failure from the shortcut menu. The Add Failure

window will appear.

e Type the description of the potential failure into the Functional Failure input box, as shown next.

Mladd Failure
[ Current Irem | 1 - Engine Fire Detection
| Function | 1 - To provide Fire Zone 1 & 2 fire detectionjoverheat signal to the airframe.
Failure | User Defined |
#  Functional Failure
| 1 Fails to provide Fire Zone 1 & Z fire detectionfoverheat signal to the airframe. ;ll_ﬁj
~ _II
Mission Phase/Operational Mode
=]
I _'I|ﬁlj
Criticality Analysis Factars Failure REN
IRatio of Unreliability IProbabiIity of Loss i I
; Revised I
Failure Probability Severity Class
[~ Undetectable Diormancy Period | ﬁ
BENE e oK | gance||

RCM++

| Adding new Failure

e Click OK. The failure will appear in the panel on the right side of the Project window.
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e Add the second failure in the same way. When you have added both failures, the Project window will

look like the one shown next.

[MlEngine Fire Detection MSG-3
Project  Edit  Wiew

System Hierarchy  Function Failure  Effect Cause

Zone 2 Sensor

s IS S E I R =R, D | Ee|
System Hierarchy FME&A Hierarchy - Engine Fire Detection
[m] Hame JEIN sl S A S Y Description g lrlalc|re
P | = B8 Engine Fire Detection [F] To provide Fire Zone 1 & 2 fire
e Zone 1 Sensor t_ P | =1 (k] detectionfoverheat signal to the
Alrframe,

A

Fails ko provide Fire Zone 1 & 2 fire
..[#| detection/overheat signal to the
airframe,

{8 Provides erroneous fire warning,

[#] To provide fire loop Failure signal,

-
2 A

| o]

[B|Function HTD provide Fire Zone 1 & 2 fire detection/overheat signal to the airframe.

4

4.2.7 Define the Potential Effects of Failure

One potential effect of failure has been identified for the first potential failure in this example:

Loss of fire detection/overheat signal from loop A or B. Alternative loop is still available.

e To define an effect, select the failure and select Add Effect from the Failure menu or press F8. You can
also right-click the failure and select Add Effect from the shortcut menu. The Add Effect window will

appear.

e Type the description of the potential effect of failure into the Effect input box, as shown next.

[MAdd Effect

Current Iem | 1 - Engine Fire Detection

| Function | 1 - To provide Fire Zone 1 & 2 fire detection/overheat signal to the airframe.

| Failure | 1 - Fails to pravide Fire Zone 1 & 2 fire detectionfoverheat signal to the airframe.

Effiect | User Defined |
#  Effect

K

Loss of fire detection/overheat signal fram loop A or B. Alternative loop is still available.

ad

Mexk Level EFfect

Local Effeck

=il

Critical Falure Criterion

Time Range ko Critical Failure

=<

l_ |<rianez

"Initial Severity

@ e

Revised Severity

EFfect RPM
’7 Initial I Revised I
N
q
E |ﬁ Categorization ” ‘\EQ” Q” 0] ”_/.;H ":“r” @| [o]:4 | Cancel |
o
(-3

| Adding new Effect
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e Click the Categorization button to display the Failure Effect Categorization (FEC) logic for this
analysis. Answer Yes to Question 1, No to Question 2 and No to Question 4 to categorize the effect as 7
- Evident Economic.

e Click OK to close the (FEC) window and then click OK to close the Effect window.

e The effect will appear in the panel on the right side of the Project window, with the categorization

displayed in the FEC column, as shown next.

[MlEngine Fire Detection MSG-3 [_ O[]
Project Edit Wiew System Hierarchy Funchion Failure  Effect Cause |
-3 X |15t [ 1S B | Zoom= | T (M [ G- DN | | |@ |

Systern Hierarchy FMEA Hierarchy - Engine Fire Detection
O Name R = Description (E st FEC | T | =
} | = 08 Engine Fire Detection =l To provide Fire Zone 1 & 2 fire
L2l Zone 1 Sensor ~ detectionfoverheat signal to the aitframe.
2 75 : Fails ko provide Fire Zone 1 & 2 fire
One £ Jensar EH#| detection/overheat signal to the
airframe,
Loss of Fire detection/overheat
» i--[m| signal from loop & or B, Alternative 7
loop i still available,
.| @| Provides erroneous fire warning.
[B] To pravide fire loop Failure signal.
- -
4| | 3 4| | v
|H Effect HLoss of fire detectionfoverheat signal from loop & or B. Alternative loop is still available. 4

4.2.8 Define the Potential Causes of Failure

Three potential causes of failure (also called failure modes) have been identified for the first failure in this

example:

Loss of sensor pressure.

Failure of responder.

Engine fire detection wiring harness failure.

e To define a cause, select the effect and select Add Cause from the Effect menu or press F9. You can also
right-click the effect and select Add Cause from the shortcut menu. The Add Cause window will appear.
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e Type Loss of sensor pressure into the Failure Mode (Cause) input box, as shown next.

[Mladd cause | x|

Current Teem | 1 - Engine Fire Detection

| Function | 1 - To provide Fire Zone 1 & 2 fire detectionjoverheat signal to the airframe.

| Failure | 1 - Fails to pravide Fire Zone 1 & 2 fire detectionjoverheat signal to the airframe.

| Effect | 1 - Loss of fire detectionf/overheat signal from loop A or B. Alternative loop is still available.,
Cause |Usar Diefined I Probability I Corrective Maintenance

k3 Failure Mode {Cause)

1 Lass of sensot pressure, ﬂ'—ﬁj

~ |

Detection Method Compensating Provisions
—Initial Ratings
Sew OICCUrrence: Detection RPN

I_ l— IcNUne> jlz_‘ l_ |<Nuna> jlﬁj I

—Revised Ratings
Sey CCcurrence Detection RFM

N [l =l |
%, Reduckion in RPN

—Classification Contrals and Actions
Qby Qby
I |<N0ne> j ’7|,§,| Controls... ” ‘ =] Actians... ”
+
:E_H B =] [aefo]2]e] __* | o= |
-4

| Adding new Cause

e Click the right-plus navigation arrow in the bottom left corner of the window to save the first cause and
add the next one. Repeat for the third cause and then click OK to close the window.

e The causes will appear in the panel on the right side of the Project window, as shown next.

[MIEngine Fire Detection M5G-3 M= E3
Project Edit Wiew System Hierarchy Furchion  Falure  Effect Cause
2 GG ERC =R = @]
System Hierarchy FMEA Hierarchy - Engine Fire Detection
[m] Hame gl-y|c Description g lalclrEc|r]~
| I 08 Engine Fire Detection 5[] 1©Provide Fire Zone 162 fire

Zome 1 Sensor : detict.iloll,l’overhzatFs.ignzl ko tl;e;;r;rame.
: ails to provide Fire Zone ite:
Zane 2 Sensar B0 detectio%,l’overheat signal bo the aitframe.
i Loss of fire detection/overheat signal
-/ From loop A or B, Alternative loop is stil 7
v ailable,
-[Z] Loss of sensor pressure.
~Z] Failure of responder,
» /= Engine fire detection wiring harness
=l Faiure,
. @ Provides erroneous fire warning,
[#] Ta provide fire loop Falure signal,

- -
4| | » 1 »

=) Cause ”Engine Fire detection wiring harness Failure.

4.2.9 Select and Define a Maintenance Task
One maintenance task has been selected to address the first cause of failure.
Detailed inspection of engine fire detection loops.

e Double-click inside the T column to the right of the “Loss of sensor pressure” cause to open the
Maintenance Task Manager.
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4.2 Example 1 - Simple MSG-3 Analysis for Aircraft Subsystem

The FEC for the effect of this failure is displayed in the middle of the window, along with the Task Selection
Questions from the MSG-3 analysis guidelines that are applicable for Evident Economic effects.

e Click the Yes/No column to the right of the second question to change the answer to Yes, indicating that
a scheduled inspection task is applicable and effective to address this issue. If desired, you can type some
additional comments in the text box to the right.

_imix

Current Tkem | 1 - Engine Fire Detection

Function | 1 - Provides Fire Zone 1 2 fire detection/averheat signal ko the aifframe.

Effect | 1 - Loss of fire detectionfoverheat signal from loop A or B, Alternative loop is still available.

| Failure | 1 - Fails to provide Fire Zone 1 2 fire detectionjoverheat signal ko the airframe,

Cause | 1 - Loss of sensor pressure.,

FE: 7 - Evident Economic v Display Task Selection Logic
Question ® wesiNo % Explanation I -
74: Is a lubrication or servicing task applicable and effective? Mo

» 7B: Is an inspection or functional check to detect degradation of
function applicable and effectiver

Yes Comments regarding applicability of inspection task,

7C: Is a restoration task ko reduce Failure rate applicable and

£
effectiver Mo ﬁ
&

70 Is a discard kask ko avoid Failures o to reduce the Failure rate
applicable and effectiver

-
4 2
Run to Failure:  Cost per Uptime ‘ Undetermined Average Availability (%)

Tatal Cost | Cost per
per Incident Uptime

Tokal Duration
per Incident

-
A 13

Skakus Type

Assigned
Interval

Labor {Crew
[ame)

EX S | Task Name

Stakus | Type

Average Availability | -
o

o

[ = = E Add Task... || 8 Addlnked Task.. [[g5r  EdiTssk. [[g  DeletaTask |
| Maintenance Packaging. .. | Refresh | QK | Cancel |

e Click Add Task to define the task. Enter the following information:
o #: Accept the default, 1.
o Task Name: Detailed inspection of engine fire detection loops.
o Type: Inspection (IN)
o Status: Assigned
o Assigned Interval: 2000 Hour
o Remarks: Inspect for condition and security.
o Zone: 400
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4 Step-by-Step Examples

The window will look like the figure shown next.

[M Add Task x|
# Task Mamne
I 1 ! Detailed inspection of engine fire detection loops. j‘LﬁJ
L
Task | Inspection Resources I PM Resources I User Defined
Type Task Description
Ilnspection (IN) ﬂ ;Il_ﬁj
Status
Assigned hd i
I Ssignes J + _II
Maintenance Package Reference Document
=
I j II _'lll_ﬁj
Proposed Interval  Units assigned Interval  Units
I ﬂ | 2000 Haur j Calculate Cptimum., .,
Basedon: %  Item Age i System Age
Condition
=
| =l
L hd |
Remarks
I Inspect for condition and security, ﬁLﬁJ
L hd |
Zone |4DD Lﬁj Access Lﬁj
Cost per Uptime Total Operating Cost Average Availability (%)
+
i [ msseiten, || soncase |5 [4] [ %]0] o | oo |
5 Ii‘ ssociated F = oW Calse A Ay @ =l 4] Ok Cancel
= | Adding new Task

e Click OK to save the changes and close the window.
e Click OK to exit the Maintenance Task Manger.

The remaining analysis for this subsystem will not be entered during this example. The full analysis is
available for review (if desired) in the “8 — Aircraft RCM (MSG-3)” project in the Demonstration.rx4
database that is installed in the Examples folder of the RCM++ application directory (e.g. C:\Program
Files\ReliaSoft\ RCM4\Examples).

4.2.10 Generate a Report of the Analysis

The next step is to generate a print-ready report for the analysis.

e Select Generate Reports from the Project menu. The Report Generation window will appear, which

allows you to specify the items and forms you want to include in the report and whether you want to
create the report in Microsoft Word or Microsoft Excel.

e Select the Engine Fire Detection item in the area at the top of the window.

e Onthe FMEA Reports page, click Deselect all FMEA reports to clear all selections and then select only
the Report Summary form.

e Go to the RCM Reports page and click Deselect all RCM reports. Select the following report forms on
this page:

o Equipment Selection

o Functional Failure Analysis
o Failure Effect Categorization
o Maintenance Task Selection

o Maintenance Task Summary
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4.3 Example 2 - Add Authorized Users to Secure Database

In the Select Output Type area at the bottom of the window, select Word Document.
The window will now look like the one shown next.

E‘Repnrt Generation

Select Items to include in the report:
Name [~
| =] |7 Engine Fire Detection .
i Zome 1 Sensor, [_'_ Y5
I_ Zone 2 Sensar,
i Select all
=|(:= Deselect All
FMES Reports  RCM Reports
[~ Equipment Selection Lagic ¥ Maintenance Task Summary I~ with Costs
¥ Equipment Selection SaitlEy ITask# j
Sort By IHiararchicaI j [ Maintenance Task Summary (Detailed)
Sork By [Task # -
[ Equipment Reliability and Maintainahility I a3 J
Sork By IHierarchicaI j [~ Maintenance Package Summary
Sort B
[~ Equipment Reliabilty and Maintainability (Detailed) or. By ITGSK# j
Sort By IHierarchicaI j [~ Maintenance Package Details
[~ Integrated Documents) SEiElEy ITESK# j

v Functional Failure Analysis
[~ WithFEC [ With End Effect anly [T With Tasks

[ Maintenance Task Details Range

% Compact " Extended
[ Failure Effect Categorization

¥ Maintenance Task Selection

| = Select all RCM reports ” = Deselect all RCM reports |

ES) | Generate Repart, ..
Close |
4

Select Oukput Type
’7(: word Document € Excel Spreadsheet

Click Generate Report. The Save File As window will appear, which allows you to specify the name
and location for the report. Specify to save the report as Aircraft MSG-3 Report.

Click Save. The report will be created and will automatically open in Microsoft Word.

After you have finished reviewing the report, close Microsoft Word and then close the Report Generation
window.

Leave the database open and proceed to the next example.

4.3 Example 2 - Add Authorized Users to Secure Database

This example will guide you through the process to add authorized users to the AircraftExample.rx4
database that you created in the previous example. When you are working with databases that have Login
Security enabled, keep in mind that the following special functions and considerations apply:

Access to the database is restricted to individuals who have an authorized user account for the database.

The database can be accessed simultaneously by more than one authorized user. These users will have
read-only permission to access to any portion of the database that is currently being edited by another
user and will have read-write permission to access to the rest of the database.

Each record properties window will display the date/time and the name of the user who last edited the
record.

The application will maintain a list of every login to the database, which includes the name of the user
and the date/time of the login.

Users will have the ability to “lock” entire projects in the database or specific sections of the analysis.
This prevents other users from editing the material while the lock is in place.
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4 Step-by-Step Examples

The next sections will guide you through the steps to add an authorized user to a database and import an
existing user account from another database.

4.3.1 Add a User to the Database

e With the AircraftExample.rx4 database open, select Administrative Options from the Tools menu. In
the Administrative Options window that appears, enter the administrative username and password that
you established when you first created the database and click Login. If you followed the instructions in
Section 4.2.2, this will be “username” and “password.”

e After you have entered a valid administrative password, the Administrative Options window will change
to display two buttons, as shown next.

[MlAdministrative Dptions x|
u—aﬂr-_w»{-

,2 Change Creator/adminstrator Information. ..

(=
% Manage Database Users. ..

Close |

e Click Manage Database Users to open the Manage Users window. This window displays a list of all
user accounts (except the administrative account) that have been defined for the current database.

—CreatorAdministrator Options

RCM++

'&_‘L‘Manage Users M= E3

- First Name Last Name Lisername E-mail Fhone Tikl: Compan:

: jrm— | | add... ‘ | Edit. .. | | Delete ‘

> _
|j) I\ A ‘E"E Export Users... Close | .
| S %

These users are authorized to view and edit the material contained in the database but they do not have the
ability to add, edit or delete the authorized user accounts that have been established for the database.

e To add a new user, click Add.
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4.3 Example 2 - Add Authorized Users to Secure Database

e In the User Login and Contact Information window, enter the required fields to create a new user
account. Enter the following information:

e First Name: Jane
e Last Name: User
e Username: janeuser

o Password: password 2
e Confirm: password
e E-Mail: RCM@ReliaSoft.com
Your screen will look like the figure shown next.

@User Login and Contact Information |

|
b %'
% 101010001 01012000010100101001011100]

First Mame IJane

] )

Last Marme IUser

Uszemame Iianeuser

xxxxxxxx

Password I

E-mail IRCM@ReIiaSoft.com

Title |

Compary I

| Corfirm I xxxxxxxx

] ] ] [

Phaone I

RCM++

[o]4 | Cancel

e Click OK to create the account.

You can see that the new user account has been added to the list of authorized users. Note: In addition to the
ability to add new users, you can use the Edit and Delete buttons in the Manage Users window to manage
existing user accounts.

4.3.2 Import a User Account from Another Database

You can also import user accounts from another database with Login Security enabled.

e To try this, click the Import button in the Manage Users window. You will be prompted to select the
database that you want to import user accounts from.

2 Note that RCM++ prevents multiple users from having the same username but it does not require the passwords to be
unique.
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4 Step-by-Step Examples

e Select AuthorizedUsers.rx4 from the Training folder in your application directory (e.g. C:\Program
Files\ReliaSoft\ RCM4\Training) and click Open. A list of the user accounts that have been defined in

the selected database will now be displayed in the Import Users window, as shown next.

zl

Select Users

vl Bill User
[w] Joe User
[v] Kate User

Import | Cancel |

e By default, all users will be selected for import. Accept this selection and click Import to add the user
accounts to the current database. These users are now authorized to view and edit the material in the
current database.

e When you are finished investigating RCM++'s capabilities to manage authorized database users, close
the Manage Users window and then close the Administrative Options window. If desired, you can close
the database before proceeding to the next example by selecting Close Database from the File menu or
by clicking the Close Database icon.

LF? Close Database

If you do not close the database, it will be closed automatically when you create a new database for the next
example.

4.4 Example 3 - Maintenance Task Intervals, Costs and Packaging

This example will guide you through the steps required to calculate the optimum interval for a repair/
replacement maintenance task, to estimate operational costs that can be used to compare maintenance
strategies and to create maintenance packages.

For this example, you will work with sample data provided for demonstration purposes. This information is
not intended to be realistic.

4.4.1 Create a New Database without Login Security Enabled

The first step is to configure the software so that the new databases that you create will not require a
username and password to access the database.

e To do this, select User Setup from the File menu and click the Settings (1) tab.

e De-select the Enable Login Security features for new databases option and click OK to close the User
Setup.

o Next, select New Database from the File menu or click the New Database icon.

ﬁq Mew Database, ..

3. Note that if a user account in the source database already exists in the destination database, it will not be listed in the
Import Users window.
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4.4 Example 3 - Maintenance Task Intervals, Costs and Packaging

e Type TaskExample.rx4 for the filename and click Save to create the database.

4.4.2 Create a New Project

Because you created a database without Login Security enabled, the Database Creation Wizard was not
displayed. Instead, RCM++ takes you immediately to the New Project window, which allows you to create a
project for your new database.

e Type Maintenance Tasks for the Name, make sure that the Standard RCM profile has been selected to
set the project properties and click OK to create the project.

4.4.3 Create an Item and Define the Reliability/Maintainability

e Select Add System from the System Hierarchy menu to create an item.

e Accept the default #, 1, type Equipment A for the Item Name and, if desired, define some additional
properties, such as Part Number, Supplier, Environmental Conditions, etc.

e Click Reliability to open the Item Reliability and Maintainability window. Go to the Maintainability
tab to define the operating time and units. This is the total amount of time that the equipment is expected
to operate for the scope of your analysis and this information will be used the for the cost calculations
that will be performed later. Enter the following:

o Operating Time =10

o Units = Year?

4 Note that the Units menu for this and other cost calculation inputs within the software allows you to enter time-based
values in different units, which will be converted to the common “Base Unit” for calculation purposes. The available
units and the necessary conversion factors are set via the Menus page in the Project Properties window.
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4 Step-by-Step Examples

In addition, specify an Item Downtime Rate of $100 per Hour to indicate that for each hour that the
equipment is down due to failure or maintenance, it will cost the organization $100 in terms of lost

production, scrap, etc. The window will look like the figure shown next.

@Item Rehability and Maintainability

| Parent System | A
| Mext Higher Assembly | M

| Current Ikem | 1 - Equipment &

Reliability Maintainabilityl

Cperating Time Units

I B
Itermn Downtirme Rate

[ 100,00 per [Hour =

+
+
= oK I Cancel
4

| Last Update Date: 6§19/2007

Click OK to close Item Reliability and Maintainability, then OK to close Edit Item.

4.4.4 Create a Function, Failure and Effect

With the Equipment A item selected, select Function then Add Function from the System Hierarchy
menu or shortcut menu to open the Add Function window. Type the following function description:

e To perform a function within specified limits.

Click the down-plus navigation arrow in the bottom left corner of the window to save the function and
open the Add Failure window. Type the following failure description:

o Fails to perform the function within specified limits.

Click the down-plus arrow to save the failure and open the Add Effect window. Type the following effect
description:

o Effect of the failure.

Click the Categorization button to open the Failure Effect Categorization window. Answer Yes to
Question 1, No to Question 2 and Yes to Question 4 or select EO - Evident Operational from the
Category menu.

5 Note that the default currency symbol for RCM++ is U.S. dollars ($) but this can be changed from the Other page of
the User Setup.
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4.4 Example 3 - Maintenance Task Intervals, Costs and Packaging

e Click OK to save the categorization and then click OK again to save the effect. The Project window will
look like the figure shown next.

Il
Project Edit VWiew System Hierarchy Function Failure Effect Cause
G X I B B one | FR R (B3 Y Y ©
System Hierarchy FMEA Higrarchy - Equipment A
=1 Name [@ |Y‘F MI- =] Description O IrlalclreEc]r]~
Pl [ Equipment A ‘ | = [#] To perform a function within specified limits.,

H Fails ko perform the Function within
El @ spedified limits.
» - m| Effect of the Failure, EC

- -
A L2 4 L2

|| Function ”To petform a function within specified limits, v

4.4.5 Define the Cause, Probability and Corrective Maintenance Properties

e With the effect selected, select Add Cause from the Effect menu or shortcut menu to open the Add
Cause window. Type the following cause description:

e Actionable cause of failure.

e Click the Probability tab so that you can define the probability density function (pdf) for this particular
failure cause. Select Define the probability of occurrence for this Cause to enable the rest of the cause
probability settings and specify the following:

o Data Source: Field data for a similar component.
o Distribution Units: Hour
o Distribution: Weibull

e Beta: 1.5
o Eta: 2500
¢ Gamma:0
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4 Step-by-Step Examples

The window will look like the figure shown next.

Mladd cause x|

| Current Teem | 1 - Equiprnent &

| Function | 1 - To perform a function within specified limits.

| Failure | 1 - Fails to perform the function within specified limits.

[ Effect | 1 - Effect of the Failure,

Cause I User Defined ~ Probability |Correct\va Maintenance

W Define the probability of occurrence For this Cause,
Data Source  |Field data For a similar component,
—Distribution and Parameters —Calculate Probability ——
Distribution Units IHour j Time
- Beta I
weibull |15—
Expanential
—_— Eka
Morrnal IZSDD— Probabilicy
Lognormal Cemimig
Mixed Weibull - 2 ID
Mied Weibull - 3
Mixed Weibull - 4
+ [
+ s
: L B =] [aefo]2]e] __* | o= |
o
=

| Adding new Cause

If desired, you can enter a time value and click the Calculate icon to estimate the probability of failure due
to this failure cause at the specified time.

Click the Corrective Maintenance tab so that you can specify the time and resources required to restore
the equipment if this failure cause occurs. You can see that the operating time and downtime rate that you
specified for the equipment is displayed for your reference at the top of the page. In addition, specify the
following:

o Restoration Factor: Enter 1 to indicate that the equipment will be fully restored (i.e. “as good as
new”) after the corrective maintenance.

o Labor Rate: Enter $150 per Hour. Note that the units that you specify for labor will also be applied
to the task duration times that you enter next.

o Task Duration: Enter 24 hours for the Delay - Wait for Labor and 6 hours for the Task Duration.
Therefore, the Total Duration per Incident will also be 30 hours.

o Cost per Incident: Enter $200 for Materials Cost. You can see that the Downtime Cost and Time
Based Labor Cost are entered automatically based on the downtime and labor rates that have already
been entered and the task duration. Therefore, the Total Cost per Incident will be $4,100.
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4.4 Example 3 - Maintenance Task Intervals, Costs and Packaging

The window will look like the figure shown next.

MIEdit Cause E
Current Ikem | 1 - Equiprnent &
| Function | 1 - To perform a function within specified limits.
| Failure | 1 - Fails to perform the function within the spedified limits,
[ Effect | 1 - Effect of the Failure.,
Cause I User Defined | Probability — Corrective Maintenance
[™ This Failure is undetectable and will not be corrected until the next scheduled maintenance or inspection
‘ Ikem Operating Time | 10 Year Ikemn Crovenkime Rate 100,00 { Hour ‘ Edit...
Restoration Factor I 1 st ey Tealents
Misc, Cost I
Materials {5y ! Part Mumb ’7
I aterials {Spare MamePart Mumber) _ ﬁ A —— 2,000,00
=
L i 1 Labor Cost Per Incident I
Labor {Crew Name) Time Based Labor Cost 900,00
= |
| =53]
[ 22 ] Total Labor Cost: 900,00
Labar Rate I 150.00 per IHnur j Materials Cast I 200,00
Task Duraian Total Cost Incident 4,100.00
Delay - Wait For Labor I 24 (LIRS (A7 HEAT A f
Delay - Wait for Materials I
Cost per Uptime
Task Duration I [
Total Dperating Cost
Total Duration per Incident 30 Hour Average Availability (%)
+ 0
HEH E o] [ealioEe] o | e |
o
= | Last Update Date: £f20/2007

e Click the Calculate icon to start the simulation that will be used to estimate the operational cost and
availability that can be expected if no preventive maintenance is performed for this failure cause (i.e. a
run-to-failure maintenance strategy). When the process completes, a window will display the number of
corrective maintenance actions and the amount of uptime projected by the simulation. These are inputs
to the Cost per Uptime, Total Operating Cost and Average Availability calculations. Click OK to return
to the Add Cause window, which displays the calculated results:

o Cost per Uptime = 1.813 / Hour
o Total Operating Cost = $156,747.10
o Average Availability = 98.691%

The specific calculation methods for these estimates are presented in detail in the RCM++ User’s Guide.

4.4.6 Define a Repair/Replacement Maintenance Task

e Click the Tasks button to open the Maintenance Task Manager for this cause.

You can see that the FEC for the associated effect and the applicable maintenance task selection questions
(based on the RCM logic that has been pre-defined for the project) are displayed in the middle of the
window. The Cost per Uptime calculated for a run-to-failure maintenance strategy (corrective maintenance
only) is also displayed for your reference. The table at the bottom of the window displays the tasks that have
been assigned or are under consideration to address this particular failure cause.

e Click Add Task to open the Add Task window. Accept the default #, 1, and type the following task

name:

e Scheduled repair/replacement.
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4 Step-by-Step Examples

e Select Repair/Replacement (RR) for Type and Proposed for Status. The task type determines the
options that will be available in the Task Properties window and the calculation method that will be used

for the Cost per Uptime, Total Operating Cost and Average Availability calculations.®

e Click the PM Resources tab so that you can specify the time and resources required for each scheduled
repair/replacement maintenance action. Specify the following:

o Restoration Factor: .9

o Labor Rate: $75 per Hour

o Task Duration: 2 Hour
o Materials Cost: $100

The window will look like the figure shown next.

[Mladd Task |
# Task Mame
I 1 I scheduled repairjreplacement, jl_ﬁj
[ ]
Task  PMResources | User Defined |
Itern Cperating Time | 10 Year Item Doventime Rate | 100,00 § Hour ‘
Materials {Spare Name/Part Mumber)
Ir=| i
I _'ll_ﬁj Restoration Factar Al
[ hd |
Labar {Crew Mame) —(Cost per Incident
= isc.,
II —'lll_ﬁj Misc, Cast I
+
Downtime Cost 200,00
Labor Rat 75.00 per |Hour -
shorRate I I J Labaor Cost Per Incident I
st B Time Based Lahor Cast 150.00
Delay - Wait For Labar I
Delay - Wait For Materials I Tatal Labar Cost 150,00
Task Duration | 2 Materials Cost | 100.00
Total Duration per Incident 2 Hour Total Cost per Incident 450,00
Cost per Uptime Total Operating Cost Average Availability (%)
| | |
Ii‘ Associated FMEA. .. ” 2] Show Cause... ”@” e ” @ ”g”‘;‘:“r” «_)}| of | Cancel |
| Adding new Task

RCM++

6. The available Task Types are based on the settings that have been defined on the Tasks page of the Project Properties

window.
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4.4 Example 3 - Maintenance Task Intervals, Costs and Packaging

4.4.6.1 Calculate the Optimum Interval

RCM++ provides a utility that can be used to calculate the optimum interval for a repair/replacement task
based on the cost of corrective maintenance, the cost of preventive maintenance and the probability of

failure. To use this utility:

e Return to the Task page and click the Calculate Optimum button. The optimum interval will be entered

automatically in the Assigned Interval field, as shown next.

[M Add Task x|
# Task Mame
I 1 I scheduled repairjreplacement, jl_ﬁj
[ hd ]
Task |PM Resources | User Defined |
Type Task Description
IRepalr,l’RepIace (RR) j ;Il_ﬁj
Status
IPerosed j j
id |
Maintenance Package Reference Document
=
| =l =i
[ hd |
Proposed Interval  Units assigned Interval  Units
I j I 1016.664 Hour j Calculate Optimunn. ..
Basedon: {* Item Age {~ System Age
Condition
=
I _'ll_ﬁj
[ hd |
Remarks
=
| ==l
[ hd |
Zone I @J Access @J
Cost per Uptime Total Operating Cost Average Availability (%)
| | |
+
! [ wmiren, |5 sorcose. [ 53] 0] @ | om |
5 li‘ ssociated FT =) oW Calse IFE} ] @ =l (7] Of Cancel
= | Adding new Task

e Change the Assigned Interval to 2 Month, which is close to the optimum and more practical for

incorporating the task into the overall maintenance plan.

4.4.6.2 Calculate the Operational Costs

e Once you have made all of the required inputs for the maintenance task cost calculations, click the
Calculate icon to start the simulation. When the process completes, a window will display the number of
corrective maintenance actions, the number of preventive maintenance actions and the amount of uptime
projected by the simulation. Click OK to return to the Add Task window, which displays the calculated

results:

o Cost per Uptime = 1.501 / Hour

o Total Operating Cost = $130,193.95
o Average Availability = 98.997%

e Click OK to save the changes and close the window.

4.4.7 Perform Maintenance Packaging

RCM++’s Maintenance Task Packaging utility allows you to group tasks together into packages based on

interval, resource requirements, etc.

e From within the Maintenance Task Manager, click the Maintenance Packaging button to open the

Maintenance Task Packaging window.
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4 Step-by-Step Examples

e Click Add Package to open the Add Maintenance Package window. Accept the default #, 1, and type the
following maintenance package name:

e Every 2 Months.

e Select the Assigned Interval option for auto-packaging criteria and enter 1 to 3 Month, as shown next.

Endd Maintenance Package x|
# M arme
I 1 IEver_l,l 2 Manths. ﬁlﬁj
L hd |
Description
B
3]
b |
Auto-Package Critenia 5
Urits
¥ Assigned Interval |1 o |3 Morth j
[T Labar (Crew Mame) I j| _f: |
[ hd ]
I~ Type I j

E‘E”E‘ 0K Lancel

+
+
=
v
&

|Add|ng new Maintenance Package

e Click OK to create the package, which will be displayed in the top panel of the Maintenance Task
Packaging window, as shown next.

,E Maintenance Task Packaging = |EI |i|

This window displays all non-linked tasks in the current project. Drag and drop a task to add or remowve it From a maintenance package. Double-click a task or package to
viewedit its properties. Use the menus to filter the display.

| Maintenance Packages and Packaged Tasks

Assigned Labar {Crew | Tatal Duration Total Cost Costper | Average Availability |«
& | Vel M | St | THFE Interval [ame) pEr Inud_glnt pet Inud_g_nt Lptime: S
L4 L....E¥ery 2 Months.

-
4 L8

|[‘Q Expand Tres ||[§. Collapse Tres | [~ Show Packages Only Add Package... ” Edit Package... ” Delete Package: |

| Individual Tasks

Assigned | Labor {Crew | Total Duration | Total Cost Cost per Average Availability |~
A

& Vel M St L Interval [ame) per Incident | per Incident Liptime (&)

» 1 Scheduled repaitfreplacement., Proposed RR 2 Manth 2 Hour 450,00 1,501 [ Hour 98,997

-
4 ¥

Skatus Type Assigned Interval Labor (Crew Name)

Jeu =] Ja = =] fen |
| Auto-Package Tasks || Un-Package Tasks | Clase

|Maintenanca Task Packaging

The individual, unpackaged tasks in the current project are displayed in the bottom panel. You can assign a
task to a maintenance package by dragging and dropping it under the selected package or by opening the
Task Properties window and selecting the appropriate package from the Maintenance Package menu. In
addition, if you have specified auto-package criteria, the software can automatically assign individual tasks
to a package with matching criteria.
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e Click the Auto-Package Tasks button to start the process. When it completes, click the Expand Tree
button to display all of the information in the top panel, as shown next.

'E Maintenance Task Packaging ol x|

This window displays all non-linked tasks in the current project, Drag and drop a task to add or remove it from a maintenance package. Double-click a kask or package to
view/edit its properties. Use the menus ta filter the display.

| Maintenance Packages and Packaged Tasks

Assigned | Labor (Crew | Total Duration | Total Cost | Costper | Average Awvailability |«
& | T itz | Sl Tipe Inkerval Narne) per Incident | per Incid... Uptime (%)
:| Scheduled repairfreplacement., Propased RR 2 Month 2 Hour 450,00 ljnuulr'f 95,997

-
Ll 13

|[‘Q Expand Tree ||[,t Callapse Tree | ™ Show Packages Only | Add Package... ” Edit Package... ” Delete Package |

| Individual Tasks

Tatal Duration
per Incident

Assigned
Inkerval

Labor (Crew
Marne)

Total Cost
per Incident

Cost per

| Ao | Task Mame | Skatus | Type Uil

Average Availability |«
()

-
4 »

Status Type Assigned Inkerval Labar {Crew Marne)

Jea 5 [ EYRES I ] =l e =l

| Auto-Package Tasks || Un-Package Tasks | Clase
|Maintenanca Task Packaging v

As you can see, the individual task created for this example has been automatically assigned to the “Every 2
Months” maintenance package because the task interval, 2 Months, matches the range specified in the auto-
package criteria for the package.

e Click Close to close the Maintenance Task Packaging window, then OK to close the Maintenance Task
Manager then OK to close the Cause Properties window.
4.4.8 Make Login Security Selection for New Databases

After completing the examples up to this point, you will have worked with both secure and non-secure
RCM++ databases. For the rest of the examples in this training guide, unless otherwise specified, you can
decide whether or not you want to enable Login Security for the new databases that you create.

e If you prefer to work with databases that require login with an authorized username and password, then
select the Enable (activate) Login Security features for new databases option on the Settings (1) page
of the User Setup. If not, leave the setting as it currently is.

e You can now close the project and database before proceeding to the next example.

4.5 Example 4 - Excel Import/Export for Items and/or FMEAS

This example guides you through the process to import/export system configuration data and functional
failure analysis (FMEA) data from Excel files that meet RCM++’s required format for import.

4.5.1 Export a System Configuration to Excel

e Open the Export to XML project in the BlockSimExample.rx4 database that is found in the Training
folder in your application directory (e.g. C:\Program Files\ReliaSoft\RCM4\Training).

e Select Export Items then To Excel Spreadsheet from the Project menu.
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e Type System Configuration for the name of the new Excel file and then click Save to start the export
process.

The progress bar at the bottom of the MDI indicates that all of the items in the project’s System Hierarchy
panel are being exported to an Excel spreadsheet. Any information in the Item Properties window and on the
Reliability page of the Item Reliability and Maintainability window will also be exported. When the process
completes, the Excel file will open automatically.

e After you have reviewed the export file, close Excel and return to RCM++,

4.5.2 Create a New Database and Project

e Create a new database called ExcelExample.rx4 and a new project called Import and Export. Use the
Standard RCM profile to set the properties for the new project.

4.5.3 Import the System Configuration from Excel

e In the new project, select Import Items then From Excel Spreadsheet then Import as Systems from
the Project menu.

e Navigate to the System Configuration.xls file that you just created. (Note: It will be in the C:\Program
Files\ReliaSoft\RCM4\Reports folder if you have not changed any of the defaults for the software.)

e Click Open to start the import process.

e When you are asked to select a sheet for import, accept the default choice of Item Import Template and
click OK.

e When the progress bar at the bottom of the MDI completes, a message will indicate that the process was
completed successfully. Click OK. You will see that the system configuration information from the
Excel spreadsheet has been imported into the current project.

4.5.4 Import Item’s Functional Failure Analysis (FMEA) from an Excel File

When importing functional failure analysis (FMEA) data from Excel, you can choose from two import
templates that are installed in the Examples folder of the application directory (e.g. C:\Program
Files\ReliaSoft\ RCM4\Examples). The basic template (called “ImportSpreadsheet.xls”) allows you to
import functions, failures, effects, causes, controls and actions along with a few additional properties of
those records. The comprehensive template (called “ImportSpreadsheetComprehensive.xls) allows you to
import all of the properties for these records. For this example, we will be using a sample data file that
follows the basic template.
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First, make sure that the software is configured to use the basic import template. To do this, select User

Setup from the File menu and go to the Settings (2) page of the User Setup, as shown next.

E‘ User Setup

RCM++

User I Sethings(1)  Settings(Z) |Hierarchies I Diescriptions | E-mnail I Prictity | Warningsl Reports | Other I

[ Show 'toaltips' For workshest columns

¥ Upon delete, renumber subsequent records in FMEA Hierarchy
™ Do not shove What do you want bo do? window upon startup
[ spell check records automatically upon save

[ Window remains open after adding records

[ Make disabled fields invisible

[ Aukomatically compact and repair dakabase upon closing

[ automatically backup database upan closing

v Include FMEA record numbers in filkered views, reports, ete.
[ Use colored text in FMEA hierarchy

[ Incorporate Cause description with controls transferred to DYRPER
|7 Autonumber new Ikems

v Aukonumber new Actions

¥ aAutonumber new Contrals

¥ Autorumber new Tasks

¥ aAutonumber new Maintenance Packages

™ Display the selection criteria in the Syskem Hisrarchy RCM column

FMEA Import Template Standard j | Wiew Selected Template. ..

| ‘E Run User Setup Wizard. .. |

oK I Cancel |

Make sure Standard is selected in the FMEA Import Template field at the bottom of the window and

click OK.

Right-click the item called “Component A.1.1.1” in the project’s System Hierarchy and select Import/
Export Item’s FMEA and then Import from Excel from the shortcut menu.

Navigate to the “Import from Excel Data.xIs” file located in the Training folder in your application
directory (e.g. C:\Program Files\ReliaSoft\RCM4\Training) and click Open. During the import, a
progress bar will be displayed at the bottom of the MDI.

When you are asked to select a sheet for import, accept the default choice of FMEA - System and
Append and click OK.

When the process is 100% complete, a message will be displayed to indicate that the information has
been imported. Click OK to continue.
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e You can see that the functions, failures, effects, causes, controls and actions defined in the Excel
spreadsheet have been automatically added to the analysis in RCM++, as shown next.

’E].‘Impnrt and Export ] 1
Project Edit VWiew System Hierarchy Function Failure Effect Cause
ES X | I ] 6 B zeen- | H {] (W] 2 a0 N | @ | @
System Hierarchy FMEA Hierarchy - Companent &.1,1.1
[m] Name glr|e(m|«} 1O Description O ¥ lalc|rEc|T]|=
£l @8 System A ¥ | =1 |p| Bake out produck,
=8 Subsystem A.1 [=I-[#] Insufficient moisture elimination.
EE Subsubsystem A.1.1 E| I Cracking of modules at card
v — [ |
» b3 Component A.1.1.1 E assembly.
T3 RE) — il = Insufficient bake 12
-] Component &.1.1. =l temperature.
E-§ SubsubsystemAdz | | LT R =] Insufficient bake time. 11
-] Companent A.1.2.1 5 [#] Bag product,
%] Comporent 4.1.2.2 [ [#] Accumulation of maisture.
/& Component 4.1,2.3 { = Cracking of modules at card
= &l fa = @ assembly.
E""z Subsystem 4.2 "3 Poorh I T
Eb-3  Subsubsystern A.2.1 . \:3 0ar hag seal
= +-{Z] Mo desicant in bag. 11
% Component A.2.,1.1 - -
s fA211 I'_—'l@ Moisture level koo high For category.
] Companent A.2.1. =M <undefined:
B Subsubsystem A.2.2 -{Z] Wrong label on bag. 2|1

|z Comporent &.2.2.1

b B Component A.2.2.2 - -
A4 » A »

| ¥ Function ”Bake out product. v

4.5.5 Export Item’s Functional Failure Analysis (FMEA) to an Excel File

You can also export the functional failure analysis from any RCM++ project to Microsoft Excel.

e To export the analysis in the current project, right-click Component A.1.1.1 and select Import/Export
Item’s FMEA and then Export to Excel from the shortcut menu.

e Type Excel Export for the filename and click Save to start the process. The progress bar will once again
be displayed at the bottom of the MDI. When the export is complete, the new spreadsheet will be opened
automatically in Microsoft Excel.

This exported file fits the basic template format required for automatic import into RCM++. You can see that
each unique entry is displayed in a separate column and specific types of data must always exist in a specific
column. For example, the function description must be in the first column, the initial Occurrence rating must
be in the twelfth column, etc.

e When you have finished investigating RCM++'s import/export functionality with Microsoft Excel, close
the Excel spreadsheet, the project and the database before proceeding to the next example.

4.6 Example 5 - Using the Plot Viewer Utility

This example allows you to experiment with RCM++'s Plot Viewer Utility, which provides a variety of
charts for graphical presentation of your analysis. This example will also provide some practice with
RCM++'s import/export functionality.

For this example, you will work with a sample database that has been prepared by ReliaSoft, which contains
sample data related to imaginary products. Sample data sets are not intended to be realistic.

4.6.1 Create a New Database and Project

e Create a new database called PlotsExample.rx4.

e Create a new project called Data for Charts. Select the Comprehensive profile to set the project
properties.
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4.6.2 Import Items to Obtain Data

In order to save time, you will obtain the data for this example from projects that have already been created
in another database.

e To do this, select Import Items and then From Database from the Project menu. Select the database
called “ChartsData.rx4” in the Training folder in your application directory (e.g. C:\Program
Files\ReliaSoft\RCM4\Training) and click Open.

The Import Items window will be displayed, with the projects contained in the ChartsData.rx4 database
displayed in the panel on the left and the items associated with the selected project in the panel on the right,
as shown next.

@Import Items !E
: Fle Wew
§ i dose | By mport | [5] Jid | o | LB 2 =] @
Import from database |a C:\Program Filesi\ReliaSoftiRCME| TraininglChartsData. rxd Browse. .,
¥ Remember last database opened
Select Praject Select [tems
[m] A Name Eased on Profile Description [m] Mame -
This project contains = l_ Systemn &
fictional data that can 51 sbsystem a1
» Data for Charts Standard FMEA  |be used to . ki .
demonstrate the Plat EI_ Subsubsystem A.1.1
Vigwer Functionalicy. o[ Component A.1.1.1
This project contains l_
Mare Data for more fictional data that E] = System B
Charks Standard RCM can be used to I_ Subsystem 6.1
demonstrate the Plot l— System C
Viewer Functionality
= l_ Syskern D
B |_ Subsystem 0.1
EI_ Subsubsystem D,1.1
Ell_ Subsubsubsystem 0.1.1.1
B Subsubsubsubsystem D.1.1,1.1
L Component D.1.1.1.1.1 =
i I ]
{* Import as Systems = Import Below Currently Selected Item
| C:\Program FilesiReliaSaft\RCM4\ TrainingyChartsDiata.rxd: Import ikems Fram this database as Systems 4

The source database contains two projects and each project contains one or more items with functions,
failures, effects, causes, controls, actions and tasks defined.

e To import the data from a project in the ChartsData.rx4 database to the new project that you have
created, simply select one of the projects in the panel on the left and then choose Select All from the File
menu. Select Import from the File menu or click the Import Selected Items icon.

] Import |

A blue progress bar will appear at the bottom of the Import Items window to show you the progress of the
import action. When the import is 100% complete and the blue bar disappears, a message will appear to
notify you that the selected items have been successfully imported.

e Click OK to continue.

e The Import Items window will remain open to allow you to import additional items. Select the other
project in the ChartsData.rx4 database and repeat the process to import all of the items associated with
the second project.

e When the import is complete, select Close from the File menu or click the Close icon in the top right
corner of the window to exit the Import Items window and return to the Project window.

You can now see that all of the items from the ChartsData.rx4 database have been added to the System
Hierarchy for the current project. In addition, all functions, failures, effect, causes, controls, actions, tasks
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and related information associated with those items were also imported. With System 12345 selected, the
Project window will now look like the figure shown next.

0]
Project Edit VWiew System Herarchy Funckion Failure  Effect Cause
ES XIS IS - [ HA (W E A N EH el @
System Hierarchy FMEA Higrarchy - System 12345
[m] Name gleim|=] 1O Description O |¥ | reui |RPur | & | C|FEC|T |~
El @ System A ¥ | B[] Function i
B2 Subsystem A1 El-[#] Abrasion
EE Subsubsystem &.1.1 E-[M Control impaired EE
@ Component &.1.1.1 i-[Z] Buildup 2 2 2|z 1
» [ System 17345 Chemical oxidation 20 1z 11 2
= [ SystemE Endangers operator HO
‘_I_-j Subsystem B.1 [Z] Friction, abnormal 216 | 108 |1 |2 1
0 System C Improper alignment 545 135 111 1
= B SystemD =l [#] Function 2
é_....g Subsystem D, 1 El-[#] Cavitation
Eb-2 Subsubsystem D.1.1 E‘@ Rough ES
B 8 SubsubsubsystemD.1.1.1 i[Z] Incorrect algorithm 96 3w (21 1
EE Subsubsubsubsystem D.1.1.1,1 ] Lean Fuel air mixtures 16 & z 1
b \;'j Camponent D.1,1.1,1.1 lE El-[#] Corrosion
— E1--[8] Intermittent operation EQ
-[Z] Improper diffusion 192 | 108 |1 |1 1
=] Improper start up a0 7z |1 |1 1
-|=] Backlash, insufficient 252 | 150 |1 1
Control impaired Hs
[Z] Excessive heat 96 40 |1 |1 1
Eleckromigration 192 120 111 1
El-[#] Discoloration
bW Customer dissatisfaction HE
- =] Ower etch 36 1z z 1 |+
4 Ll_l q »
[l System ||System12345 4

You can now use this fictional data to experiment with RCM++'s Plot Viewer.

4.6.3 Generate Pie Charts

To begin, select Plot Viewer from the Project menu or press Ctrl+Shift+P. The Select Items window
displays all of the items that have been created in the System Hierarchy for this project and allows you to
select one or more items to be included in the plots/charts that you create.

Since the item called “System 12345” was selected in the Project window, it will also be selected in the
Select Items window. With this item selected, click OK to open the Plot Viewer.

The Plot Viewer provides 22 different plot types to choose from and all of these plot types provide additional
options to allow you to select the information to be displayed in the plot. When you first open the Plot
Viewer, it will automatically create a chart based on the current data and the plot type and options for the last
plot that you created.

Select Effect FEC Pie from the Plot Type menu. The appearance of the Control Panel will change to
display the options available for pie charts. Make the following selections:

o Auto Refresh = Selected
o Show Legend = Not Selected
o Show Details in Pies = Selected

o Show User Information = Not Selected
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The Plot Viewer window will now look like the figure shown next.

~lolx|
Effects by Failure Effect Categorization

Flok Type
|EFFect FEC Pie =l

Recard Type
ES - Evident Safety: Qty = 1 (16.66735) [EFFect =

Recard Quantity &

ES - Evident Operationali Gty = 1 (16.66796)

E - Hidden Econornic: Gy = 1 (16.66795)

v auto Refresh
[~ show Legend
[¥ 5how Details in Fies

EE - Evident Econornic: Qty = 1 (16.66795)

I" Show User Information

HO - Hidden Operationalt Gty = 1 (16.66795)

HS - Hidden Safety: Gty = 1(16.66795)

Total Quantity of Effects = 6

Database: C:\Program Files\ReliaSoftiRCMAFilesiPlotsExample. rxd ﬂ Close |

Project: Data For Charts

4

You can see that the plot area has been updated to display a pie chart, with the segments representing the
percentage of effects that have been assigned to each Failure Effect Category (FEC). In addition, the legend
panel at the bottom of the Plot Viewer window has been updated with the details associated with the current
chart. This includes the pathname/filename for the database, the project name, the numbers and names of the
items included in the chart and the FEC percentage information.

You may wish to take some time now to experiment with the options available in RCM++’s pie charts. For
example, you can hide the details on the pie chart and display them in a legend instead. Notice that if you
change the size of the window or the information that is displayed in the chart, the pie graphic may change
from a circle to an elliptical shape. To restore the circular shape for the pie, simply click the Redraw/
Refresh Plot icon to re-draw the chart.

As you experiment with the plot types and Control Panel options, please be aware that if the Auto Refresh
option is not selected, you will need to click the Redraw/Refresh Plot icon to update the plot area to reflect
the new selections.

4.6.4 Generate Pareto (Bar) Charts
e Next, select Task Cost Pareto from the Plot Type menu and make the following selections:
o Display Range =1t0 10
o Cost Type = Total Operating Cost
o Auto Refresh = Selected
o Show Legend = Not Selected
o Show Details in Pies = Selected

o Show User Information = Not Selected

RCM++ 4 Training Guide 65



4 Step-by-Step Examples

The Plot Viewer will now look like the figure shown next.

~lolx|
Tasks Ranked by Total Operating Cost {1 - 10)

Flok Type
ITask Cost Pareto j

Recard Type

ITask j
Record Quantity 13

Display Range —————————————
’V From: |1_ Tar IIU_

16433 .4

16000

14000

12000

Cost Type

10000

919781

#0001

Total Operating Cost

v auto Refresh
[~ show Legend
[¥ 5how Details in Fies

£000 cogk 53

417574 I" Show User Information

2000
1120.01

Database: C:\Program Files\ReliaSoftiRCMAFilesiPlotsExample. rxd ﬂ Close |

Project: Data For Charts

4

You can see that the plot area has been updated to display the top ten tasks (based on Total Operating Cost)
that are associated with the selected item. If desired, you can change the options in the Control Panel to
display other variations of the Task Costs chart. For example, you can change the Display Range to 1 to 5 or
change the Cost Type to Cost per Uptime or Total Cost per Incident. Other combinations are also available.

e You can take some time now to experiment with the other bar charts by selecting the chart from the Plot
Type menu and then making the appropriate selections in the Control Panel. When you are finished,
return to the Tasks Ranked by Total Operating Cost (1 - 10) chart and proceed with the example.

4.6.5 Edit Plot Setup

You can use the Plot Setup window to customize the appearance of the charts that you create in RCM++.

e To access this utility, right-click inside the plot area or legend panel and select Plot Setup from the
shortcut menu or click the Plot Setup icon.
ﬂl

The Plot Setup provides many customization options, which are described in detail in the RCM++ User's
Guide. For this example, you will make a change to the settings for pareto (bar) charts.
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e To do this, click the Lines, Bars and Pies tab to display a page like the one shown next. This page
presents all of the customization options for grid lines, pareto chart bars and pie chart segments.

[MIPIot Setup x|
Titles I Mumbers and Legend  Lines, Bars and Pies | OrcfSey Matrix I

—iatid Lines Thickness, Calor and Style

Thick  Calar Style Thick Caolar Style oK

xesos (eottom) [0 | [ "] waior pivisions xesuxis [o [ [ ]—] coneel |
vaoas (eft) o <] || wesor owvisions v-ais [5 <] [ ]—] ;
rigt Border [~ | [j—]
topgorder [ <] [ —

—Pareto Chart Bars ———————————— Fie Chart Segments ——————————
IPrimary Eiar Calor j . ISegment 1 j .
I [~ Use Priarity Colars I._-j,lr.:s. b f“'Ju:
= 1=l
o
o

Set As Default

e To change the color of the bars in the pareto chart, click the box to the right of the Primary Bar Color
menu in the bottom left corner of the window and select a new color from the Color Palette, as shown
next.

B azic colors:
Err— - = B x4
L Uil 0l |

Titles I Murnbers and Legend .- I_

—iatid Lines Thickness, Calar . I_ - - - - - .

Thick Cof NN NN H BN st [ol's
was oo [l mmmmmr m— [ coeel |
¥-Axis (Left) IEI 'l . Custom colors: ]El

Right Border IE. F::FFFFFF

op Borcer IE . Define Cugtom Colors »> |

—Pareto Chart Bars Cancel |

IPrimarv Bar Color j. ISegment 1 j . w
PraN+

[~ Use Pricrity Calors
Sek As Default

e Click OK to close the Color Palette and then click OK again to close the Plot Setup and return to the Plot
Viewer window. If the new bar color is not applied automatically, click Redraw/Refresh Plot to update
the display.

RCM++

This change to the plot settings will be in effect for all pareto (bar) charts generated during this session in the
Plot Viewer. If you close and re-open the window, the default settings will return. If you want a plot settings
change to persist after the current session, click the Set as Default button in the bottom right corner of the
Plot Setup window.

4.6.6 Send Plot to RS Draw

As in most of ReliaSoft's other software products, RCM++'s plotting utility provides integration with the RS
Draw metafile (vector) graphics editor. You can use RS Draw to edit and annotate the chart graphics that you
create in the Plot Viewer and also to save plot graphics as Windows metafiles (*.wmf).
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e With the Tasks Ranked by Total Operating Cost chart displayed in the Plot Viewer, right-click inside the
plot area or legend panel and select Edit Plot from the shortcut menu or click the Edit Plot icon.

i

The RS Draw utility will be opened with the current chart displayed, as shown next.
1ol x]

File Edit Wiew Draw Arrange Transform  Help |
Dl & =)o #- QR WolEpsasa k-

Tasks Ranked by Total Operating Cost (1 - 10)

Total Cperating Cost

CYPFPERCOOD / /)~

 Task

Line - Fill
Color: Color:

e You can expand the title for the chart to include the name of the item analysis that the chart is based on.
To do this, click the Text tool from the toolbar on the left side of the window.

Al

e The cursor will turn into an arrow with a T next to it. Click inside the plot in the area of the title and drag
the mouse down for a short distance before releasing the left mouse button. A blinking vertical line will
be placed into the graphic at the location where you placed the mouse and the length of this line will
depend on how far you dragged the mouse.

e Type the following text into the plot and the press Enter to create the new text object.

e For System 12345
e Click the Select tool and use it to right-click the new text object.

L]
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e Select Object Properties from the shortcut menu and use the Properties window to change the
appearance of the text to match the original plot title. Change the Font Color to black and the Font to 12
point Tahoma then click Set to close the window and apply the properties.

rjf_.-' Properties E

Line Properties | Fill Properties  Text Properties I @

i

LCancel
Font: | Tahoma 12 pt. l
AaBb Cc Dd

e Now use the Select tool to drag the text object into the desired position, centered below the original plot

title.” Click the white background of the plot to de-select the new text object. The RS Draw window will
now look like the figure shown next.

SI=E
File Edit Wiew Draw Arrange Transform  Help |
DEE & r2@lv #-QeQmupE/ sarallr-
W Tasks Ranked by Total Operating Caost (1 - 10)
i For System 12345
~,
=
.
O
(o]
<
Gl
cll &
Al ¢
~ &
Task )
Line Fill
Calar: Calar:

You can follow similar procedures to make other annotations to the plot graphic, if desired.

e To save the annotated plot graphic as a Windows metafile that can be inserted or edited in other
applications, select Save from the File menu. Specify the name and location of the *.wmf file and click
Save.

e Now, select Exit from the File menu or click the X in the top right corner of the window to close RS
Draw.

e Close the Plot Viewer then close the project and database before proceeding to the next example.

7. If desired, you can use RS Draw's Align Objects tool to exactly center the original title and the new subtitle. Simply
press Shift while selecting the original title and then the new subtitle. When both text objects are selected, choose
Center from the Align Objects icon to center align the text objects automatically.
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4.7 Example 6 - RCM Analysis for Conveyor Belt

This example guides you through the process for entering a portion of an RCM analysis for a conveyor belt.

For this example, you will work with sample data provided for demonstration purposes. This information is

not intended to be realistic.

4.7.1 Create a New Database and Project

e Create a new database called Sample RCMs.

e Create a new project called Conveyor Belt and use the Standard RCM profile to set the project
properties. This will automatically configure the software for a basic RCM analysis.

4.7.2 Define the Item and Function

For this example, the analysis will be performed on a Conveyor Belt, which has the following primary

function:
Convey solid material from one location to another at XX pounds per hour while maintaining
system integrity and providing feedback to the DCS.

e Define the item and function in the project, as shown next.

’Etonveyor Belt =] E3
Project  Edit Wiew System Hierarchy Function Failure Effect Cause
Sa X |1 B | IS B | zoom- | H W (W2 N (2]
Syskem Hierarchy FMEA Hierarchy - Conveyor Belt
Hame: [B |Y‘F [m]=] [ Description HEREEERE
}l (8 Convevor Bel: | | [F] Convey solid material From one location ko another at 2% pounds

[#] pet hour while maintaining system integrity and providing Feedback
o the DS,

- -
A 13 A 13

|»| Function ||C0nvey solid material from one location to another at %% pounds per hour while maintaining system inkegrity and providing feedb v

4.7.3 Define the Failures, Effects and Causes
The analysis team has identified the following ways that the equipment may fail to perform its intended
function:
Failure: Conveys less than the required rate.
Effect: Reduction in production.
Cause: Product belt slippage due to improper alignment and/or tension.

Cause: Plugged feed and/or discharge spout due to foreign object.
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Failure: Conveys no material.
Effect: Loss of production.
Cause: Belt conveyor bearing worn or seized due to improper lubrication.
Cause: Chain drive failure due to chain wear and/or damage.
Failure: Provides no signal to DCS.
Effect: Operation impaired.
Cause: Contact failure.
Cause: Faulty wire/connections.

e Enter this portion of the analysis into the project, as shown next.

’Etonveyor Belt M= E3
Project Edit Wiew System Hierarchy Function Failure  Effect Cause
Sa X | I B | IS RS | zoom- | H 4 (W3 S D =] (2]
Syskem Hierarchy FMEA Hierarchy - Conveyor Belt
=] Hame: [B |Y‘F [m]=] [@ Description O rlalclreEc]r]=
»| [ ConveyorEBelt 3 Convey solid material from one location ko anather

= [B] at %% pounds per haur while maintaining system
i integrity and providing feedback to the DCS,
[=--[#] Conveys less than the required rate.
E}@ Reduction in production.

______ = Product belt slippage due to improper
=1 glignment and/or tension,

______ = Flugged feed andfor discharge spout
=l due to foreign object.

[=--[#] Conveys no material,
Ef-[M] Loss of production,

______ = Belt conveyor bearing worn or seized
=1 due to improper lubrication,

= Chain drive failure due to chain wear
=1 andjor damage.

[=--[®| Provides no signal ko DiCS.
E}@ (Operation impaired.

Contact Failure,
=] Faulty wire/connections.

- -
A 13 A 13

=) Cause ”Faulty wire/connections, v

4.7.4 Perform the Failure Effect Categorization

e Double-click the FEC column to the right of the first effect description to display the logic diagram that
will be used to categorize the failure effects. Select Yes to answer the first question, No to answer the
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4 Step-by-Step Examples

second question and Yes to answer the last question. The effect will be categorized as EO - Evident
Operational, as shown next.

'E‘Failure Effect Categorization

Current Ikem | 1 - Conveyor Belt

Function | 1 - Convey solid material from one location to another at XX pounds per hour while maintaining system integrity and providing feed

Failure | 1 - Conveys less than the required rate,

—Cuestion 1

Effect | 1 - Reduction in production,

Is the occurrence of a functional Failure evident to the operator during the performance of
normal duties?

% Yeg

" No

—Question 2

Does the functional Failure or secondary
damage resulting From the Functional
failure have a direct adverse effect on
operating safety or other hazardous
results?

" ves * No

Ciuestion 3

Does the hidden functional Failure or
secondary damage resulking from the
functional Failure have a direct adverse
effect on operating safety or other
hazardous results?

 ves LT

e
CQuestion 4

Does the functional Failure have a
direct adverse effect on operating

Does the hidden functional Failure
have a direct adverse effect on

ong§—— 1
Cuestion 5

capability? operating capability?
% Yeg " No  ves LT

| | | |

Es EO EE Hs HC HE
) Evident Evident " Hidden Hidden
Evident Safety DOperational Econamic Hidden Safety Operational Econamic

| Last Update Date: 3/14/2006

_ ol x|
Answer 1
=
] ;IILﬁl
Answer 2
=
] ;IILﬁl
Answer 3
=
_ ;Ilml
Answer 4
=
] ;IILﬁl
Answer 5
=
_ ;Ilml
Remarks
=
] ;IILﬁl
Cateqgary
IEO - Evident Operational j
EE O
4

e Click OK to save the analysis and return to the Project window.

e Use a similar procedure to analyze the other two effects. These effects will also be categorized as EO -
Evident Operational.

4.7.5 Select and Define the Maintenance Tasks

e Right-click the third failure cause (“Belt conveyor worn or seized...”) and select Manage Tasks from the

shortcut menu to open the Maintenance Task Manager window.
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4.7 Example 6 - RCM Analysis for Conveyor Belt

e Select Yes to answer the first task selection question, as shown next.

’EMaintenance Task Manager !E[ E

Current Ikem | 1 - Conveyor Belt

Function | 1 - Convey solid material from one location to another at %¥ pounds per hour while maintaining system integrity and providing fe

Effect | 1 - Loss of production,

|
|
| Failure | 2 - Conveys no material,
|
|

Cause | 1 - Belt conveyor bearing worn or seized due to improper lubrication,

FEC: ED - Evident Operational v Display Task Selection Logic
Question Q ‘fesiho Q Explanation -
B i1 Is a scheduled service task (such as lubrication) applicable and effective? fes
21 Is a scheduled on-condition inspection task applicable and effective? Mo
31 Is a scheduled repairfreplacement. task applicable and effective? Mo
4 Is an up-front one-time task (such as re-design) applicable and effective? Mo

-
A 13

Run ko Failure:  Cost per Uptime | Undetermined Average Availability (%) | Undetermined
Assigned Labor {Crew Total Duration Total Cost Cost per Aver: -
Fy
i Vs Gl SEie | Tvpe Inkerval Tame) per Incident per Incident Lptime

v
1| | 3

Stakus Type

[an = = @ AddTask...”@ Add Linked Task, .

| Maintenance Packaging... |

[ Edit Task... ” s Delete Task |

Refresh | [8]4 | Cancel |

%

e Click Add Task to define the task. Enter the properties shown next and click OK to save the record.

[Mladd Task E
# Task Mame
I 1 I Apply proper lubrication ko the conveyor bearing, ﬁl_ﬁj
[

Task. |PM Resources | User Defined I

Type Task Description
IService (5 j ;”_ﬁj
Status
IAssigned j ;II
b
Maintenance Package Reference Document
| =] =[]

[ b

Proposed Interval  Units Assigned Interval  Units

I j I 1 Week j Calculate Optimur. ..

Based on: (% Ikem Age {~ System Age

Condition
| =&

Remarks

Zong I Lﬁj Access Lﬁj

Cost per Uptime Total Operating Cost Average Availability (%)

| | | @

| Associaked EMEA. .. [Z Show Cause... ||¢Q|| .Q” @ ”_/;;”“j” @.| OF | Cancel |

o
- | Adding new Task

e Close the Maintenance Task Manager for this failure cause and then open the window for the next cause
(“Chain drive failure...”).
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4 Step-by-Step Examples

e Answer the selection questions No, No, Yes, No to indicate that a scheduled repair/replacement
maintenance strategy will be applicable and effective for this issue.

e Add a task with the properties shown next.

[Mladd Task E
# Task Marme
I 2 I Preventively replace the chain drive. ﬁl_ﬁj

[ b 1

Task. |PM Resources I User Defined I

Type Task Description
IRepair,l’RepIace (RR} j ;”_ﬁj
Status
IAssigned j LI
hd ]
Maintenance Package Reference Document
|
| =l =&
| I - ]
Proposed Interval — Linits Assigned Interval  Units
I j I 1 ‘fear j Calculate Optimur. ..
Based on: (% Ikem Age {~ System Age
Condition
|
I _'Il_ﬁj
[ hd |
Remarks
|
I _'Il_ﬁj
[ hd |
Zong I Lﬁj Access Lﬁj
Cost per Uptime Total Operating Cost Average Availability (%)

| | | @

Associaked EMEA. .. [Z)  Show Cause... || 23| ¢ 2| @) OF Cancel
4D 8 [ AL

| Adding new Task

e If desired, you may continue this analysis on your own, entering additional failures, effects, causes and/
or tasks based on your experience.

e When you are finished, close the project but leave the database open to proceed to the next example.

4.8 Example 7 - RCM Analysis for Dust Filter

This example guides you through the process for entering a portion of an RCM analysis for a dust filter. For
this example, you will work with sample data provided for demonstration purposes. This information is not
intended to be realistic.

4.8.1 Create a New Project

e With the database from the previous example open, create a new project called Dust Filter and use the
SAE RCM (6 Categories) profile to set the project properties.

4.8.2 Define the Item and Function

For this example, the analysis will be performed on a Dust Filter, which has the following primary function:

Remove unwanted particles of size XX and larger from air stream at a system required flow
rate of YY while maintaining system integrity and providing feedback to the DCS.
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4.8 Example 7 - RCM Analysis for Dust Filter

e Define the item and function in the project, as shown next.

[MIpust Filter - o] x|
Project Edit Wiew System Hierarchy Function Faillure Effect Cause
2 X | & B | S R | zeom- | H { (M| EH - DN 5 ©
Syskem Hierarchy FMEA Hierarchy - Dust Filker
=] Hame: [ [Em]<] o Description HEREEERE
}l [l Dust Filker | | [F] Remove unwanted particles of size X% and
» ] larger From air stream at a system required Flow
rate of ¥ while maintaining system integrity
and providing feedback to the DCS,

- -
A 15 A 15

|»| Function ”Remove unwanted particles of size ¥ and larger from air stream at a system required Flow rate of ¥ while maintaining system i

4

4.8.3 Define the Failures, Effects and Causes

The analysis team has identified the following ways that the equipment may fail to perform its intended
function:

Failure: Does not remove required particles.
Effect: Regulatory non-compliance.
Cause: Tube sock failure.
Cause: Tube cage/thimble sheet seal failure.
Failure: Filters less air than required.
Effect: Loss of production.
Cause: Partially plugged filter due to excessive loading.
Cause: Sweep arm gearbox failure due to leaking seals.

e Enter this portion of the analysis into the project, as shown next.

-ioix
Project Edit Wiew System Hierarchy Function Faillure  Effect Cause
G x| B 1S b e | H 4 (B A D D e

System Hierarchy FMEA Hierarchy - Dust Filker
=] Hame: [B |Y‘F|M|A [m] Description IERNEEEREE
»| 8 DustFiler 3 Remove unwanted particles of size XX and larger from air
= [B] stream at a system required flow rate of ¥ while maintaining
i system integrity and providing feedback to the DCS,
[=--[® Does not remove required particles.
E}@ Regulatory non-compliance.
=] Tube sock failure.
[Z] Tube cage/thimble sheet seal failure.
[=-[®| Filters less air than required.
E}@ Loss of production.
; Partially plugged filker due to excessive loading,
Sweep arm gearbox Failure due to leaking seals,

- -
A 15 A 15

=) Cause ||Sweep arm gearbox Failure due to leaking seals,
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4 Step-by-Step Examples

4.8.4 Perform the Failure Effect Categorization

e Double-click the FEC column to the right of the first effect description to display the logic diagram that
will be used to categorize the failure effects. Select Yes to answer the first question and Yes to answer the
second question. The effect will be categorized as 1 - Evident Safety and Environmental
Consequences, as shown next.

'E‘Failure Effect Categorization gl =l
| Current Item | 1 - Dust: Filker
| Function | 1 - Remove unwanted particles of size ¥x and larger from air stream at a system required Flow rate of ¥ while maintaining system
| Failure | 1 - Does not remove required particles,
| Effect | 1 - Regulatory non-compliance,
—Cuestion 1 Answer 1
'will the loss of function caused by this Failure mode on its own become evident: to the operating ;Il_ﬁj
crew under normal circumstances? ;I
i ]
(G Lo
[ & | o Answer 2
—Question 2 Guestion 3 ;Il_ﬁj
Is there an intolerable risk that the Is there an intolerable risk that the - ;II
effects of this Failure mode could injure effects of the multiple Failure could injure
o kill someone OR. Is there an o kill someone OR. Is there an Anser 3
intolerable risk that the effects of this intolerable risk that the effects of the = ﬁ
failure mode could breach a known multiple Failure could breach a known ;I
environmental standard or regulation? environmental standard or regulation? . 1
% Yeg " No  ves LT Aniswer ¢
P P I -
Guestion 4 Guestion 5 jlﬁ‘J
hd ]
Answer 5
Dioes the Failure mode have a direct Dioes the mulkiple Failure have a ;I
adverse effect on operational direct adverse effect on operational ﬁ
capability? capability? - ;II
Remarks
= yes LT = yes LT jll_ﬁj
| | | | _ al
Evident 2 3 Hidden4SaFety 5 & Category
Saf_ety and Ewde_nt Ewdent_Non- and Hldd?n Hidden _Non- |1 - Evident Safety and Environmental Consequej
Environmen Operational Operational Erviranmental Operational Operational
tal Consequences | [ Consequences Consequences Consequences | [ Consequences
Consequenc a =l g )] ok | Cancel |
| Performing Failure Effect Categarization 4

e Click OK to save the analysis and return to the Project window.

e Use a similar procedure to analyze the other effect. This effect will be categorized as 2 - Evident
Operational Consequences.

4.8.5 Select and Define the Maintenance Tasks

e Right-click the first failure cause (“Tube sock failure”) and select Manage Tasks from the shortcut menu
to open the Maintenance Task Manager window.
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4.8 Example 7 - RCM Analysis for Dust Filter

e Answer the selection questions No, No, Yes, No to indicate that a scheduled discard (replacement)
maintenance strategy will be applicable and effective for this issue, as shown next.

@Maintenance Task Manager gl =l
| Current Item | 1 - Dust: Filker
| Function | 1 - Remove unwanted particles of size ¥ and larger from air stream at a system required Flow rate of ¥ while maintaining syste
| Failure | 1 - Does not remove required particles,
| Effect | 1 - Regulatory non-compliance,
| Cause | 1 - Tube sock Failure,
FEC: 1 - Evident Safety and Environmental Consequences v Display Task Selection Logic
Question Q ‘fesiMo Q Explanation -
8 Is a scheduled on-condition task technically feasible and worth doing? Mo
94: Is a scheduled restoration task technically Feasible and worth doing? Mo
B [9E: s a scheduled discard task technically Feasible and worth daing? fes
10: Is a combination of tasks technically feasible and worth doing? Mo
-
4 4
Run ko Failure:  Cost per Uptime | Undetermined Average Availability (%) | Undetermined
Assigned Labor {Crew Total Duration Total Cost Cost per AvEr: -
Fy
i Vs Gl SlEie | Type Inkerval Tame) per Incident per Incident Lptime
-
«| | »
Stakus Type
[ai = = 5 AddTask. || AddlnkedTesk.. g7 EdiTssk. | DeleteTask]
| Maintenance Packaging... | Refresh | OF | Cancel |

e Click Add Task to define the task. Enter the properties shown next and click OK to save the record.

# Task Mame
I Preventively replace the tube sock,

| 1
[

Task. |PM Resources I User Defined I

Type Task Description

IRestoration (RS} j ;”_ﬂ
Status

IAssigned j - ;II

Maintenance Package

Reference Document:

| =

[ -
Proposed Interval  Linits Assigned Interval  Units
I j I 1 Month j Calculate Optimur. ..
Basedon: (% Ikem Age = System Age
Condition
= |
|| —'Ill_ﬂ
Remarks
= |
II _'Ill_ﬂ
Zong I Lﬂ Access

Cost per Uptime

Total Operating Cost

Average Availability (%)

| &

Associaked EMEA. ..

H amD)

[@_stoncase. @] @] 0] 2] %] @l

ok |

o
- | Adding new Task
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4 Step-by-Step Examples

e If desired, you may continue this analysis on your own, entering additional failures, effects, causes and/
or tasks based on your experience.

e When you are finished, close the project but leave the database open to proceed to the next example.

4.9 Example 8 - Cost and Availability Comparisons

This example guides you through the process for comparing maintenance strategies based on cost and
availability. For this example, you will work with sample data provided for demonstration purposes. This
information is not intended to be realistic.

4.9.1 Mechanical Component with Wearout

Consider an RCM analysis for a large truck that is intended to operate for 120,000 miles per year. A critical
failure mode has been identified for a mechanical component and reliability analysis indicates that the
failure behavior follows a Weibull distribution with beta = 2.3 and eta = 72,000 miles. Considering logistical
factors, downtime penalties and the actual repair resources, it takes 7 work days (3,500 miles of lost
“production”) and costs $4,650 each time the component must be replaced when it fails. The component will
be “as good as new” after the maintenance action. The RCM analysis team is considering whether to
incorporate a scheduled preventive replacement task into the maintenance plan. Because there are no
additional logistical delays/costs for a planned replacement, the PM task will take only 1 work day and cost
$2,050.

e With the database from the previous example open, create a new project called RCM Cost Comparison
and use the Standard RCM profile to set the project properties.

e Select Project Properties from the Project menu and go to the Menus tab. Click Edit and go to the
Units tab. Enter Mile for the Base Unit and use the Delete Row button to delete all of the other units
except Day. Enter 500 for the Multiplier, as shown next.

—ioix]
:

n_ _n_

iS |

Classification I Action Priority I Action Category I Control Type | Prob of Loss | Task Stakus  Units

Base Linit IMiIe
Other Units
Uit [ Mulkiplier |
1p | Day | 500 |
= Delete Row
Copy Existing. .. |5 (7] oK | Cancel |
| Updating Menu Set For this project 4

e Save the changes and close the Project Properties window. With these settings, there will be two options
for entering “time” values within the project, Mile or Day, where 1 day is equivalent to 500 miles.
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4.9 Example 8 - Cost and Availability Comparisons

e Add an item called “Truck” and open the Item Reliability and Maintainability window.® On the
Maintainability tab, enter 120,000 for the Operating Time and select Mile for the Units, as shown next.

’E.‘Item Reliability and Maintainability x|

R, p----------HLPHTT'TF}_PPEBEEEEE———.
Parent System | NjA

| Mext Higher Assembly ‘ WA

| Current Tkem ‘ 1 - Truck

Reliability Mainta\nabihtyl

Dperating Time Units
[ 120000 [Fes =l

Itern Downtime Rate

| oo | =

+
+ |
5 QK Cance|

[

| Last Update Date: 3/15/2006

e Enter a function, failure, effect and cause, as shown next.

RT=TE

© Project Edit Wiew Swstem Hierarchy Function Faillure  Effect Cause

i3 X | & B | S B | zeom- | H { (M| E - N 5 ©
Syskem Hierarchy FMEA Hierarchy - Truck
[=]| Mame [aF]e[m]=] [ Description O Flalclrc]T]=
}E [ Truck ] = [B] Traverse 500 miles per day.

[=--[®] Failure ko travel 500 miles per day.
E}@ Delivery delay.
» {Z] Mechanical component Failure,

- -
A 15 A 15

[C System ”Truck v

8 To open the Item Reliability and Maintainability window, you can click the Reliability button in the Item Properties
window or select Item Reliability/Maintainability from the System Hierarchy menu.
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e Open the cause (“Mechanical component failure™) and define the failure behavior on the Probability tab,
as shown next.

x

Current Tkem | 1 - Truck

Function | 1 - Traverse 500 miles per day.

Failure | 1 - Failure o travel 500 miles per day.

|
|
|
| Effect | 1 - Delivery delay,

Cause I User Defined ~ Probability |Correct\va Maintenance

W Define the probability of occurrence For this Cause,

Data Source

—Distribution and Parameters —Calculate Probability ——

Tirne

—

Distribution Units |Mi|e

[ wea | BT

weibull |23—
Expanential

Eka

Morrnal 72000 Probabilicy
Lagnormal Cemimig

Mixed \weibull - 2 ID

Mized \wWeibull - 3
Mixed Weibull - 4

[B =0 [aafi]a]o]e] & | o |

| Last Update Date: 3/15/2006

RCM++

o Define the duration and cost for corrective maintenance on the Corrective Maintenance tab, as shown
next.

MEdit Cause x|

Current Tkem | 1 - Truck

Function | 1 - Traverse 500 miles per day.

Failure | 1 - Failure o travel 500 miles per day.

| Effect | 1 - Delivery delay,
Cause I User Defined I Probability — Corrective Maintenance

[™ This failure is undetectable and will not be corrected until the next scheduled maintenance or inspection

I
‘ Ttem Cperating Time | 120000 Mie Item Downtime Rate || Edit... |

Restoration Factar 1 pEteer et
Misc, Cosk I 4,650.00

Materials {Spare Mame/Part Number) Downtime Cost ’7
| =/ —

[l
L b ] Labor Cost Per Incident
Labor (Crew Name) Time Based Labor Cost

=] -
| =/l
[ = ] Total Labor Cost
Labor Rate I per IDay j Materials Cost I

Task Duration Total Cost Incident 4,650,00
Delay - Wait for Labor I oo per neen -

Delay - Wait for Materials I ’7

Cost per Uptime
Task Duration I 7
Total Dperating Cost

Total Duration per Incident ’T Average Availability (%) ’7 @‘
D "
am» E el EuliEEe] _« | ow |

| Last Update Date: 3/15/2006

RCM++
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4.9 Example 8 - Cost and Availability Comparisons

mechanical component will be run to failure. The results will be as follows:
e 1.43 CMs and Uptime = 115,114.20 miles
o Total Operating Cost = $6,626.25
e Cost per Uptime = 0.058 per mile
o Average Availability = 95.93%

[Mladd Task x|
# Task Marne
I 1 ! Preventive replacement j‘l_ﬁj
i
Task IPM Resources | User Defined |
Type Task Description
IRepair,l’RapIace (RR) j ;”_ﬁ
Status
IPerosed j LI
|
Maintenance Package Reference Document
=
| =l =
L n/ |
Proposed Interval  Units assigned Inkerval  Units
I j | j Calculate Optimu. ..
Basedon: & Item Age = System Age
Condition
=
| =[]
L = |
Remarks
=
| =&
L = |
Zone I Lﬁj Arcess Lﬁj
Cost per Uptime Total Operating Cost Average Availability (%)
+
E Iil Associaked FMEA. .. ” =] Show Cause... ”@” e ” ] ”g”‘:“)” @| O Cancel |
o
© | Adding new Task

Click the Calculate icon to simulate the operation of the truck for one year, assuming that the

Click the Tasks button then click Add Task. Define the planned replacement maintenance strategy as
shown in the next two pictures.
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[MlEdit Task x|
# Task Mamne
I 1 ! Prewentive replacement jl_ﬁj

Task  PMResources | User Defined

Tkem Operating Time \ 120000 Mile Teern Dotwritine Rate ‘ Edit...

Materials {Spare Name/Part Mumber)

Ir=| i
I _'ll_ﬁj Restoration Factor 1

[ hd 1

Labar {Crew Mame) —Cost per Incident

I| _'IILﬁJ Misc. Cost | z,050.00
~
Downtime Cosk
Labor Rat per |Da -
SROrnEe I I 4 J Labor Cost Per Incident I
T Buifitery Time Based Labor Cost
Delay - Wait For Labor I
Delay - Wait For Materials I Total Labor Cost
Task Duration I 1 Materials Cost I
Total Duration per Incident 1 Day Total Cost per Incident 2,050.00

Cost per Uptime Total Operating Cost Average Availability (%)

| | | @

% Iz‘ | Associaked FMEA. .. ”@ Show Cause. .. ||‘§” Q” @ ||_/;||*j‘)” @| [+]3 | Cancel |
-4

| Last Update Date: 3/15/2006

e Return to the Task tab and click the Calculate Optimum button to calculate the optimum replacement
time given the reliability and cost information that you have provided.

e Replace the calculated value (60330.254 miles) with 60,000 and return to the PM Resources tab. Click
the Calculate icon to simulate the operation of the truck for one year, assuming that the mechanical
component will be replaced every 60,000 miles. The results will be as follows:

o .98 CMsand .79 PMs and Uptime = 116,246.80 miles
o Total Operating Cost = $6,188.95

o Cost per Uptime = 0.053 per mile

o Average Availability = 96.87%

The analysis indicates that the scheduled replacement strategy provides both lower cost and better
availability than run-to-failure. The differences between the two strategies will be even greater when applied
to an entire fleet of trucks over multiple years of operation.

e Close the cause and task windows to return to the Project window and proceed with the rest of the
example.

4.9.2 Electrical Component with Infant Mortality

Another critical failure mode has been identified for an electrical component of the truck. This follows a
Weibull distribution with beta = .76 and eta = 100,000 miles. The analysis team is considering a planned
replacement for this component at 60,000 miles to coincide with the PM for the mechanical component. For
this failure mode, the CM downtime is 4 work days; the CM cost is $2,800; the PM cost would be $1,200
and there would be no additional PM downtime because the equipment is already down for the other
maintenance task.
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4.9 Example 8 - Cost and Availability Comparisons

Enter another cause called “Electrical component failure” and define the failure behavior as shown next.

x|

Current Tkem | 1 - Truck

Failure | 1 - Failure o travel 500 miles per day.

|
| Function | 1 - Traverse 500 miles per day.
|
|

Effect | 1 - Delivery delay,

Cause I User Defined ~ Probability |Correct\va Maintenance

W Define the probability of occurrence For this Cause,

Data Source

—Distribution and Parameters

Distribution Units |Mi|e

weibull

Expanential
Marrnal
Lognormal
Mixed \weibull - 2
Mized \wWeibull - 3
Mixed Weibull - 4

Beta

ID.?B

Eka

|1 00000

Garnma

—Calculate Probability ——

Tirne

—

Probability

=

| Tasks... H 0

[we]o]I]v]e] _ * |

Cancel |

| Last Update Date: 3/15/2006

Define the corrective maintenance duration and cost and click the Calculate icon. The results will be as
shown next.

[MEdit Cause

X

Current Tkem | 1 - Truck

Function | 1 - Traverse 500 miles per day.

Failure | 1 - Failure o travel 500 miles per day.

Effect | 1 - Delivery delay,

Cause I User Defined I Probability — Corrective Maintenance

[™ This failure is undetectable and will not be corrected until the next scheduled maintenance or inspection

‘ Ikem Operating Time |

120000 Mile

Item Downtime Rate

|| Edt... |

Restoration Factor 1

IMaterials (Spare Mame/Part Nurmber)

Labar {Crew Name)

~

Labor Rate I

Task Duration

Delay - Wait for Labor

Delay - Wait for Materials

Task Duration

per IDay

"Cost per Incident

Simulation Results - Calculation
-
3)

#of CMs = 1,205
Uptime = 117617738

Misc, Cost

Piannkire ok

er Incident

Labor Cost

Labor Cost

e
—
—
——
—

Total Cost per Incident

2,800,00

Total Duration per Incident

4 Day

Cost per Uptime
Total Dperating Cost

Average Availability (%)

0.029 | Mile

3,374.00
93,01

| Tasks... H 0

[we]o]I]o]e] _ x|

Cancel |

| Last Update Date: 3/15/2006
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e Define the proposed preventive replacement task and calculate the results, as shown in the next two

pictures.

x

# Task Mame

E

| Preventive replacement,
[

Task |PM Resources | User Defined |

Type Task Description

IRepair,l’RepIace (RR) j ﬂl_ﬁj
Skakus

IPerosed j _ j,

Maintenance Package

Reference Docurnent

=
| =] | = E=1
[ hd |
Proposed Interval  Units assigned Interval  Units
| =l S Mile: || caleulate Optimum...
Basedon: f* Item Age = System Age
Condition
=
I _'ll_ﬁj
[ hd |
Remarks
=
| =]
[ hd |
Zone I Lﬂ Access Lﬁj

Cost per Uptime

Total Operating Cost

Average Availability (%)

| | |
é li‘ | Associaked FMEA. .. ”E_] Show Cause. .. ”@H .f}” @ ||g||“j” (_)’,| (o4 | cancel |
g | Last Update Date: 3/15/2006
x

# Task Mame

e

| Preventive replacement,
[

Task  PMResources | User Defined

Ikern Cperating Time ‘

120000 Mile Itern Downtime Rate

Materials {Spare Name/Part Mumber)

Restoration Factor

==l

= |

Labar {Crew Mame)

Cost per Incident

= isc.,
I _-ll_ﬁj Misc, Cast
[ = 1 . o5t
Simulation Results - Calculatio |

Labor Rate |

Task Duration
Delay - Wait For Labar

Delay - Wait For Materials

Task Duration

per I
ost Per Incident

ased Labor Cosk

1 #of CMs =1.387
Hl‘) # of PMs = 0,676
Uptime = 117252, 301

otal Labor Cost

5t

Total Duration per Incident

[ tamomn
—
—

—
——

Total Cost per Incident

1,200.00

Cost per Uptime

Total Operating Cost

Average Availability (%)

| 0,042 { Mile

| 4,934.60 |

97.71

LB

| Associated FMEA. .. ”E_] Show Cause. .. ”@” ﬂu” @ ”g”‘:“r” @|

oK | Cancel |

| Last Update Date: 3/15/2006

In this case, the analysis indicates that a run-to-failure maintenance strategy will be more cost-effective and
provide better availability than scheduled replacement. In fact, since the beta parameter of the failure
distribution is less than 1, this indicates that the equipment does not experience wearout and there is no
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optimum preventive replacement time. The team could repeat the analysis for other maintenance intervals
and would always determine that run-to-failure is more cost-effective.

e Close the project and database then proceed to the next example.

4.10 Example 9 - Integration with BlockSim via XML

RCM-++ provides integration with ReliaSoft's BlockSim system reliability, maintainability and availability
analysis software. You can generate blocks and diagrams in BlockSim based on the system configuration
and reliability information that you have defined in RCM++. This example guides you through the process
of exporting items from an RCM++ project to an XML file that can be opened with BlockSim.

For this example, you will work with a sample database that has been prepared by ReliaSoft, which contains
sample data related to imaginary products. This information is not intended to be realistic.

Note: BlockSim 6 or newer is required to perform this example.®

4.10.1 Open an Existing Database and Project

e Open the sample project called “Export to XML” that has already been created in the
BlockSimExample.rx4 database file that is located in the Training folder in your application directory
(e.g. C:\Program Files\ReliaSoft\RCM4\Training).

With the FMEA hierarchy panel hidden and the Subsubsystem A.1.1 item selected, the Project window will
look like the figure shown next.

[MJEstport ko XML =1oix|
Project Edit View System Hierarchy Function Failure  Effeck Cause
ES x| I e Zoom- | FH /] [W] 3 Yo D | ] 4B @
Systern Hierarchy
) Hame L el SN
= 0 System A
=} =8
B e Subsystem A.1

» Fh-3  Subsubsystern &.1.1
b-|E] Compaorent A.1.1.1

i3] Component &.1.1.2
BB Subsubsystem A.1.2
%] Component 4.1,2,1

=| Component A.1.2.2
-] Component &.1.2.3
E- 2 Subsystem 4.2
EJE Subsubsystem &.2,1
|__j Component &.2..1.1

Component 4.2.1.1

E}E Subsubsyster £,2.2

: I_-j Component 4.2.2,1

L—j Component A.2.2.2

= @ System &
- 8 Subsystem B.1

#| Component B.1.1

I;-] Component B.1.2

5 Subsystem B.2

@ Subsubsystem B.2.1

I_-j Component B.2.1.1

=] Component B.2.1.2

Component B.2,2

----- 2| Component B.2.3

2| Component B.2.4 IE* -
q L'J

2 Assembly ”Subsubsystem A1 v

e You can take some time now to examine the system configuration that has been defined for this project.
You may want to open the properties windows (e.g. Item Properties windows and Item Reliability and
Maintainability windows) for the items to view the reliability characteristics and other properties that

9 The example illustrated in this section was created using BlockSim 7.
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have been defined for the items. You will also notice that reliability characteristics have been defined for
the cause associated with the last item. This information will also be transferred to BlockSim.

e When you are finished, close the Project window so that only the Project Explorer is displayed.

4.10.2 Export Project from RCM++

The next step is to export the system configuration that has been defined in RCM++ to an XML file (*.xml)
that is accessible by the BlockSim software.

e To do this, select Export XML Project from the Project Explorer menu.

e Inthe window that appears, select Export as RBD.

e Note the location where the file will be saved, accept the default filename, “Export to XML,” and click
Save to transfer the data to an XML file (*.xml).

e When the window appears to inform you that the XML file has been created successfully, click OK.

4.10.3 Open the XML File in BlockSim

e When the export to XML is complete, leave the RCM++ database open and activate the BlockSim 6
software.

In BlockSim, choose to open an existing project. Select XML Files (*.xml) from the Files of type menu,
as shown next.

Select file to open HE
Loak in: I@Files j L] cf B

Export to #ML xml

File: name: I

Open I

Filez of type: ML Files [*.xral) Cancel |

BlockS im Prajects [, *.106) 2

BlockSim 7 Projects [*.rbp)

BlockSim 6 Projects [*.rbE
| [*.ml]

Led Lo

ML Files

e Locate and select the XML file called “Export to XML.xml” that you just created in RCM++ and click
Open.
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e BlockSim will create a project that contains diagrams and blocks to represent the system configuration
and probability data that was defined in RCM++, as shown next.

[ ReliaS oft BlockSim 7 [H[=] B3

File “iew Project ‘Window Help
J@doul%2 s vas asde|Em>%EReEae A
orra il Y+lalselnnnele AN ol 2Bk %5k

Tahamna ElE

4

B 7 U|AB====|g|m =qaa

arams
Component B,2.4
Export ko kML
Subsubsystem A.1.1
Subsubsystem A.1.2
Subsubsystem 4.2,1
Subsubsystem A,2.2
Subsubsystem B.2.1
Subsystem A1
Subsystem 4.2
Subsystem B.1
Subsystem B.2
Syskem &

~+{ans| System B
{3 Fault Trees
{3 Phase Diagrams
{8 Maintenance Templates
{38 Templates
{3 Resources
{88 MultiPlots
{3 Reports
{38 Spreadsheets
{8 Attachments

The system configuration and probability data from RCM++ is represented in BlockSim with diagrams,
subdiagrams and blocks. For example, a system from RCM++ will be represented by a diagram that consists

of subdiagrams or blocks for every associated sub-item and cause.°

e To demonstrate this, open the Diagram Sheet called System B by double-clicking its name in the Project
Explorer. This Diagram Sheet represents the System B top level (system) item from the RCM++
configuration. The diagram contains two subdiagram blocks to represent the two subsystems in the next
level of the configuration, Subsystem B.1 and Subsystem B.2, as shown next.

ﬁ Diagram: System B M=l E3
Analytical 0
Subsystern  Subsystem
Elyl B‘TE =l [~ Use IES
Simulatian 0

5
Diagram
Mumber of Blocks 2

C ts

ll f o Comments
4 »

Diagrarm |

10-Note that if you had selected Export as Fault Tree during the export process, the data would be represented in a fault
tree format.
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e Right-click the Subsystem B.2 block and select Open Subdiagram from the shortcut menu. The
Subsystem B.2 Diagram Sheet will appear, which contains a subdiagram block to represent
Subsubsystem B.2.1, two blocks to represent the Component B.2.2 and Component B.2.3 items and a
subdiagram block to represent Component B.2.4 and its associated cause, as shown next.

ﬁ Diagram: Subsystem B_2 |_ (O] x]
m_’ 4@ — Analytical 9
Subsubsystem Component ;‘ﬁument Component

B.2.1 B.2.2 B.2.3 B.2.4

@ Simulation 9

oce|
-5

Diagram
Number of Blocks 4

Comments
lo Comments

L Na

Diagrarn I

e Now double-click the Component B.2.2 block to open the Block Properties window for that item. In the
Block Properties window, click the Reliability tab.

e On the Failure Distribution page of the Reliability tab, you can see that the reliability properties for the
block have been defined based on the information defined in RCM++, as shown next.

I Block Properties [Component B.2.2) [ %}
General - Reliability Properties
Reliability Failure Distribution |

Maintenance
¥ Block Can Fail

Eiﬂl‘ll__a
Beta

ID.964292164D?688?

Eta

IZIBZ.SIDB?IZDBUS

Gamma
ID

[~ Static Reliability

Other

&S

I Set Irem as Failed

Set As Defaulk | Active Block: IComponent B.2.2 j | oK I Cancel | Help |

e In addition, the text that was entered into the Item Description field in the RCM++ Item Properties

window is displayed on the Comments & Attachments page of the General tab in the Block Properties
window.

88 http://RCM.ReliaSoft.com



4.11 Example 10 - Using the Check Analysis Utility

e Close the Block Properties window for Component B.2.2 by clicking OK and open the diagram linked to
the Component B.2.4 subdiagram block.

E Diagram: Component B.2. 4 =l 3
— Analytical 9
lc.?.L.J]s...al ﬁ [~ UseIBS
@ Simulation 9
%
Diagram
Mumber of Blocks 1
C ts
Tl Mo Comments
kil v
Diagrarm |

This diagram contains one block to represent the cause that has been defined for Component B.2.4 in the
original RCM++ project. Please note that when Cause Probability information is transferred to BlockSim,
the time-based parameters (e.g. eta for Weibull) are converted to the Base Unit for the project. This is
necessary because BlockSim assumes that all time values have the same units.

4.10.4 Close BlockSim

e When you are finished investigating the diagrams, subdiagram blocks and blocks in BlockSim, exit the
BlockSim application by selecting Exit from the File menu. If desired, you can save the BlockSim
project.

e Return to the RCM++ application.

4.11 Example 10 - Using the Check Analysis Utility

This example demonstrates the capabilities of RCM++'s Check Analysis Utility, which identifies any
possible discrepancies and/or omissions in each analysis. The utility lists the potential issues and you can
make the decision of whether or not to address each issue.

For this example, you will work with sample data prepared by ReliaSoft. Sample data sets are not intended
to be realistic.

4.11.1 Create a New Database and Import an Existing Project
e Create a new database called CheckAnalysis.rx4. When prompted to create a new project, click Cancel.

e Select View Project Explorer from the File menu or click the View Project Explorer icon.

S Yiew Project Explorer. ., |

e Select Import Projects from the Project Explorer menu or click the Import Projects icon.

d)
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e When prompted to select a database to import from, navigate to the Examples folder in the application
directory (e.g. C:\Program Files\ReliaSoft\RCM4\Examples) and select the database called
Demonstration.rx4. The Import Projects window will be displayed, as shown next.

@Import Projects _ |El|l|
Import from database |a Ct\Program Files\ReliaSoftyRCM4Examples\Demonstration . rxd | Browse ... |
Select Project ko Impork
A ame Eased on Profile Description -
) - This sample project was prepated based on the Design FMES (DFEMERM)
» W 11,1 - Breegm (R I DIFHIER on page 37 of the SAE J1739 guidelines.
[ 1.2 - Pracess FMEA ATAG PEMEA This sample project was prepared based on the Process FMEA

(PFMEA) on page 70 of the ALAG FMEA-3 guidelines.

[ 1.3 - Machinery FMEA

739 MFMEA

This sample project was prepared based on the Machinery FMEA
(MFMEA) on page 45 of the SAE 11739 guidelines,

[[] 2 - Criticality Analysis

MIL-3TD-16294

This praject contains fictional data that can be used to investigate the
software's Criticality Analysis capabilities.

[] 3- Charts Data

Standard FMEA

This project contains fickional data that can be used to demonstrate
the software's Plok Viewer Funckionality,

[ 4 - Check Analysis Data

Standard FMEA

This project contains fickional data that has been created for the

purpose of demonstrating the Check Analysis utility, w7

¥ Remember last datahase opened — Select All || 2= Deselect Al |
Import | Close |
|Import projects from the selected database 4

e Select the project called 4 - Check Analysis Data and click Import to import the project into the current
database. Click Close to close the import window.

e Open the project that you imported. With Component 1.1.1 selected, the Project window will look like

the figure shown next.

@4 - Check Analysis Data = 3]
Project Edit Wiew Swstem Hierarchy Function Failure  Effect Cause
A R =R TR 5 @
System Hierarchy FMEA Hierarchy - Component 1.1.1
[m] Name glrieim <13 Description O ¥ | rewi | RPne | A | CJFEC | T |«
El 08 System 1 P | £l B| Funckion 1
=3 Subsystem 1.1 | | [=-[@] Failure 1.1
» L] Companent 1.1.1 (Fjm E-[m] Effect1.1.1
£l B Systemz . Cause 1.1.1.1 360 SE 1|1 1
L8| Subsystem 2.1 EM Cause 1.1.1.2 504 1)1 1
£l B8 System3 [=--[®] Failure 1.2
B~ 2 Subsystem 3.1 -] Effect1.2.1
EE Subsubsystem 3.1.1 Cause 1.2.1.1 252 140 1 1
Ij Companent 3.1.1.1 Cause 1.2.1.2 230 168 1|1 1
L;j Component 3.1.1.2 5] E Fliulnc:o.:12 o1
ailure 2,
] Subsubsystem 3.1.2 T
ol scu 2L emw 121 -] Effect 2.1.1
2| “omponent .12, Cause 2.1.1.1 1
Component 3.1.2.2 Cause2.1.1.2 1

Eb-3  Subsubsystem 3.1.3
[z Companent 3.1.3.1
L |__j Component 3.1.3.2
[ SystemS
[ System 1

A

|¥] Function ”Function 1

4.11.2 Run the Check Analysis Utility

e Select Check Analysis from the Project menu to open RCM++'s Check Analysis Utility. In this utility,
the area at the top of the window allows you to select the items that will be considered when you perform
the analysis check. The results will be displayed on the first page. The checks that can be performed are
listed on the next two pages: FMEA Checks and RCM Checks.

e Click Select All to include all items in the check.
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’E‘Eheck Analysis Ukility
_

Click the FMEA Checks tab to display the checks that are available for the functional failure analysis
(FMEA). Click Select All Checks.

Click the RCM Checks tab to display the checks that are available for the Reliability Centered
Maintenance analysis. Click Select All Checks.

Click Check to start the process. While the checks are being performed, a progress bar will be displayed
at the bottom of the MDI. When the process is 100% complete, the Analysis Check Results area of the
window will be updated with the results. The window will look like the figure shown next.

=10l x|

Select Iters to be included in the Analysis Check

Mame

= System 1

Bt Subsystem 1.1

LB Component 1,1.1

= System 2

-l Subsystem 2.1

— Select all

= System 3

| —_ Deselect Al |

Analysis Check Results | FMEA Checks | RCM Checks

Analysis Check Results:

Check Items
9 Iterns in the current project have the same Item Mumber (1),
S Iterns in the current praject have the same Item Mumber (2).
2 Items in the current project have the same Tkem Number (3),

5

Item : 1 - System 1
Check Analysis Properties:
Check Itern Reliability
Relisbility has not been defined

Check Equipment Selection:
Equipment Selection has not been performed.

Check Functions:
Mo Functions have been defined,

The Analysis Praopetties {(FMEA header information) have not been defined.

=l

|§ Print. .. ” =] Save... ” Copy Text ” “J|

|

By scrolling through the results, you can see that the utility first compares all selected items to see if they
have the same names and/or numbers. Next, the utility checks the analysis associated with each individual
item and identifies any possible omissions or discrepancies.

4.11.3 Change the Options and Re-Check the Analysis

Now, suppose that you are only interested in the following checks for Component 1.1.1:

The Equipment Selection has been performed for every item.

The Failure Effect Categorization has been performed for every effect.

At least one function, failure, effect and cause have been defined for each item.

The Task Selection has been performed for every cause and the answers match the assigned tasks.

To configure the Check Analysis Utility to perform only those checks that are of interest to you, simply de-
select the items and checks that you do not want to include in the results. Specifically, do the following:

Click Deselect All to de-select all items and then select Component 1.1.1 only.
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Go to the FMEA Checks page, click Deselect All Checks and then select the checks shown next.

Select Items to be included in the Analysis Check

g [ 3]

Name

= [] Swstem 1

-] Subsystem 1,1

~-fw] Component 1,11

[= [ Swstem 2

Select Al

L] Subsystem 2,1

[= [ Swstem 3

Deselect Al |

Analysis Check Results  FMEA Checks | RCM Checks

All Ttems Chedks
™ Check duplicate Item Numbers

™ check duplicate Item Names

—Individual Tkern Checks

[V Check at least one Function for each Item
[V Check at least one Effect For each Failure
[~ Check at least one Control for each Cause
I~ Check duplicate Function Descriptions

™ Check duplicats Effect Descriptions

™ Check duplicate Control Descriptions

I~ Check Severity For Effects

™| Check Gritiality. analysis Fackors for Failures
[~ Check Item Reliability

[V Check at least one Failure For each Function

[v £heck at least one Cause for each EFfect &

I Check at least one Action for each Cause
™ check duplicate Failure Descriptions

™ Check duplicate Cause Descriptions

™ Check duplicate Action Descriptions

™ Check OecurrenceDetection For Causes

I~ Check Analysis Properties

Select Al Checks

Deselect All Checks ‘

|§ Print. .. ” Save... H Copy Text ” w|

Check Clase

Go to the RCM Checks page, click Deselect All Checks and then select the checks shown next.

Select Items to be included in the Analysis Check

=lolx|

Hame
= [] System 1

L] Subsystem 1.1
Component 1,1,1
= [] System 2

W] Subsystem 2.1
= [] Syskem 3

]
o

Select All

Deselect Al |

finalysis Check Results | FMEA Checks  RCM Checks

¥ Check Equipment Selection petformed For every Tkem
[~ Check RCM analysis performed For every MSI
¥ Check FEC performed For every Failure Effect

¥ Check Task Selection performed For every Failure Cause

v Check Task Selection answers match assioned tasks

™ Check Duplicate Task Names
I~ Check Interval assigned ko every Task

I~ Check Cost Caleulation data entered For every Task

Check Close

Select All Checks

Deselect All Checks ‘

|§ Erin Save... H Copy Text ” @|

B

Now, click Check to re-check the analysis, performing only those checks that have been selected for the
selected item. By scrolling through the results, you can see the second set of check analysis results are
less comprehensive than the original results.
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4.11.4 Modify the Analysis and Re-Check

Finally, you may wish to modify the analysis and then re-check to make sure that the issue(s) that you
addressed have actually been resolved. For this example, you will correct the first issue that has been
identified for Component 1.1.1.

To begin, click Close to exit the Check Analysis Utility and return to the Project window. Then select
Component 1.1.1 from the System Hierarchy and double-click inside the FEC column for the first
potential effect associated with the first potential failure, Effect 1.1.1.

Set the Failure Effect Category (FEC) for this effect to EE - Evident Economic, as shown next.

’Efailure Effect Categorization =] 3]
[ Current Itemn | 1 - Component 11,1
| Function | 1 - Function 1
| Failure | 1 - Failure 1.1
[ Effect | 1 - Effect 1.1.1
—Question 1 Answer 1
Is the occurrence of a functional Failure evident ko the operator during the performance of ;”_ﬁj
normal duties? ;I
- 1
@ Ll
[ & ‘ ° Answer 2
—Questonz —————————————————————— Question 3 ;Il_ﬁj
Does the functional Failure o secondary Does the hidden Functional Failure or b |
damage resulking from the Functional secondary damage resulking from the PEREs D
failure have a direct adverse effect on Functional Failure have a direct adverse —
operating safety or other hazardous effect on operating safety or other —I i
resulks? hazardous results? ;II
.
" Yes (oM = es LT Answer 4
Question 4 SR E— Cuestion 5 R jl—ﬁj
= |
Answer 5
Does the Functional Failure have a Dioes the hidden Functional Failure =
direct adverse effect on operating have a direct adverse effect on {
capability? operating capability? - ;II
Remarks
" Yes & No T Yes Lol ] jll_ﬁj
| | | \ . ,
- £ EE e HO HE Saleyuny
Evident safety Ewde_nt Ewdenl_: Hidden Safety H'dd?n Hldden_
Operational Economic Operational Econormic
P& (7] oK | Caniel |
| Performing Failure Effect Categarization A

Click OK to save the change and return to the Project window. Repeat the procedure for the other two
effects in this analysis (Effect 1.2.1 and Effect 2.1.1). You can choose which FEC to assign to each
effect.

Re-open the Check Analysis Utility. The checks that were enabled the last time you used the utility are
still enabled. Click Check to re-check the analysis for Component 1.1.1 only. As you can see, the
warnings under “Check Effects” have been removed. Some additional issues under “Check Causes”
remain but they will not be addressed for this example.

4.11.5 Print, Save or Copy the Results
If desired, you can print, save and/or copy the results generated by RCM++'s Check Analysis Utility.

To send the results directly to the default printer on your computer, click Print. To save the results as a
rich text format document (*.rtf), click Save. To copy the results to the Clipboard, click Copy Text.

When you are finished experimenting with the Check Analysis Utility, click Close to exit the utility and
then close the project and database before proceeding to the next example.
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4.12 Example 11 - Using Profiles/Libraries for Customization

This example allows you to experiment with RCM++'s profiles and libraries functionality and guides you
through the process to create your own custom libraries and profile.

RCM++'s profiles and libraries have been designed to allow flexible configuration of the software to fit the
wide variety of analysis styles for RCM, FMEA and FMECA that exist within industry. You can manage
these configuration resources with the Profiles/Libraries Manager.

4.12.1 Open the Profiles/Libraries Manager

e Toopen RCM++'s Profiles/Libraries Manager, select Profiles/Libraries Manager from the Tools menu.
A window like the one shown next will be displayed.

’EProfiles,.-“Lihraries Management _ |D|i|

Profiles |InterFaca I Severity I Qccutrence I Detection I Menu Sets I Phrase Sets I ES Questions | ES Criticality | FEC Lagic I Tasks I Checd | ¥

Profiles can be used to set the interface style, menus and other settings for a Project. Click Add to create a new profile, Edit ko view
andfor edit an existing profile or Delete to delete the selected profile,

A Bame Description Lask UEdated E Lask UEdated Default
» ALAG DFVEA Eased on ALAG FMEA-3 For Design FMEA (DFMEA), ReliaSoft Corporation 0512005
ALAG PFMEA Based on ALAG FMEA-3, for Process FMEA (PFMEA) ReliaSoft Corporation 3/31/2005
Comprehensive Provides every option available in the software, ReliaSoft Corporation 3/31/2005
11739 DFMEA Based on SAE 11739, for Design FMEA (DFMEA). ReliaSoft Corporation 3/31/2005
J1739 MFMEA Based on SAE 11739, For Machinery FMEA (MFMEA), ReliaSoft Corporation 3/31/2005
11739 PFMEA Based on SAE 11739, for Process FMEA (PFMEA). ReliaSoft Corporation 3/31/2005
MIL-5TD- 16294 Based on MIL-3TD-16294, for FMECA, ReliaSoft Corporation 3/31/2005
Based on the Air Transport Assodiation (ATA) M3G-3
M5G-3 guidelines Far aircraft systemns and powerplant ReliaSoft Corporation 3/31/2008
analysis,
Eased on the Reliability Analysis Center (RAC)
RAC RCM docurnent, "Practical Application of Reliability-Centered | ReliaSoft Corporation 3/31/2008
Maintenance,”
Based on SAE JA1012 "A Guide to the .
SAE RCM {4 Categaries) Reliability-Canfered Maintenance (RCH) Standard.” Reliagoft Corporation 4112005
Based on SAE 141012 "A Guide to the .
SAE RCM ( Categories) Reliability-Cenfered Mainterance (RCH) Standard.” Reliagoft Corporation 4112005
Standard FMEA g[mﬂz:;mmn options found in the major FMEA | o cob cornaration 4{11j2005
Skandard RCM Frovides comman options Found in the major RCHM ReliaSoft Corporation 3/31/2005 v
guidelines.
pdd.. | Edt. || ekt |
w | Expart Current Library... ” Reset Library. .. | Close |
[P
|C:'I,Pn:|gramF\IEs\Re\iaSth'\RCM3'\Defaults.Ib3 |Raad,l’Write v

This window allows you to manage the libraries and profiles that are available to use in your RCM++
analyses.

4.12.2 Create a Custom Interface Style

As the previous examples in this training guide have demonstrated, an interface style is a pre-defined set of
instructions to determine which data fields will be enabled/displayed in the RCM++ interface and report
output, and what those fields will be called. For example, if your organization captures three levels of effect
description (e.g. Local Effect, Next Level Effect and End Effect), then you can define the interface style to
enable/display all three fields. If not, then you can define the interface style to enable/display only one field
and rename the field to be called “Effect Description” or whatever terminology is appropriate for your
application.

e To create your own custom interface style, which can be applied to the projects that you create in
RCM++, begin by clicking the Interface tab in the Profiles/Libraries Manager. This page displays a list
of existing interface styles.
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e Click Add to open the Add Interface Style window.

'&_‘L‘ Add Interface Style =] E3
Mame
Description
Ttem |Analysis I Function | Failure I Effect I Calse | Action | Control | Ranks I Control Plan | DYPER. I DREFM I Task I
Properky ® Display/Report Name % Enabled/Displayed ||
» Itern Namne Itern Marne * Yes
Fark Number Part Murnber s
Albernate Park Number Alternate Part Mumber s
Ikem Descripkion Ikern Description ‘fes
Qby per Syskem Qby per System ‘fes
Qby per NHLA by per MHLA ‘fes
Supplier Supplier ‘Yes
Similar T Sirnilar Ta s e
Reference Designatar Reference Designator Mo
CAGE Code CAGE Code Mo
Design Enginesr Dresign Engineer Mo
Drawing Mumber Drrawing Muraber Mo
Remarks Remarks s =
Copy Existing... oK | Cancel
| Adding new Interface Style to Library A

4.12.2.1 Copying an Existing Style

If there is an existing interface style that comes close to meeting your particular needs, you can copy the
style and modify it as necessary to define the new custom style, following the steps described in this section.
If this does not apply to you, you can skip ahead to the next section.

e To set the properties in your new style automatically based on the properties of an existing style, click
Copy Existing and then select the style from the Select Interface Style window that is displayed, as
shown next with the standard RCM interface style selected.

@Select Interface Style - 1Ol x|
Impart: from Library |Ei Ci\Program FilesiReliaSoft\RCM4 Defaults. [ba Browse. ..
A Name Description Last Updated B Last Updated
Provides the most common data fields Found in the major .
FME&A FIMEAFMECA quidelines, ReliaSoft Corporation 41412005
11739 DFMEA Based on SAE 11739, for Design FMEA (DFMEA), ReliaSoft Corporation 4/11/2005
11739 PFMEA Based on SAE 11739, for Process FMEA (PFMEA). ReliaSoft Corporation 4/11/2005
MIL-5TD-16294 Based on MIL-5TD-16294, for FMECA, ReliaSoft Corporation 4/11/2005
ALAG DFMEA Based on ALAG FMEA-3, For Design FMEA (DFMEA), ReliaSoft Corporation 4/11/2005
ALAG PFMEA Based on ALAG FMEA-3, For Process FMEA (PFMEA), ReliaSoft Corporation 4/11/2005
omprehensive Provides every interface field available in the software, ReliaSoft Corporation 111712005
11739 MFMEA Based on SAE 11739, for Machinery FMEA (MFMEA), ReliaSoft Corporation 4/11/2005
Minirmurn Provides the minimum required fields, ReliaSoft Corporation 4/11/2005
Provides the most common data fields Found in the major .
» RCM RCM quidelines., Reliagoft Corporation 4l4)2005
|
A

e Click OK to update the settings for the new interface style you are creating with the settings from the
existing style. You can use these settings as a starting point and modify them as necessary to meet the
specific needs that will be addressed by the new style.

e For Interface Style Name, type a name for the new interface style that will be meaningful to you, such
as the name of your company and perhaps the type of analysis that the style is appropriate for (e.g.
“ReliaSoft RCM”). This name must be unique among the interface styles that have been created in the
active library file (*.1b4) on your computer.

e If desired, type a more detailed description of the purpose for the style in the Interface Style
Description field.
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4.12.3 Record Properties Tabs

The Item, Analysis, Function, Failure, Effect, Cause, Action, Control, Task, Control Plan and DVP&R tabs
of the Add Interface Style window allow you to determine which fields will be enabled/displayed in the
interface and reports when this style is applied to the project and what the fields will be called. Each tab
displays all of the properties that are available for the selected record type in a table with three columns:

o Property: Contains a list of all properties (data fields) that are available in RCM++ for the selected
record type. You cannot change the information in this column.

o Display/Report Name: Contains the names that will be used within the interface and report output to
identify each property. You can change this name by clicking inside the cell and editing the text.

o Enabled/Displayed: Contains an indication of whether or not the property (field) will be enabled/
displayed in the interface and report output. You can set this to Yes or No by clicking inside the cell
to toggle the selection.

e Take some time now to review the fields that are available for each type of record. Determine whether
each field will be displayed and, if so, what it will be called in the interface and reports for projects that
use this interface style.

e For example, if you want to display the “Part Number” field for item records but you want to call the
field “Part #” instead of “Part Number,” set the Enabled/Disabled column to Yes for that property and
type “Part #” in the Display/Report Name column, as shown next.

@ Add Interface Style [_ O] =]

Marne
[Reliasaft RCM

Description

I This custom interface style was created by the user while warking through the examples in the RCM++ braining guide. ﬂ

Item |Analysis I Function | Failure I Effect I Cause | Actian | Contral | Rarks I Control Plan | CYPER. I DREFM I Task I
% Enabled/Displayed | =

Froperty * Display/Repart Name
Ttern Name Ttern Mamne * Yes
Part Murmber Part Murnber Wes
» Alternate Part Mumber Part #| = es

Item Description

Itern Description

‘es

Oby per Syskem

Qby per System

‘es

Qby per MHLA

Qiby per MHLA

‘es

Supplier

Supplier

‘es

Sirvilat Too

Sirnilar Too

‘es

Reference Designator

Reference Designator

Mo

CAGE Code

CAGE Code

Mo

Design Engineer

Design Engineer

Mo

Drawing Mumber

Drrawing Mumber

Mo

Rematks

Remarks

‘es

Copy Existing...

o] | Cancel

| Adding new Interface Style to Library

4
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As you review the properties available for each record type, you will notice an Enable Actions for Causes
option in the Action tab, and an Enable Controls for Causes option in the Control tab. These options can be
found above the tables, as shown next for the Action tab.

'&_‘L‘ Add Interface Style =] E3
Mame

[Reliasoft Rt

Drescription

| This custom interface style was created by the user while working through the examples in the RCM4++ braining guide. ﬂ

Ttem | Analysisl Function | Failurel Effect I Cause  Action |CUr|tn:|| | Rarks I Control Plan | DVP&RI DRBFMI Task I

[V Enable Actions for Causes
Property Q Display/Report Mame Q Enabled/Displayed |«
» Action Description Ackion * Yeg
Person Responsible Person Responsible ‘es
Due Date Due Date ‘es
Action Status Updates Action Status Updates ‘es
Action Taken Ackion Taken Ves
Completion Date Completion Date ‘es e
Estimated Cost Estimated Cost Ves
Actual Cost Ackual Cosk Ves
Action Categary Action Cakegory Yes
Action Priority Action Pricrity Yes
Reviewed and Approved By Reviewed and Approwved By s -
| Adding new Interface Style to Library A

If you de-select the Enable Actions for Causes option on the Action tab of the Interface Style window, then
you will not be able to define actions for the analyses in projects that use this interface style. Any selections
that have been made for Display/Report Name and Enabled/Displayed will be ignored by RCM++ because
the Actions windows will not be available at all. De-selecting the Enable Controls for Causes option on the
Control tab will have a similar effect for controls.

4.12.3.1 Ranks Tab

The Ranks tab allows you to determine whether Risk Priority Numbers (RPNs) and/or Criticality Analysis
will be enabled for the projects that use the current interface style.

'E Add Interface Style [_ (O] x|
Marme
[ReliaSoft Rt

Drescription

I This custom interface style was created by the user while working through the examples in the RCM++ training guide, ﬂ

Item | Analyssl Function | Fallurel Effect I Cause | Action | Control  Ranks | Contral Plan | DVP&RI DRBFMI Task I

Risk Priority Mumbers (RPMs)

Select the RPN values that will be enabled in the interface and displaved in reports

™ Initial RPN (Calculated)

I Initial Severity ™ Initial Occurrence ™ Initial Detection

I Revised RPN {Calculated)

[ EnablejDisplay Criticality Analysis Factors,

Copy Existing... OF | Cancel

| Adding new Interface Style to Library S

e Make the required selections to meet your particular needs and click OK to create the new interface
style.
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4.12.4 Create a Custom FEC Logic

The FEC logics are pre-defined sets of questions and categories that can be used to evaluate the effects of

failure in an RCM analysis.

e To create your own custom FEC logic, which can be applied to the projects that you create in RCM++,
begin by clicking the FEC Logic tab in the Profiles/Libraries Manager. This page displays a list of

existing FEC logics.

e Click Add to open the Failure Effect Categorization Logic window.

This window also provides the ability to copy the properties of an existing logic into the new logic and
requires a unique name for the scale (as described for interface styles in Section 4.12.2.1). The following

options are available when defining an FEC logic:

o Logic Tree Configuration: Allows you to specify whether your logic diagram will have 3 questions
and 4 categories, 4 questions and 5 categories or 5 questions and 6 categories. For 5 category
diagrams, you must also specify whether the last question occurs in the yes (left) branch or no (right)

branch.

o Questions: Depending on your selection for the Logic Tree Configuration, the window displays 3, 4
or 5 text boxes to allow you to type the questions that will appear in the logic diagram.

o Categories: Depending on your selection for the Logic Tree Configuration, the window displays 4, 5
or 6 sets of text boxes to allow you to type the categories that will appear in the logic diagram, along

with their short abbreviations.

The window shown next provides an example of what your screen might look like as you add entries to the
new custom FEC logic. The appearance will vary, of course, based on the information that is appropriate to

your particular needs.

@Add Failure Effect Categorization Logic x|

Tame
ICustDm FEC Logic

Description

I This custom logic was created by the user while working through the exarnples in the RCM++ training guide.

Lagic Tree Configuration 4 Categories

Lel kL

‘fes

This is the first question in the logic
diagram.

No

This is the question that will be asked IF the
answer ko the First question is Yes.

This is the question that will be asked if the
answer ko the First question is Mo,

Yes Mo Yes Mo
1 2 3 4
IF the answer IF the answer TF the answer TF the answer
to the second to the second tothe tothe
question is question is Mo, third question third question
WEs, is Wes, is Mo,
+
e e
E Copy Existing... =) O | Cancel |
o
(-4 Adding new Failure EFfect Categorization Logic to Library

e When you have fully defined the FEC logic, click OK to save the changes and add the new custom

settings to the list of available FEC logics.
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If desired, you can follow a similar procedure to define custom settings for other RCM analysis logics and
Risk Priority Number (RPN) rating scales. The features in each window are different to accommodate the
specific requirements of the settings that you are defining.

4.12.5 Create a Custom Menu Set

A menu set is a pre-defined set of options that will be available in the menus that appear throughout the
RCM++ interface.

To create your own custom menu set, which can be applied to the projects that you create in RCM++,
begin by clicking the Menu Sets tab in the Profiles/Libraries Manager. This page displays a list of
existing menu sets.

Click Add to open the Add Menu Set window.

This window also provides the ability to apply the properties of an existing menu set into the new set and
requires a unique name for the menu set (as described for interface styles in Section 4.12.2.1). In addition,
each of the seven tabs displayed in this window allows you to set the options available within a particular
menu. The tabs include:

Classification: Allows you to set the options that will be available for the Classification menu that
can be enabled/displayed in the Cause Properties window.

Control Type: Allows you to set the options that will be available for the Control Type menu that
can be enabled/displayed in the Control Properties window.

Action Category: Allows you to set the options that will be available for the Action Category menu
that can be enabled/displayed in the Action Properties window.

Action Priority: Allows you to set the options that will be available for the Action Priority menu that
can be enabled/displayed in the Action Properties window.

Prob of Loss: Allows you to set the options that will be available for the Probability of Loss menu
that can be enabled/displayed in the Failure Properties window.

Task Status: Allows you to set the options that will be available for the Status menu that can be
enabled/displayed in the Task Properties window.

Units: Allows you to define the base unit for all time-based calculation inputs in the project (e.g.
Item Operating Time, Task Interval, Task Duration, etc.) and the conversion multipliers for the other
units that are available.

Note that the order of the options in each menu reflects the order in which the options will appear in the
menu within the interface. The following buttons allow you to manage the options that have been defined for
each menu.

o Delete Row deletes the currently selected option from the menu.

Insert Row inserts a new option above the currently selected option in the menu.

o Move Up moves the currently selected option up one place in the menu.

o Move Down moves the currently selected option down one place in the menu.
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The window shown next provides an example of what your screen might look like as you add entries to the
Task Status menu for your new custom menu set. The appearance will vary, of course, based on the
information that is appropriate to your particular needs.

o

Mame

ICustom Menu Set

Description

I This menu set was created by the user while working through the examples in the RCMA+ Training Guide. ﬂ

Classification I Action Priority | Action Category | Control Type | Prob of Loss  Task Status |Units I

Mame |
1 |Assigned
2 |Rejected
A | |
| = Delete Row ” = Inserk Row ” = Move Up ” = Mave Dawn |
Copy Existing... D7 (7] [o]4 | Cancel |
| Adding new Menu Set ta Library A

e Define the menu options for each of the seven menus and click OK to save the new menu set.

4.12.6 Create a Custom Profile

As the previous examples in this training guide have demonstrated, profiles provide a quick and easy way
for you to assign the interface style, rating scales, menu set and RCM logics to the projects that you create
and manage with RCM++,

e To create your own custom profile, which can be applied to the projects that you create in RCM++, begin
by clicking the Profiles tab in the Profiles/Libraries Manager. This page displays a list of existing
profiles.

e Click Add to open the Add Profile window.
e Type a unique name and, if desired, type a more detailed text description.

e Next, select the custom interface style that you created in Section 4.12.2 from the Interface Style menu,
which displays a list of all existing interface styles defined on your computer.

e Then select the custom menu set that you created in Section 4.12.5 from the Menu Set menu.
e Then select the rating scales to be used for any RPN calculations that may be performed in the project.

e Now, click the RCM tab and select the RCM logics that will be applied to the project, including the
custom FEC logic that you created in Section 4.12.4.

o When you have made all selections, click OK to create the new profile. When you apply this profile to a
new or existing project, the interface style, RPN rating scales, menus and RCM logics used within the
project will be updated automatically to fit the custom preferences that you have pre-defined.

e To investigate more advanced features of RCM++'s profiles and libraries, leave the Profiles/Libraries
Manager open and proceed to the next example.
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4.13 Example 12 - Advanced Techniques for Profiles/Libraries

This example guides you through the processes required for more advanced profiles and libraries
management techniques in RCM++. With this example, you will obtain settings from another library,
modify the project properties directly within a project, create a new library set based on the properties that
have been defined for a particular project and create and activate your own custom phrase library.

4.13.1 About Library Files

The profiles and libraries settings that have been defined on your computer are stored by default in the
defaults.lb4 file in the RCM++ application directory on your computer (e.g. C:\Program
Files\ReliaSoft\RCM4). Therefore, each user can manage the profiles and libraries stored on his/her
computer independently of other users. If you want to obtain new or updated settings information from
another user's computer, you can import that record from the library file on that user's computer to the
defaults.Ib4 file on your own computer. You can also export your custom settings to a new library and then
set this library as the active library for the projects you create. In addition, you can set the active library
location in a shared network location so that all users have the same profiles and libraries.

4.13.2 Export Library to Another File

e With the Profiles/Libraries Manager already open, click the Export Current Library button and type
TrainingLibrary for the name of the new library file (*.Ib4) that you are creating.

Click Save to create the file.

4.13.3 Delete a Rating Scale

e Go to the Severity page of the Profiles/Libraries Manager and select the Ten Pt (Sev) rating scale that is
shipped with the software.

e Click Delete to delete the rating scale from the active library.

e Since there is no undo for delete, you will be prompted to confirm that you want to delete the rating
scale. Click Yes to continue.

4.13.4 Obtain Settings from Another Library

Click Add to open the Add Severity Scale window. Click the Copy Existing button to display a Select
Severity Scale window like the one shown next.

ESEIect Severity Scale B ] 4|
Import fram Library |a C:\Program Files|ReliaSof tiRCM Defaults, bt | Browise. .. |
A Mame Description Last Updated B Last Updated -
] From D.H. Stamatis "Failure Mode and Effect Analysis: s .
IT Ten Paint (Sew) FIMEA From Theary Fo Exection,” page 448, ReliaSoft Carporation 3/5/2003
. } From 0, H. Stamatis "Failure Mode and Effect Analysis; ) )

Five Point (Sev) FMEA Fram Theary ta Execution,” page 445, ReliaSoft Corporation 3/5/2003
Aukorotive DFMEA (Sev) |From SAE 11739, page 10, ReliaSoft Corporation 3/5/2003
Aukornotive MPMEA (Sev) |From SAE 11739, page 28, ReliaSoft Corporation 3/5/2003

MIL-STD-16294 (Sev)  |From MIL-STD-16294, page 10, ReliaSoft Corporation 3/5/2003

ARPS5E0 (Sev) From SAE ARPSSE0, page 43, Reliasoft Corporation 3/5/2003

10 Poink {Sev) From Productivity Inc, "The Basics of FMEA," page 35. Reliasoft Corporation 3/5/2003 —
From Ford's "Reliability & Maintainabilicy Guidelines for ) )
Ford Auto MFMEA (Sew) Machinery, Equipment and Toding Applications,” page 69, ReliaSoft Corporation 3/5/2003 LI
oF | Cancel |
= v

e By default, this window displays a list of all the severity rating scales that have been defined in the active
library on your computer However, you can click the Browse button at the top of the window to select a
different *.1b4 file to import a rating scale from.
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e After clicking Browse, choose the TrainingLibrary.lb4 file that you created in the previous step.

e You can see that the Import from Library field at the top of the window now displays the
TrainingLibrary.lb4 file and the table has been updated with the severity scales that exist in that *.Ib4
file.

e Select the rating scale called Ten Pt (Sev) and click OK. The Add Severity Scale window will now be
updated with the properties of the rating scale that you imported from the other library file.

e Click OK to save the new rating scale into your library then close the Profiles/Libraries Manager.

4.13.5 Modify Project Properties Directly Within the Project

Although the previous examples in this training guide have always set the project properties automatically
with a pre-defined profile, you can also modify the project properties directly within an existing project.
These changes apply to the project only and have no direct effect on the profile and libraries that were used
to set the project properties originally.

e Open the AuthorizedUsers.rx4 database from the Training folder in your application directory (e.g.
C:\Program Files\ReliaSof\RCM4\Training). The Username is “username” and the Password is
“password” for this login secure database.

e Next, open the Project Properties window for the project called Sample Project.

As you can see, the properties for this project were originally set based on the Standard FMEA profile that is
shipped with RCM++. For this example, suppose that all of the properties from the Standard FMEA profile
are appropriate for the project except that you would like to choose a different Occurrence scale and make a
few adjustments to the interface style.

e To change the Occurrence scale assigned to this project, first click the Occurrence tab and then click the
Apply Existing button at the bottom of the page. If a warning message is displayed, click OK to
continue. This message simply reminds you that if you change the rating scale for the project and the
project already has records that have been rated according to the old scale, you may need to re-set the
ratings for those records according to the new scale in order to avoid inconsistencies in RPN
calculations.
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e After clicking the Apply Existing Occurrence Scale button, the menu to the right will become enabled
and you can select a different Occurrence scale to apply for this project, as shown next.

’EEdit Project Properties [ %]

General | Interface | Severity  DCCUFrENCe |Detecti0n | Severity Class | Failure Probability | Menus | ES Questi 4 I L4

A Yalue Description Criteria
» 1 Almost never Failure unlikely, History shows no Failures, Cpk =1.67; CHF(1000 <,00053,
z Remate Rare number of Failures likely, Cpk =1,50; CWFf1000 = 0068,
3 Wery slight Wery Few Failures likely, Cpk =1,33; CNF/1000 = 0063,
4 Slight: Few Failures likely, Cplk =1,17; CWFf1000 = 46
5 Low Occasional number of Failures likely, Cpk =1,00; CHF1000 = 2.7,
3] Medium Moderate number of Failures likely, Cpk =.83; CNF/1000 = 12,4,
7 Moderately high  |Frequent high number of Failures likely, Cpk = 67; CNFf1000 = 46,
g High High number of Failures likely, Cpk =.51; CNF/1000 = 134,
9 Wery high ‘Wery high number of Failures likely, Cpk =,33; CNF/1000 = 316,
10 almost certain E:iLu;eI;éTocsl\lth;aertgig;Hésltsolry of Failures exists From previous similar designs,

Edit...
Select from Library

Apply Existing | j
10 Point {Qcc)

ALAG Automotive PFMEA {Occ) ’—I |
ARPSSE0 (Occ) o OK Cancel

Automative DFMEA (Occ)
Automative Five Poink {Occ)
Automative MFMES (Occ)
Automative PFMEA (Occ)
Electronics {Occ)

Five Point {Occ)

Ford Auto MFMEA (Occ)
Mechanical {Occ)

Medical Devices {Occ)
MIL-5TD- 16294 (Do)

Ten Point {Occ)

Ten P {Occ)

WDA-Yold Process FMEA {Occ)
WDA-Yold Produck FMEA {Occ)

|Date Created: 10/30/2006 |

e Select the ARP5580 (Occ) scale (created based on the SAE's ARP5580 guideline and shipped with
RCM++) to update the Occurrence scale for the current project, as shown next.

’EEdit Project Properties [ %]

General | Interface | Severity  DCCUFrENCe |Detecti0n | Severity Class | Failure Probability | Menus | ES Questi 4 I L4

A Vg]_ue Description Criteria -
Remate: Failure is _ i
» 1 nlikel <= 0,000000667, (1 in 1,500,000}
2 Low: Relatively Few |5 nonnnaeez, (1 in 150,000)
Failures
3 Low Relatively Few |g nnnaeez (1 in 15,0000
Failures
4 Moderate_: Occasional 0.0005 {1 in 2,000}
Failures
5 Moderate_: Occasional 0.0025 (1 in 400}
Failures
6 Moderate_: Occasional 0.0125 (1 in B0
Failures
7 High: Repeated |5 e 1) o
Failures
g High: Repeated |5 yon ¢y i g
Failures
‘Wery High: Failure is . et
? Almost Inevitable 0.33(1in3)
10 Very H|Lg|'1: Fa_lLIu[? 5 |=s 0.5, {greater than 1 in 2) -

Edt...
Select from Library
Apply Existing [arps5a0 (0cc) |

OF I Cancel |

RCM++

|Date Created: 10/30/2006 User; First Last

e Next, click the Interface tab to edit the interface style that has been defined for this project. On this
page, click the Edit button to open the Edit Project Interface Style window.

e For this example, suppose that the standard interface style is acceptable except for the following:

o Users will not be able to enter Design Engineer or Drawing Number for item records.
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o The Responsibility field for the Analysis Properties will be called “Design/Process Responsibility.”

o Users will be able to enter three levels of effect descriptions for effect records, called End Effect,
Next Level Effect and Local Effect.

To make these changes, do the following:
e From the Item page of the window, click inside the Enabled/Displayed column in the row for the
Design Engineer property and set the value to No. Then disable the Drawing Number property as well.

e Next, click the Analysis tab and then click inside the Display/Report Name column for the

Responsibility property. Edit the text to set the label as Design/Process Responsibility, as shown next.

’EEdit Project Interface Style

Ttem  Analysis |Functi0n | Failure | Effect: | Cause | Action | Contral | Ranks | Contral Plan | DVPER | DREFM | Task |

I[=] E3

Property Q DisplayReport Mame Q Enabled;Displayed | =
FIMEA Date {Crig.) Analysis Dake {Orig.) es
FIMEA Date (Rev,) Analysis Date (Rev.) es
Prepared By Prepared By es
Core Team Core Team ‘es
Primary Approval Primary Approval es
Approval Date Approval Date es
Product: Product: Mo
Model Year{s)/Program(s) Model ¥ear{s)/Programis) ]
» Responsibility Design/Process Responsibility Mo
Release Date Release Date Mo
Others Affected Others Affected Mo
Mission Mission Mo f
User Defined 1 User Defined 1 Mo
User Defined 2 User Defined 2 Mo hd

| Updating Interface Style for this project

4

e Finally, click the Effect tab and then enable the Next Level Effect Description and Local Effect

Description properties, as shown next.

’EEdit Project Interface Style

Item | Analysis | Function | Faiure EFfect |Cause | Action | Control | Ranks | Control Plan | DYP&R | DREFIM | Task |

I[=] E3

Property Q DisplayReport Mame Q Enabled|Displayed

End Effect Description Effect * Yes
Mext Level Effect Description Mext Lewvel EFfect es
» Local Effect Description Local Effect Yes
Critical Failure Criterion Critical Failure Criterion Mo
Time Range to Critical Failure Time R.ange to Critical Failure ]
User Defined 1 User Defined 1 Mo
User Defined 2 User Defined 2 Mo
User Defined 3 User Defined 3 Mo
User Defined 4 User Defined 4 Mo
User Defined 5 User Defined 5 Mo

| Updating Interface Style for this project
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4.13.6 Create a New Library Set Based on Project Properties

The changes that you have made to the interface style will be applied to the current project when you click
OK. In addition, if you want to save the modified interface style in your library so that it will be available to
apply to the projects that you create and modify in the future, do the following:

e Select the Add to Library option in the top right corner of the window. The Name and Description
fields will become enabled.

e Type a name (required) and description (optional) for the new interface style that will be added to the
library, as shown next.

’EEdit Project Interface Style H=E3
Mame Add ko Library
IModiFied Standard
Description

Created by the user while performing the examples in the RCM++ training guide, ﬂ
Tkem | Analysis | Function | Failure | Effect: | Cause | Action | Contral | Ranks | Contral Plan | DVPER | DREFM | Task |
Property Q DisplayReport Mame Q EnabledDisplayed ||
» Itern Mame Itern Mame * Yes
Part Mumber Part Mumber Ves
Alcernate Part Mumber Aleernate Park Mumber Ves
Ikem Descripkion Ikem Descripkion ‘fes
by per Systemn by per Syskern ‘fes
Qby per NHLA by per NHLA ‘fes
Supplier Supplier es
Sirnilar Ta Sirnilar To Ves
Reference Designator Reference Designator Mo s
CAGE Code CAGE Code Mo
Design Engineer Design Engineer Mo
Drawing Mumber Drrawing Mumber ]
Remarks Remarks Ves
LiCH LiZH Mo -
Copy Existing. .. oK Cancel
| Updating Interface Style for this project 4

e Now, click OK to apply the modified interface style to the current project and add it to the library for
future re-use.

e Click OK to close the Project Properties window.

4.13.7 Create a Custom Phrase Set

In addition to the settings that are applied in the Project Properties window, RCM++ allows you to manage
other pre-defined resources within your library file: phrase sets, checklists, ground rules and assumptions
lists and quality surveys. As the examples in this training guide have demonstrated, you can use phrase sets
to quickly and easily enter descriptions for the records you create in your analyses. The other records are
available for use in the software’s Analysis Planning utility.

For this example, you will be creating a custom phrase set.
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e Select Profiles/Libraries Manager again from the Tools menu. Then click the Phrase Sets tab to
display a list of all the phrase sets that have been defined on your computer, as shown next.

’&_‘L]Profiles,.-"Lihraries Management _ |EI|1|
Occurrencel Detectionl Menu Sets  Phrase Sets |ES Questions | ES Criticalityl FEC Logicl Tasks I Check]istsl Assumptionsl Surveysl 1 I 'I

Phrase Sets store pre-defined descripkions that can be used to define records within vour analvsis, Click Add to create a new phrase set,
Edit ko view andior edit an existing phrase set or Delete to delete the selected phrase set,

A& Mame Descripkion Last Updated B Last Updated
B[ Automotive DFMEA Egiﬁ?cgtliﬁﬁsmm'a and SAE 11733, for DFMEA in autamative ReliaSoft Corparation 411/2005
Autornotive MFMEA From SAE 11739, for MFMEA in automotive applications. ReliaSoft Corparation 1/17 /2005
Automative PEMEA ELTJ?CQESESFMEA'S and SAE 11733, For PEMEA in automative ReliaSaft Corparation 1172008
Examples For Automotive |Prepared by ReliaSoft Corporation Far use in completing the ) .
FMEAS examples presented in the software Training Guide. ReliaSoft Corparation 4/11{2005
JEDEC Semiconduckor  |From JEDEC EIAJJEP131L, For the semiconductor industry, ReliaSoft Corporation 11172005
) From page 27-28 of the Reliability analysis Center (RAC) document, ) .
NDI Techniques "Practical Application of Reliability-Centered Mainkenance." ReliaSoft Corparation 3(14{2005
Standard From a variety of engineering references, Reliasoft Corporation 1/17/2005
‘ehicle Maintenance Tasks This sample phrase set has I;-een prepare;l |.3«.358d on the ) ReliaSoft Corporation 3/14/2005
recommended scheduled maintenance activities for an autornobile,
Add... || Edt... ” Delete |
w | Export Current Library... ” Reset Library. .. | Close |
P
|C:'|,Program Files\ReliaSoft\RICM3Defauls. b3 |Read,|'Write v

e Click Add to open the Add Phrase Set window. This window works in a similar fashion to the windows
that you have used to create your own custom Profiles/Libraries settings. Follow a similar procedure
now to pre-define descriptions that may be of use to you when you are creating function, failure, effect,
cause, control, action and task records in your analyses. If you have phrase sets already defined in Excel,
you can import them on the appropriate tabs of this window.

’&_‘L]Add Phrase Set _ ol =l

Mame —
ICustom Phrase Set
Description [P ==

This custom phrase set was created by the user while working through the examples in the RCM++ ﬂ

Training Guide.,

Functions |Failures I Effects | Causes I Actions I Controls I Tasks I

Funckion Description
1 Tvpe re-usable text descriptions that will save you time when you are entering Functions inko wour
analyses,
5 These descriptions will be available by clicking the icon bo the right of most description fields within
the RCMA-+ inkerface,
ik
E Delete Row | Import From Excel | | Export to Excel |
| Copy Existing. .. | (o] | Cancel |
| Adding new Phrase Set to Library 5

e When you have fully defined your own new custom phrase set, click OK to add the phrase set to the
library.
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Click Close to close the Profiles/Libraries Manager and then select User Setup from the File menu to
open the User Setup window. Click the Descriptions tab. You can see that your new custom phrase set
has been added to the list of phrase sets that are available on your computer.

If you would like to activate this phrase set so that its descriptions will be included in the Select Existing
windows when you edit analyses on your computer, mark the checkbox next to the phrase set name and

click OK.

After you are finished experimenting with these advanced profiles/libraries management options, you can
close the project and the database before proceeding with the next example.

4.14 Example 13 - Using Revision Tracking Features

This example allows you to experiment with RCM++'s revision tracking capabilities and guides you through
the process to create and manage baseline versions of an RCM++ database.

For this example, you will work with a sample database that has been prepared by ReliaSoft, which contains

sample data related to imaginary products. Sample data sets are not intended to be realistic.

4.14.1 Open and Log In to an Existing Database

Open the database called AuthorizedUsers.rx4 in the Training folder in your application directory (e.g.
C:\Program Files\ReliaSoft\RCM4\Training). Log in with the following administrative user account:

o Username: username

o Password: password

4.14.2 Create a New User Account

Select Administrative Options from the Tools menu and then use the same account information to log
in to the administrative utilities for this database. Click Manage Database Users and then create a new
user account for yourself.

’E‘Manage Users

A Firsk Mame

Last Mame

=101 ]

Lsername E-mail

Phone

Title

Compan:

2

Bil

User

billuser ®Ffmea@ReliaSaft, com

+1.520.586.0410

ReliaSoft Corporation

Joe

User

joeuser #Frmea@ReliaSoft.com

+1.520.586.0410

ReliaSoft Corporation

Kate

User

kateuser ¥fmea@Reliasoft.com

+1.520.586.0410

ReliaSoft Carparation

E‘User Login and Contact Information

|
bl %'
4101 010001010110000101001010010111007

RCM++

x|

Firat Mame IType wour firsk name,

Last Mame IIast name,

5] )

Uzemame I USEIMAanme,

xxxxxxxx

Fassword I

E-rnail Iand e-mail address,

bdd. .. ||

| | Delete

Title |Title,

Compary Icompany and

| Corfirm I xxxxxxxx

Fhiohe Iphone are optional,

oK

(=
(=
=l
(=

| Cancel |

Close

4
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Close the Manage Users window and then close the database and open it again, logging in with your new
user account.

4.14.3 Edit Record and View Last Updated Username and Timestamp

e Next, open the project called Sample Project.

e Double-click the item called Component 1.1.1 in the System Hierarchy to display the Item Properties
window. Type RS12345 for the Part Number, 1 for the Qty per System and 1 for the Qty per NHLA.

e Then click OK to save the changes and close the window.

e Double-click the item again to re-open the properties window. You can see that the status bar at the
bottom of the properties window now displays the date/time when you made the change to the item
record and the first and last name associated with the user account that you logged in under.

4.14.4 Open the Revision Tracking and Management Window

Now, select Revision Tracking from the Tools menu to open the Revision Tracking and Management
window, as shown next.

E‘Revision Tracking and Management _ Ol x|
Current Database Dakabase Size (KE) Creation Date Last Update Date
|CilProgram FilesiReliaSoft|RCM4|Trainingl AutharizedUsers, rxd | 3605 | 4/11j2005 | 4f28/2005

Manage Baselines | Database Logins I

Baselines allow you to store an exact replica of the database at a particular point in time. IF necessary, wou can roll back ko (or
restore) a saved wersion of the database at any time, The tools below allow wou to view and manage the existing baselines For this
database,

Existing Baselines

A Date Size (KB) Starage Location Motes Create Baseline in
Sample baseline For use Database
P [4/11/2005 11:31:55 AM 1796 Stored in Dakabass heploinaltolon —
the: training quide Create Baseline in
examples, Separate File

Delete Selected Baseline

Replace Current Dakabase
with Selected Baseline

Create New Datsbase
from Selecked Baseline

M Close
l,

You can see that the top of the window displays some information about the current database. Note that the

appearance of the window on your computer will vary depending on the specific attributes of the database
that you are using.

In addition, the window provides revision tracking options on two pages, separated by tabs. The Manage
Baselines page allows you to create and manage baselines of the current database, which are exact replicas
of the database at a particular point in time. You may wish to use a baseline to “roll back” to an exact state
that the database was in. You will notice that one baseline has already been created for this sample database.

The Database Logins page allows you to view a record of every login to the current database, including the
date/time of the login and information on the user who performed the login.
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4.14.5 Store a Baseline Within the Database

You can store baselines inside the current database or as separate files outside of the database.

e To create a baseline inside the database, click Create Baseline in Database. A window like the one
shown next will be displayed.

Baseline Notes E3

Enter notes ta describe baseline.
Cancel |

|<None>

You can use this window to type notes about the baseline that you are in the process of creating. These notes
can be used to identify the purpose and/or contents of the baseline at a later time.

e Type the following text and click OK to proceed.

e To archive the database before proceeding with the Training Guide example.

e A message will be displayed that indicates that the baseline was created successfully. Click OK to
continue. The window will now look like the figure shown next.

’E‘Revision Tracking and Management _ 1Ol x|
Current Database Database Size (KB} Creation Date Last Update Date
|C:'|,Program Files\ReliaSoft\RCM4 Training|ButhorizedUsers. res | 7240 | 4/11/2005 | 4{26/2005

Manage Baselines | Database Logins I

Baselines allow you to store an exact replica of the database at a particular poink in time. IF necessary, vou can roll back bo {or
restored a saved version of the database at any time, The bools below allow vou to view and manage the existing baselines for this

database,
Existing Baselines
A Date Size (KEB) Starage Location Mokes Create Baseline in
Sample baseline for use Database
4112005 11:31:55 AM 1796 Stored in Database when working thraugh —
the training guide Create Baseline in
examples, Separate Fila
To archive the database
) before proceeding with )
B f4fz6 2005 3608 Stored in Database the Training Guide Delete Selected Baseline
example,

Replace Current Database
with Selected Baseline

Create New Database
from Selected Baseline

Clase /b

This baseline file is stored inside the database and will be transferred with the database if you e-mail the
database to a colleague or create a copy of the database in another location, etc. However, storing the
baseline inside the database also takes up space within the database, which may become an issue for very
large databases. If space inside the database is (or becomes) a concern, you may prefer to create the
baselines as separate files outside of the database. This process is described next.

4.14.6 Store a Baseline Outside of the Database
e To create a baseline as a separate file outside of the database, click Create Baseline in Separate File.

e A window will be displayed to explain that if the link does not remain consistent (e.g. if you move the
baseline file or transfer the database to another user who does not have access to the baseline file in the
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same location), then you will not have full baseline management capabilities for that baseline. In other
words, you will not be able to replace the current database with the selected baseline if the file does not
exist in the original location. Likewise, you will not be able to create a new database from a selected
baseline if the link is not consistent. Click Yes.

e You will again be prompted to enter notes to help identify the baseline. Type the following text and click
OK.

e Sample baseline stored outside of the database.

e Next, you will be prompted to specify the location and filename for the new baseline file. Type
BaselineExample and click Save to create the file.

e Click OK to close the confirmation message that is displayed. The window will now look like the figure
shown next.

’E‘Revision Tracking and Management _ 1Ol x|
Current Database Database Size (KB} Creation Date Last Update Date
|CiProgram FilesiRelasoft|RCM4|Trainingl AutharizedUsers, et | 7244 | 4f11jz005 | 4fz5/2005

Manage Baselines | Database Logins I

Baselines allow you to store an exact replica of the database at a particular poink in time. IF necessary, vou can roll back bo {or
restored a saved version of the database at any time, The bools below allow vou to view and manage the existing baselines for this
database,

Existing Baselines

& Date Size (KE) Starage Location Maokes Create Baseline in
Sample baseline for Database
4112005 11:31:55 AM 1796 Stored in Database use when working —
through the training Create Baseling in
guide examples, Separate File

To archive the
database before

4f26/2005 3608 Stored in Database proceeding with the (Dl S etz Epeine
Training Guide
Bxlan;D'B-l Replace Current Database
) Sample baseline with Selected Baseline
P H4ize2005 7240 ClFimET stored outside of

Files\ReliaSoft\RCM4 BaselineExa. ..

the database,

Create New Database
from Selected Baseline

Clase /b

You can see that the full path/filename for the new baseline file is displayed with the entry in the list of
existing baselines. Only the link (and not the actual file) is stored inside the database and only the link will
be transferred with the database.

4.14.7 Create a New Database from a Baseline

You can use the baselines that you have stored (both inside the current database and outside the database in
separate files) to either replace the current database or to create a new database. If you select to replace the
current database with a selected baseline, this will have the effect of “rolling back” the database to the exact
state it was in at the time that the baseline was created. This action cannot be undone and will overwrite any
changes that have been made to the database since the creation of the baseline.

If you select to create a new database from a selected database, the current database will remain exactly the
same and a new database will be created that re-creates the state of the database at the time that the baseline
was saved.

e To create a new database from one of the baselines in the current database, select any of the existing
baselines and click Create New Database from Selected Baseline.

e You will be prompted to enter the path/filename for the new database. Type BaselineDatabase for the
filename and click Save.
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o A message will be displayed that indicates that the database was created successfully. Click OK.

4.14.8 Open the New Database

The new database, BaselineDatabase.rx4, will be an exact replica of the current database at the time that the
baseline was created.

4.14.9 Re-Open the Original Database and Review Database Logins

Dakabase Size (KE)

Creation Date

=10l x|

Last Update Date

Manage Baselines

Database Logins

| Fa4d

| 4/11j2005

4/26/2005

This table displavs a record of every lagin to the database, including the dateftime and the user wha logged in ta the database.

¥ DateiTime Username | First Mame | Lask MName Compan Phone E-mail
4/26/2005 4:02:07 PM | username | ReliaSoft | Corporation |ReliaSoft Corporation |+.1.520,836.0410 | RCM@ReliaSoft. com
4/11/2005 11:32:32 AM | kateuser Kate User ReliaSoft Carparation | +1.520.886.0410 RCM@ReliaSoft, com
4f11/2005 11:32:21 AM | billuser Eill User ReliaSoft Carparation | +1.520.886.0410 RCM@Reliasoft.com
4/11/2005 11:30:10 AM | username | ReliaSoft | Corparation |ReliaSoft Corporation |+,1.520,886.0410 |  RCM@ReliaSoft, com
4/1/2005 5:12:52 PM username | ReliaSoft | Corporation |ReliaSoft Corporation |+.1.520,886.0410 | RCM@Reliasoft, com
Filter Based On Username | all j Filter Based On Most Recent Im vl

M Close
l,

To confirm this, click Close to close the Revision Tracking and Management window and then open the
new database that you just created.

You can take some time now to review the new database to confirm that it is an exact replica of the
original database at the particular point in time.

Now re-open the original database for this example, AuthorizedUsers.rx4, then select Revision
Tracking from the Tools menu.

Click the Database Logins tab to display the second page of the Revision Tracking and Management
window, as shown next.

E‘Revision Tracking and Management

Current Database

|C:'I,Program FilesiReliaSoft RCM4 Training) AuthorizedUsers, rxd

The appearance of the window will vary depending on the particular properties of your database. It will
display a list of every login that has been made to the current database, including the date/time and
information on the user who performed the login.

By default, all records will be displayed. However, you can filter the records based on username or based on
the most recent login date/time using the corresponding drop-down menus.

e When you have finished investigating RCM++'s revision tracking functionality, click Close to exit the

window. Then close the project and the database.

RCM++ 4 Training Guide

111



4 Step-by-Step Examples

4.15 Example 14 - Using Change Logs

This example allows you to experiment with RCM++'s Change Log feature and guides you through the
process to create and manage versions of an RCM++ database.

For this example, you will work with a sample database that has been prepared by ReliaSoft, which contains
sample data related to imaginary products. Sample data sets are not intended to be realistic.

4.15.1 Create a New Login Secure Database

The first step is to configure the software so that new databases are login secure, if you have not done so
already.

e To do this, select User Setup from the File menu and click the Settings (1) tab.

e Select the Enable Login Security features for new databases option and click OK to close the User
Setup.

e Next, create a new database called ChangeL.ogExample.rx4.

o

In Step 1 of the Database Creation Wizard, type username in the Username input box and type
password in the Password input box. Type the rest of the required information in the Creator/
Administrator Information area (indicated with red text).

In Step 2 of the Database Creation Wizard, select Yes, | would like to add other users now. The
Manage Users window will appear.

Click Import and select AuthorizedUsers.rx4 from the Training folder in your application directory
(e.g. C:\Program Files\ReliaSoft\RCM4\Training) and click Open.

Select all available users and click Import, then close the Manage Users window.

In Step 3 of the Database Creation Wizard, select Yes, | would like to create a project now and click
Finish.

e When prompted to create a new project, click Cancel.

4.15.2 Import an Existing Project

e Select View Project Explorer from the File menu or click the View Project Explorer icon.

f‘% Yiew Project Explorer. ., |

e Select Import Projects from the Project Explorer menu or click the Import Projects icon.

d)
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e When prompted to select a database to import from, navigate to the Training folder in the application
directory (e.g. C:\Program Files\ReliaSofttRCM4\Training) and select the database called
ChartsData.rx4. The Import Projects window will be displayed, as shown next.

’Elmport Projects !E[ E
Import From databas%a C:\Program Files\ReliaSoft\RCM4 TrainingyChartsData.rxd Browse ...
Select Project to Import
A Hame nged on Profug Description
DI T seatorchats | sandsdries O e o e e
[ Hore ot or G| stndardicn |1 0 ortons et st 0t o
V¥ Remermber last database opered | = Select Al || i—  Deselect Al |

Import | Close |

|Imp0rt projects from the selected database 4

e Select the project called Data for Charts and click Import to import the project into the current
database. Click Close to close the import window.

e Open the project that you imported. With System A selected, the Project window will look like the figure
shown next.

,E‘Data For Charts H[=] E3
Project Edit  View System Hierarchy Function Failure Effect  Cause
4 S X | I | EEEETE =R ENE] | @ |
System Hierarchy FMEA Higrarchy - System A
=] Name 8% [rm][<] O] Description [8 % [reni [rene [a[c[rec [T ]~
bW System A

E!----g Subsystem A. 1
El-3  Subsubsystem A.1.1

—--|E| Component A.1.1.1 'F|
=] OB SystemB |
b Subsystem B.1 F|
[ System C E ]
=l M System D

=8 Subsystem D.1
B & Subsubsystem D.1.1
= 2 Subsubsubsystem D.1.1.1

Bt 2 Subsubsubsubsystem

|| Component 0.1.1.1.1.1 [F]
= -
4 ¥ q ¥
[ System HSystem A A

4.15.3 Activate a Change Log

e With System A selected, select Activate Change Log from the System Hierarchy menu. You will see a
warning notifying you that activating a Change Log for this item and its sub-items will mean that users
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can only make changes to the analysis when a Revision is in progress. Click Yes to continue. The

Analysis Change Log window will appear, as shown next.

’Ennalysis Change Log: 1 - System & [_ o] x|
Change Log Activation and Management
| 10/30/2006 3:20:53 PM | First Last I™ Require Reason for Change | De-Activate Change Log |
Yersion History
| # | ‘ersion | Comments | Initisked B | Start Dake/Time | End Dake|Time Stark Revision, .
» | - |original | | First Last {username) | - | 104302006 3:20 PM
Edit Details, .,
Approve Version, .
Change Log
- . Change -
Reevigion A Date/Time Lser e Record Type Ikem Reecord Description Properky
«| | »
Revision Dake Rangs Change Type Record Tvpe User
fa =1 liores006 EH to |1ojzoeoos L [a = [ =] Jan =l
| Exzpart Yersion Histary. .. | | Expart Change Log. .. | Remove Filkers Close |
Y

You will see in the Version History table that the only version of the analysis currently in existence is the

original version. Now that you have activated a Change Log for this system,

there must be a Revision

currently in progress in order to make changes; if no Revision is in progress, the system and its sub-items
will be locked. Once a Revision is in progress, all changes made to the analysis will be logged. Note that you
can configure a Revision to require a reason for every change made, if desired, by selecting Require Reason

for Change in the Analysis Change Log window. It is also possible to require ele

ctronic approval when each

Revision is ended; this ensures that no further changes can be made to the analysis until the user(s)

designated as approvers have “signed off” on the most recent Revision.

4.15.4 Start a New Revision

Click Start Revision to begin a new Revision. The Version Details window will appear. Select Major to

number the Revision as a major revision to the original version (i.e. 1.0) instead of as a minor revision

(i.e. 0.1), and enter Revision 1 in the Version Label field.

e Click the Assign Approvers button and assign Kate User as the approver for

this version then click OK.

Click OK once more to return to the Analysis Change Log window. You will see that the new Revision

now appears in the Version History table.
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e Click Close to return to the Project window. You will see that there is now a Change Log icon beside
System A in the System Hierarchy panel, as shown next.

System Hierarchy
=] Name A% |Fl1=
By o [0 System A
-2 Subsystem A1
-2 subsubsystern A.1.1
I:.j Campanent &.1.1.1 [F]
£ 08 SystemB B
I:_:'" Subsystern B.1 F|
O Svstem C F|
= B SvstemD B
=2 Subsystem D1
S 2 Subsubsystem D.1.1
=2 Subsubsubsystem D.1.1.1
-2 Subsubsubsubsystem |
be@| Component D.1.1.1.1.1 F|
-
‘ —PI—I

This indicates that a Change Log is active for the System, and that a Revision is currently open.

4.15.5 Make Changes to the Analysis

Change Logs track all changes made to an item and/or its sub-items, both to the items themselves and to any
associated records in the FMEA. To see this process, you will now make a few changes.

e Double-click Subsystem A.1 to open its Item Properties window. You will notice that the Change Log
icon at the bottom of the window is unavailable; this is because no changes have been made to the item.
In the Item Description field, enter New item description and click OK to save your change.

e Re-open the Item Properties window for Subsystem A.1. You will see that the Change Log icon has
become active. Click the icon to open the Record Change Log window, as shown next.

’ERecord Change Log
A Date,l’TLn:g

Revision

Lser Ch_g_nge Type

Propert:

0] x

Value Befare Valus After

» | 1.0 | 10/30/2006 32220 P |Fret Last fusername) |

Edit

| Ikem Descripkion |

|Mew item description

Revision Date Range Change Type User
far =] | i o Ja =l =l

e Click Close to return to the Project window.

e Select Component A.1.1.1. In the FMEA Hierarchy panel, double-click Cause H under Effect A to
open the Cause Properties window.
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e Change the Revised Occurrence rating for the cause to 1 - Almost never, as shown next.

MEdit Cause | x|

Current Ikem | 4 - Component 4.1.1.1

| Function | 1 - Function 4

| Failure | 1 - Failure A

[ Effect | 1 -Effect &

Cause |User Defined | Probability | Corrective Maintenance

# Cause
3 Cause H ﬂLﬁJ
= 1
Detection Method

Compensating Provisions

44
| B
—Initial Ratings

Sev Occurrence Detection RPN

IT |3— |3 - Wery slight j @ IT |2 - Wery high j Lﬁj I 54

—Revised Ratings
Sev Occurrence Detection RPN

IT 1 1 - Alrnost never = @ ll— |1 - Almost certain jl_ﬁj I 9
% Reduction in RPM | 83.33

—Classification

Controls and Actions
Qby Qby
I |<N0nE> j ‘“ﬂ“ Contrals... ” ] | | Actions... ” 1
+
4D B =] [de]o]I2]e] [ ] o |
= |Last Update Date: 10/23/2006 User: Firsk Lask

e Click the Controls button to open the Controls Manager then click Add Control. In the Control
Properties window, enter New Control for the name and select Prevention as the Control Type, as

shown next.
E‘ﬂndd Control [x]
Cortrol |User DeFinedI
# Contral
I 42 Mew Contral ;”_ﬁj
=
id |
Contral Type IPrevention j
+
: mssmiten. | o 5]0]2%0] (o | ow |
5 n | SSoCiake @ £l 0| 2|5 (7] | I ance!
3 | Adding new Control

e Click OK to add the control then click Close to close the Controls Manager. Finally, click OK to close
the Cause Properties window.
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4.15.6 End the Revision

e In the System Hierarchy panel, select System A and select View Change Log from the System
Hierarchy menu. In the Analysis Change Log window that appears, you will see that each of the
changes you made to the analysis is listed in the Change Log table, as shown next.

,E.Analysis Change Log: 1 - System & |_ O] ]
Change Log Activation and Management
| 10f30/2006 3:20:53 PM | First Lask [~ Require Reason for Change ‘ De-activate Changs Log |
¥ersion History
# Wersion Comments Initiated B Stark DakeTime End Date/Time Start Revision, ..
- |Criginal First Last (username) - 10/30/2006 3:20 PM
P | 1.0 |Revision 1 First Last {username) | 10/30f200& 3:21 FM
Approve Yersion, ..
Change Log
Reevisian A DatefTime User C:agﬁge Record Tvpe Itern Record Description | Property Yalue Befare Value After
» | 1.0 | 10/30/2006 3225z pr Frst Last add | contral |18 Component s ey corpral
(username) A1
2| 1o | 10/a02008 3izzizepm |frStLast Edi Cause  |123A-Component |y 4 g 5 coey | Revised 1
(username) Addd CCcurrence
3| Lo | 10p30/2006 32220 pe |FirstLast Edit Irem | 1.2- Subsystem a.y |1+2 - Subsystem Teem Mew item description
(username) Al Description
| | 3
Revision Date Range Change Type Recard Type User
[to =] |iojzsjzons EE o [1ops0fz00e EE L [al =l Ja =] Jan =
| Export Version History. .. | ‘ Export Change Log. .. | Remove Filters Close |
4

e Click End Revision. You will see a warning stating that users will not be able to make changes to the
current version of the analysis unless the Revision is re-opened. Click Yes to proceed.

4.15.7 Track More Changes in Another Revision

e Repeat the steps given above to start a new Revision, which you will call Revision 2.

e Close the Analysis Change Log window.

e In the System Hierarchy, add a new component, Component A.1.1.2, under Subsubsystem A.1.1, as
shown next.

System Hierarchy
=] Name g% |F[M|-
= Ol System &

= 8 Subsystem A.1
-2 Subsubsystem 4.1.1
-2 Component A.1.1.1 [F]
> -2 Commpanent &.1,1,2
=l 08 SystemB
“-{E] Subsystem B.1
@ System C
= 8 SystemD
E-- 8 Subsystem [n1
B2 subsubsyster D.1.1
[+ 2 Subsubsubsystem

Subsubsubsubsy stenm
BB D11

1 Component
Bl 0111101 F
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e With Component A.1.1.2 selected, select Promote Item from the System Hierarchy menu.

e Double-click the promoted item to open the Item Properties window and change its name to
Subsubsystem A.1.2, then close the Item Properties window.

e Select System A in the System Hierarchy and select View Change Log from the System Hierarchy

menu.

e In the Analysis Change Log window, click End Revision.

e You will notice that only the changes from the most recent Revision are currently displayed in the
Change Log table. You can use the filters below the table to specify criteria for which changes are
displayed. For example, select All in the Revision field. All of the changes from both Revisions are
displayed. Then select Edit in the Change Type field. Only changes of type Edit from both Revisions

are displayed, as shown next.

’E‘Analysis Change Log: 1 - System A

[H[=] E3
Change Log Activation and Management
| 10/30/2006 3:20:53 PM | First Last I™ Require Reason for Change | De-Activate Change Lag |
Yersion History
# ‘ersion Comments Initiated B Start Date)Time End Date}Time Stark Revision, .
Original First Last (username) - 10/30/2006 335 PM
1.0 |Revision 1 First Last (username) | 10/30/2006 3:21 PM 10/30/2006 3;35 PM
b | 2.0 |Revision 2 First Last (username) | 10/30/2006 3:35 PM - .
Edit Details. ..
Approve Yersion, .
Change Log
Revision & Date/Time User Cpagage Record Type Ttem Record Description Froperty ‘alue Before Walue After
#5190 First Last " 1.2.14 - 1.2.14 - Companent
» 2.0 10f30/2006 3:36:13 PM | P Edit Item bsubewekam &.1.2 | Subsubeystem A.1,% Item Mame Ao Subsubsystem A.1.2
2| 1.0 | tof30z2006 3:22:38 p [FrSt Last Edit Cause | 1234 -Compenent |y s case H Revised 1
{username) A.1,1,1 QCourrence
3| 1.0 | tof30/2006 3:22:20 p [FrSt Last Edit Item 1.2 - Subsystem &.1 [1.2 - Subsystem A.1 Ttem Mew item description
{uszername) Descripkion
| | »
Revision Dake Range Change Type Record Tvpe User
far =1 ioreoreo0e b0 [1qjz0jz00s EE e = [ =] Jan =
| Exzpart Yersion Histary. .. | | Expart Change Log. .. | Remove Filters Close |
i

4.15.8 Export Change Log Information

You can export the information from either the Version History table or the Change Log table to Microsoft

Excel, if desired.

e Click Export Change Log to export the current contents of the Change Log table to Excel (note that
because you have filtered the change records that are displayed, the exported data will correspond to the

filtered data shown in the Change Log table).
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e In the Save File As window that appears, name the file Change Log and click Save. RCM++ will
generate a spreadsheet of the current Change Log view. Once the spreadsheet has been exported, it will
automatically open in Microsoft Excel, as shown next.

E Microsoft Excel - Change Log.xls |_ (O] x|
@_] File Edit Yiew Insett Format Tools Data  window  Help Typeaquestionforhelp - - & X
DEHRSSR YEI 4B I 8z-4lil WP -offis -3 E=mE -0 F
R20C1 - &

1] 2 [ 3 | 4 ] 5 | 3 | 7 | 8 | 3 | 10 =
| 1 |Change Log —
| 2 |Generated by ReliaSoft's ROk 10/30/2006 3:41:52 PM
i Database: C\Program Fies'RelaSotRCM4'FilesiChangelogExample rx4
| 4 |tem: 1 - System A

5]
. - Change Record Record
Revision Date Time User tem o Property | Value Before Value After
B Type Type Description
2 10/30/2008 3:36:113 PM  |First Last Edit ttem 1214 - 1214 - tterm Mame | Componert Subzubsystem 4.1.2
7 [UsErname) ubsubgystem A.1.2 |Subsubsystem A1.2 A112
1 1003002006 3:22:35 PM (First Last Edlit Cause 1.2.3.4 - Componert {1118 - Cause H Revized 2 1 -
5] [UsErname) EARN DCCurrence
1 1043042006 3:22:20 PM  |First Last Edlit ttem 1.2 - Subsystem A1 [1.2 - Subsystem &1 tem Mewy item description
o [USEFNEIME) Description
1 1043002008 3:22:20 P |First Last Eddit tem 1.2 - Subsystem &1 1.2 - Subsystem &1 ttem Mew tem description
10 [username) Description
11 -
W 4 » M[\Sheetl 14 | Llj_‘
Ready MUK i

e Once you have finished viewing the report, close Microsoft Excel, then close the project and the
database.

4.16 Example 15 - Perform Your Own RCM Analysis

This example guides you through the steps to perform an RCM or FMEA/FMECA analysis for one of your
own products or processes. It has been designed to bring together all of the techniques that you have
practiced by working through the examples in this training guide. The example will help you to focus your
new skills toward performing a real analysis that will be of interest to you and your organization.

All instructions for this example are very general and the appearance of the windows will vary depending on
your particular processes and information.

4.16.1 Use the Setup Wizard to Configure the Software

If you did not already go through each step of the Setup Wizard, which guides you through the process to
configure RCM++ to fit the specific way that you and your organization work on RCM or FMEA/FMECA
analyses, you may want to take some time to do so now.
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e To open the Wizard, select User Setup from the File menu and then click Run User Setup Wizard from
the first page of the User Setup window.

’ESetup Wizard [ %]

Setup Wizard Step 1 of 6

RCM + + facilitates all types of FMEA/FMECA and RCM analysis with support for major
industry standards and extensive customization capabilities.

RCM++ is highly flexible and customizable. This wizard
provides a brief introduction to RCM's work environment and
guides vou through the process to set the major
configuration options.

ou can click ‘Finish' at any time to apply the current
configuration settings and begin waorking with the
application. Click the ™Mext:>'and '<Back' buttons to
navigate through the pages of the Wizard.

This Wizard only appears automatically the first time you
run the software, After that, you can access it from the
User Setup window, The configuration options can also
be rodified at any time with the User Setup and
Profiles/Libraries Management windows,

Click Finish at any time to begin working with the
application...

RCM++

<Back | Mext= | Einish |

e When you have completed all of the steps, click Finish to apply your own customized settings and close
the wizard.
4.16.2 Overview of Basic Analysis Steps

The basic steps required to perform your own analyses are presented next. Specific instructions for
performing each of these actions have been included within the previous examples of this training guide and/
or in the RCM++ User’s Guide.

For this example, you will perform those steps that are applicable to your particular analysis requirements.

e Database: Create a database, with or without Login Security enabled.
o Users: If the database has Login Security enabled, create an account for each authorized user.

e Project: Create a project with the appropriate properties to fit the requirements of your analysis. If
applicable, use the custom profile that you created in Example 11 to quickly set the project properties.

e Items: Create one or more items in the System Hierarchy for the project.

e Equipment Selection: If applicable, use the Selection Questions or Criticality Factors method to
identify the equipment that will be analyzed with RCM techniques.

e Analysis Properties: If applicable, define the analysis properties for one or more items in your project.
These properties will be used to set the “header” information in printed report output and also the info in
analysis properties reports.

e Item Reliability and Maintainability: If applicable, define the reliability and maintainability
characteristics for the item(s) in your analysis. This information will be used in item properties reports,
quantitative criticality analyses and maintenance task cost calculations, if performed.

e Functions, Failures, Effects and Causes: For each item that you want to analyze, define functions,
failures, effects and causes, including all relevant properties.
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e Failure Effect Categorization: If applicable, perform the Failure Effect Categorization for each effect
that has been identified in your RCM analysis.

e Controls: If applicable, define the current controls that have been identified for each cause in the
analysis.

o FMEA/FMECA Risk Assessment: If applicable, use the Risk Priority Number or Criticality Analysis
method to assess the risk associated with potential failure causes and to prioritize issues for corrective
action.

e Actions: If applicable, define the recommended actions that have been identified for each cause in the
analysis.

o If desired (and possible on your computer), you may want to send notification e-mails to the people
responsible for completing recommended actions. To enable this functionality, select the Enable
action notification e-mails option on the E-mail page of the User Setup and set the related
properties.

o Monitor the progress on recommended actions.

e Maintenance Task Selection and Definition: If applicable, use the Task Selection logic and/or
maintenance task cost comparisons to select and define the maintenance tasks that will be applicable and
effective for your RCM analysis. If desired, you can also package the maintenance tasks that have been
assigned.

e Check Analysis: Use the Check Analysis utility to identify any possible discrepancies and/or omissions
within the project. Address the appropriate issues and use the Check Analysis utility to confirm that the
issues have been resolved.

e Plots and Charts: Use the Plot Viewer utility to create a variety of pareto (bar) charts, pie charts and
matrix charts based on the information within the project.

o If desired, copy/paste the chart information into separate report documents and/or save the chart
graphics as Windows metafiles (*.wmf) that can be used in other applications.

e Print-Ready Reports: Generate a variety of print-ready reports for the information contained within the
project in Microsoft Word and/or Excel.

e Control Plans, DVP&Rs and Other Related Analyses: If desired, perform related analyses including
transferring Design FMEAs to Process FMEASs, Process Flow Diagrams, Control Plans, DVP&Rs,
DRBFMs, Relationship Diagrams, etc.

4.16.3 Share Your Experience

If the analysis that you have prepared for this example contains non-proprietary and non-confidential
information and you would like to share your work with other users who are learning the features of
ReliaSoft's RCM++, we invite you to send the database file to ReliaSoft Corporation for possible inclusion
among the example files shipped with RCM++.

If you would like to share your analysis, please contact us via e-mail at RCM@ReliaSoft.com.
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